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1. Generic Functions 

1.1 General Application Features 

 

Function 

Entering data 

 

Information 

a) Input fields 

Mandatory input fields are marked with a red triangle in the upper left 
corner.   These fields must always be completed before committing an 
action or instigating a search.   Auto-complete fields are marked with a 
black triangle in the upper right corner.   In such a field, if it contains a 
default * and you remove it, a list drops down displaying available choices. 
As you start typing the choices will narrow down but if you double-click all 
initial choices will reappear. 

 

 

b) How to enter text 

To enter information you can either click in an input field or press the [Tab] 
key to move to the next field. The field is automatically highlighted. Use the 
keyboard to type information.  

In a large edit field, you can use the following keys to move within the text: 

[←], [→], [Home] and [End]. 

The same keys can be used to move within sets of radio buttons. 

Tip: You do not need to use [Backspace] to delete existing information in a 
highlighted field. Entering new information replaces it. 

 

 

 

 

How to enter time and date 

The format of all Time and Date fields adapt to the regional settings in the 
Control Panel of your PC. eg : AM/PM A date value can be selected by 
using the arrow keys:- 

[←] or [→] moves to (highlights) previous or next field among the Year, 
Month and Day fields. eg :dd/mm/yyyy 

[↑] or [↓] steps the value in the highlighted field up or down. 

You can also select the date from a calendar or drop-down list. 

 

 

Function 

Searching data 

 

Information 

a)  Search criteria 
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When entering search criteria, remember the following:-  

 Some fields are mandatory and must be given complete values, 
either by choosing from a list or by typing. 

 Some fields allow wildcards to be used. 

 Some fields can be left empty, which is the same as supplying one 
or more * wildcards.  

 
For information on specific fields, see the search criteria descriptions for the 
corresponding screens. 

Many screens have checkboxes for certain search criteria.   To leave all 
checkboxes related to the same property unchecked gives the same result 
as in checking them all, that is, all items will be listed. 

Note: If a search returns too many items, an error message will be 
generated stating the list has been truncated.   The user must narrow the 
search criteria to reduce the number of items displayed.  

 

b)  Wildcards 

The following wildcards are available:-  

* matches an empty field or a set of characters.  

* * matches an empty field or two sets of characters separated by space.  

* * * matches an empty field or three sets of characters separated by 
spaces.  

? matches one character.  

For example, if the following items exist ASA22, ASB22, ASC22, ASD22, 
ASA33 and ASA44. Searching for ASA* gives the result ASA22, ASA33 
and ASA44. Searching for AS?22 gives the result ASA22, ASB22, ASC22 
and ASD22. To search using only * wildcards or leaving the field empty 
results in all items. 

 

Function 

Viewing data 

 

Information 

a)  How to select items in lists 

Many screens display lists of items with many properties.   Often actions 
are provided on a right-click menu when an item is selected.   To select an 
item (row), highlight its row at the far left end. To select two or more items, 
either hold down the left mouse button and drag the mouse or hold down 
the [Ctrl] key as the rows are highlighted.   To select all items in a list 
choose Select All on the right-click menu.   To select a single property 
(cell), click in the cell. 

 
 
Note: Not all tables permit selections.   In this case the background is 
generally grey. 

 

b)  How to copy items to the clipboard 

To copy information in a single cell to the clipboard, just point at and click it. 
The copied data can be pasted using [Ctrl] + [V].   By choosing Copy on the 
right-click menu, the selected items in the list will be copied to the 
clipboard.   In the same way Copy All will copy all items to the clipboard. 

Tip: Copying information in a single cell can be used to transfer data from 
one screen to another, when entering data. 

 

c)  When double-clicking 

When some items are listed in a screen, there is often insufficient space to 
display all available properties. When double-clicking an item in the list, a 
separate screen opens displaying all individual properties for the selected 
item, including both displayed and hidden columns.  

If you double-click on a column heading, the items will be sorted by the 
properties in the column. 

 

d)  When right-clicking 

https://exigotc.austraclear.com.au/exigoonlinehelp/00secur/tab/tab_rig_gen.xml
https://exigotc.austraclear.com.au/exigoonlinehelp/00secur/tab/tab_rig_gen.xml
https://exigotc.austraclear.com.au/exigoonlinehelp/00secur/fig/fig_prp_exa.xml
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Often many optional user actions are provided for items listed in an explore 
or view screen.   When right-clicking an item in the list (select the item and 
click the right mouse button), a right-click menu appears.   The right-click 
menu contains general options that are related to viewing information and 
are applicable to most screens.   The Properties screen can be accessed 
by choosing the Properties option from this general options section of the 
right-click menu.   The right-click menu also contains the context-specific 
options that are directly related to the screen, which is currently opened.  

 

 

 

 

 

 

 

 

 

 

 

e)  Sorting 

Information can be sorted in ascending or descending order by selecting a 
column heading and clicking. 

 

 

 

 

Function 

Viewing Screens 

 

Information 

a)  Columns 

Lists are displayed as screens with columns and rows.   To adjust a column 
width just select its right border and drag it to the desired width.   If many 
properties exist some can be hidden.   You can see hidden columns for an 
individual transaction by double-clicking its row or for all transactions by 
reorganising or adding the columns. 

 

Process Steps 

1. To add/reorganise columns, from the right click menu select 
Add/Remove Columns. 

2. To add a column – Check the tickbox next to the field to be added.    

3. To remove a column – Uncheck the tickbox next to the field to be 
removed.    

 

 

 

 

4. To reorganise columns –  There are two(2) options available for 
column settings : 

a. All Screens except Reported Trades - Highlight the column 

to be moved and select the up or down arrows  to move 
as required.   Click OK. 

https://exigotc.austraclear.com.au/exigoonlinehelp/00secur/fig/fig_rig_exa.xml
https://exigotc.austraclear.com.au/exigoonlinehelp/00secur/tab/tab_rig_gen.xml
https://exigotc.austraclear.com.au/exigoonlinehelp/00secur/fig/fig_prp_exa.xml
https://exigotc.austraclear.com.au/exigoonlinehelp/00secur/pro/pro_dia_col.xml
https://exigotc.austraclear.com.au/exigoonlinehelp/introduction/columns.xml
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b. Reported Trades Screen – From the Reported Trades screen, 
select the applicable column heading and drag to desired 
position. 

 

b)  Rows 

Each row in a table represents a transaction. One cell in the row contains a 
unique identifier for the transaction, such as a trade number to identify a 
trade.   All other cells in the row display various information and properties 
in relation to the item.   You can sort the list by a certain property by 
double-clicking on the property column heading you wish to sort by.   
Double-clicking twice gives the opposite sort order. You can also 
reorganise the rows.  Click anywhere in the list and choose Sort By on the 
right-click menu, if available.  The Sort By screen will open providing three 
optional columns on which the order of rows can be changed.   Select 
options then click OK.   The rows will be reorganised according to your 
selections. 

https://exigotc.austraclear.com.au/exigoonlinehelp/00secur/pro/pro_dia_col.xml
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1.2 Main Navigation Menu 

 

 

 

 

 

 

 

 

 

 

View 

► Notes 

► View Clearing Messages 

► Current Session 

► Reports ► 

► Calendar 

► Authorisation Policy 

 

► Explore 

► Properties 

 

Holdings 

► View Holdings 

► View Deposits and Withdrawals 

► View Issuer Sub Accounts 

► View Pending Transactions on Issuer Sub Accounts 

► View Issuer CSD Account 

► View Pending Transactions Issuer Sub Accounts 

 

 

Sub Participants 

► Sub Participants Users Sub Account ► 

► Cash Records ► 

► View Standard Settlement Instructions 

► View Agreements 

► Roles ► 

► Proxies ► 

► View Cash Transfer Groups 

► View 

 

► Explore 

► Create User 

► Create Sub Account 

 

► View 

 

► View 

 

Trades 

► View Reported Trades 

► View RBA Repos  

► View Pledges  

► Bill Nominations ► 

► View REPO Renegs/Unwinds 

► View SWAP Terminations 

► View Fixing Values 

► Create Trade ► 

 

► View/ Display Rules ► 

 

► Fixed Income  ► FRA 

► Fixed Income REPO ► Swap 

► Discount Securities ► Pledge 

► Discount Securities REPO ► Bill Delivery 

► Cash   ► Bill Nomination 

► FX   ► Cash Transfer 

     

    

 

► Parameters Periods 
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Main Navigation Menu ....cont. 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Settlements 

► View Settlement Accumulation 

► View Settlements ► 

► View Holding Rectify DVP 

► View Clearing Information 

► Manage Queue Priority 

 

► Settlement Instructions 

► Settlement Obligations 

► Reserve Bank Settlement Monitoring 

► Corp Action Settlement Instructions 

► DVP Instructions 

 

 

Series 

► Series ► 

► View Corporate Actions 

► View Corporate Action Holder Positions 

► View Holders of Series 

 

 

► View 

► View Delegated 

 

Administration 

► Authorisations ► 

► Local Caching ► 

► Market Reference Rates 

► Load / Reload 

► Monitor ► 

► Rules ► 

 

 

► View Actions Pending Authorisation 

► Holding Authorisations 

 
► Refresh 

 

► Business Workflow 

► Corporate Action Execution 

 

► RBA Repo Rules  

► Settlement Rules 
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1.3 Application Login (ANNI Users) 

Definition 

SFE Austraclear System is a web based application designed to replace 
the existing FINTRACS functionality. Accordingly only an Internet 
browser is required to access the application. 

 

Function 

Ability for users to Login to the SFE Austraclear System application. 

 

Information 

Key System features are: 

 Internet Explorer 6.0 or above are the only supported browsers. 

 Account lockout after 3 failed logon attempts. 

 The System timeout is set at 30 minutes inactivity. 

 

Navigation Steps 

https://exigo.austraclear.com.au 

 

Process Steps 

First Time Login 

1. In a new browser window, enter the SFE Austraclear System 
URL, as shown above. 

2. You will receive the SFE Austraclear System Home page. Click 
“Production”, the application will launch the main sign in page as 
shown opposite. 

3. Enter your Username, temporary Password and Digital 
Certificate. The application will navigate you to the Change 
Password screen. 

4. Set your password by entering your temporary password, 
followed by your new Password and confirming your new 
password. 

5. On completion, click the “Start” button. The system will then 
display a Login box. Click the “Log On” button  

6. The system will validate your Login and Digital Certificate and if 
successful, navigate you to the main menu. 

7. The “Cancel” button will remove you from this procedure with 
zero changes effected.  

Note: - Refer to the change password procedure. 

 

Application Login 

1. In a new browser window, enter the SFE Austraclear System 
URL, as shown opposite. 

2. You will receive the SFE Austraclear System Home page. Click 
“Production”, the application will launch the main sign in page as 
shown below.  

3. Enter your Username, Password and Digital Certificate. 

4. On completion, click the “Start” button. The system will then 
display a Login box. Click the “Log On” button. The system will 
validate your Login and if successful, navigate you to the main 
menu. The “Cancel” button will remove you from this procedure 
with zero changes effected.  

 
 
 
 
 
 
 
 
 
 
 

https://exigo.austraclear.com.au/
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SFE Austraclear System Login Screens 
 

 
 

 

      

1.4 Application Login (Internet Users) 

Definition 

SFE Austraclear System is a web based application designed to replace 
the existing FINTRACS functionality. Accordingly only an Internet 
browser is required to access the application. 

 

Function 

Ability for users to Login to the SFE Austraclear System application. 

Information 

Key System features are: 

 Internet Explorer 6.0 or above are the only supported browsers. 

 Account lockout after 3 failed logon attempts. 

 The System timeout is set at 30 minutes inactivity. 

Navigation Steps 

https://exigo.austraclear.com.au 

https://exigo.austraclear.com.au/
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Process Steps 

First Time Login 

1. In a new browser window, enter the SFE Austraclear System 
URL, as shown above. 

2. The Client Authentication window will be displayed. Select your 
Digital Certificate from the list and click OK.  

3. You will receive the SFE Austraclear System Home page. Click 
“Production”, the application will launch the main sign in page as 
shown opposite. 

4. Enter your Username, temporary Password and Digital 
Certificate. The application will navigate you to the Change 
Password screen. 

5. Set your password by entering your temporary password, 
followed by your new Password and confirming your new 
password. 

6. On completion, click the “Start” button. The system will then 
display a Login box. Click on the double arrow to display the 
Authentication field. 

7. Enter your four digit pin (that was provided to you with your RSA 
Securid token) immediately followed by the six digit code 
currently appearing in the display panel of the RSA Securid 
token. 

8. Click the “Log On” button. The system will validate your Login 
and Digital Certificate and if successful, navigate you to the main 
menu. 

9. The “Cancel” button will remove you from this procedure with 
zero changes effected.  

Note: - Refer to the change password procedure. 

 

Application Login 

1. In a new browser window, enter the SFE Austraclear System 
URL, as shown above. 

2. The Client Authentication window will be displayed. Select your 
Digital Certificate from the list and click OK.  

3. You will receive the SFE Austraclear System Home page. Click 
“Production”, the application will launch the main sign in page as 
shown below. 

4. Enter your Username, Password and Digital Certificate. 

5. On completion, click the “Start” button. The system will display a 
Login box. Click on the double arrow to display the 
Authentication field. 

6. Enter your four digit pin (that was provided to you with your RSA 
Securid token) immediately followed by the six digit code 
currently appearing in the display panel of the RSA Securid 
token. 

7. Click the “Log On” button. The system will validate your Login 
and if successful, navigate you to the main menu. The “Cancel” 
button will remove you from this procedure with zero changes 
effected.  

 
SFE Austraclear System Login Screens 
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Application Logout/Exit  

Definition 

Closes the SFE Austraclear System application, ensuring no other users 
can access the application under your login. 

 

Function 

Closes the application 

 

Information 

Key System features are: 

 Once you have exited the application you will be required to repeat 
the sign in process to gain access to SFE Austraclear System. 

 

Navigation Steps 

► File ► Exit  

 

Process Steps 

Application Logout 

1. Follow Navigation steps to display confirm box “Logout” as 
shown opposite. 

2. Click the “Yes” button to confirm system logout. The “No” button 
will remove you from this procedure with zero changes effected.  

 

 

 

 

 

 

 

 

 

System Logout 
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1.5 Password Maintenance 

Definition 

The ability for users to maintain their password. 

 

Function 

Changing your existing SFE Austraclear System password. 

 

Information 

Key System features are: 

 SFE Austraclear System will prompt users to change passwords 
every 90 days. 

 Ad-hoc changes can be performed by users. 

 Password must be a combination of Alpha / Numeric characters, 
Upper and Lower case. 

 Minimum password length must be 8 characters and maximum 14 
characters. 

 

Navigation Steps 

► File ► Change Password  

 

Process Steps 

Change Password 

1. Follow Navigation steps to display screen “Change Password” as 
shown opposite. 

2. Enter your “Old Password”, “New Password, then “Confirm New 
Password”. 

3. On completion, click the “OK” button. The system will validate the 
changes and advise of any errors. The “Cancel” button will 
remove you from this procedure with zero changes effected.  

 

 

 

 

 

Change Password Screen 
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1.6 Right Mouse Click 

Definition 

A number of functions are accessed via “Right Mouse Click” in SFE 
Austraclear System. Functions vary depending on what screen you have 
accessed and what permissions you have.  

 

Processing Functions 

The following is a brief description of the processing functions that can be 
performed via the “Right Mouse Click”. 

 

Properties 

Provides a more detailed view of the transaction or record in a new 
window. This function is permission based and available in most SFE 
Austraclear System windows. 

 

Create 

Allows the user to create a new transaction or record. This function is 
permission based. 

 

Authorise 

Allows the user to authorise a task or transaction that has been created 
by another user. This function is permission based. 

 

Delete 

Allows the user to delete a task or transaction that has been either 
created by them or another user. This function is permission based. 

 

 

Generic  Additional Functions 

These additional functions provide the user the opportunity to customise 
the view of the application and screens to suit their purposes. These are 
also available through a “Right Mouse Click” and include the following: 

 

Select All 

Selects all records, transactions or data within a table based on the 
user’s search criteria. This information can then be copied into other 
applications such as MS Excel or MS Word. 

 

Copy 

Allows the user to copy a specific record or transaction, or all records or 
transactions from their selected table. 

 

Sort By 

Allows the user to sort table records by specific fields. 

 

Column Settings 

Provides the opportunity for the user to display or hide certain columns 
within each table display. 

 

Export to File 

Allows the user to export data into an external application such as MS 
Excel.  This is via a CSV file 

 

Print 

Provides the user with a Print Preview of the data in another window, 
formatted for printing. 



        

 Austraclear System Participant User Guide 

          20  

1.7 File Navigation & Functions 

Definition 

The “File” navigation can be found on the main application navigation bar. 
The navigation features are similar to most MS applications. 

 

Function 

The “File” navigation point allows the user to perform a number of generic 
functions. These functions are further explained below.  

 

SFE Austraclear System Main Menu 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Navigation Steps 

► File  ► Change Password  

► Exit  

 

Process Steps 

► File ► Change Password 

Provides the ability for users to change their own password on an Ad-hoc 
basis. See procedure “Password Maintenance” 

 

► File ► Exit 

Exits application. See procedure “Application Log Out” 

 

 

 

 

 

File 

► Change Password 

► Exit 
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1.8 View Navigation & Functions 

Definition 

The “View” navigation can be found on the main application navigation 
bar. The navigation features are similar to most MS applications. 

 

Function 

The “View” navigation point allows the user to perform a number of 
generic functions. These functions are further explained below.  

 

SFE Austraclear System Main Menu 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Navigation Steps 

► View  ► Notes  

► View Clearing Messages 

  ► Current Session 

► Reports ► Explore 

  ► Properties 

► Calendar 

► Authorisation Policy 

 

Process Steps 

► View ► Notes 

SFE Austraclear System creates notes for most activities performed 
within the application throughout the day. The Notes will display the 
transaction before and after changes. 

 
View 

► Notes 

► View Clearing Messages 

► Current Sessions 

► Reports ► Explore 

► Properties 

► Calendars 

► Authorisation Policy 
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► View ► View Clearing Messages 

Displays messages provided by SFE Austraclear. Messages can be 
either a general broadcast message to the Market or message to a 
specific market. 

 

 

 

► View ► Current Session 

Displays the Current Session to the user including the start time and 
status of each Sub Session within SFE Austraclear System. 

 

 
 

► View ► Reports ► Explore 

Displays the reports available for the User. Reports can be previewed or 
downloaded; this is accessed by selecting the report required and “Right 
Mouse Clicking”. 
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► View ► Reports ► Properties 

Displays all the Report Properties to the user including:- Download 
directory, Time reports are kept in SFE Austraclear System for and any 
automatically scheduled downloads. 

 

 
 

View Navigation & Functions..cont. 

 

► View ► Calendar 

Allows the users to see all valid System Settlement and non Settlement 
days in the system. The user can select a specific State, and see all valid 
non settlement days for that State.  
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Viewing Specific Invalid Dates 

Select the appropriate sub calendar from the main display. Right Mouse 
Click and select properties. The following window will appear displaying 
the specific days that are invalid System Settlement dates. 
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1.9 Window Navigation & Functions 

Definition 

The “Window” navigation can be found on the main application navigation 
bar. The navigation features are similar to most MS applications. 

 

Function 

The “Window” navigation point allows the user to perform a number of 
generic functions. These functions are further explained below.  

 

SFE Austraclear System Main Menu 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Navigation Steps 

► Window  ► Close All 

  ► Minimise All 

► Restore All 

 

Process Steps 

► Window ► Close All 

Closes multiple SFE Austraclear System sub windows that are open 
within the SFE Austraclear System application. 

 

► Window ► Minimise All 

Minimises multiple sub windows that are open within the SFE Austraclear 
System application. 

 

► Window ► Restore All 

Restores all windows of the SFE Austraclear System application. 

 

 

 

 

 

Window 

► Close All 

► Minimise All 

► Restore All 
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1.10 Help Navigation & Functions 

Definition 

The “Help” navigation can be found on the main application navigation 
bar. The navigation features are similar to most MS applications, and 
takes the user to the SFE Austraclear System Online Help. 

 

Essentially this replaces the FINTRACS User Guide. 

 

Function 

The “Help” navigation point allows the user to perform a number of 
generic functions. These functions are further explained below.  

By pressing “F1” from any screen will display the SFE Austraclear 
System Online screen specific help for the screen you are using. 

 

SFE Austraclear System Main Menu 

 

 

 

 

 

 

 

 

 

 

 

 

 

Navigation Steps 

► Help ► Help Index 

 ► Connection Info 

► About 

 

Process Steps 

► Help ► Help Index 

Help Index will navigate the user to a new window displaying the index for 
all Online Help available within the SFE Austraclear System. 

Alternatively pressing “F1” from any screen will display the specific help 
related to that screen and function. 

 

► Help ► Connection Info 

This displays the connection information from your PC to the SFE 
Austraclear System. 

 

► Help ► About 

Provides information about the SFE Austraclear System, this includes the 
different components within its network. 

  

 

 

Help 

► Help Index 

► Connection Info 

► About 
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2. Administration 
 

Introduction 

In order for each participant to maintain control of its internal security, the 
SFE Austraclear system gives Administrators significant responsibilities 
and the authority to carry out unique procedures. The main role of an 
Administrator is to create and maintain individual users within the 
organisation by allocating each user roles and user actions. Temporary 
passwords may be set for users who become locked out of the system 
and Administrators can register Standard Settlement Instructions (SSI’s) 
and Agreements for the organisation. To ensure continuity in cases of 
absence, Austraclear recommends that participants allocate two 
individuals to act as Administrators.  

2.1 Users 
 

Function 

Create Users and Allocate Proxies 

 

Navigation Steps 

► Sub Participants ► Sub Participants Users Sub Accounts ► Create 
User  

 

Process Steps 

1. Follow the navigation steps above to display the ‘Create User’ 
screen. 

2. Enter the new user details.   Refer to the Glossary for naming 
conventions and further details on the fields.   The following fields 
are mandatory:- 

 User 
 Sub Participant  
 Password 

 Confirm Password 
 Email 

3. The user password can be set as a temporary one if the ‘Set as 
temporary’ box is ticked. The system will force the user to 
change this password when they next log on. 

4. Each Role in the system consists of a group of User Actions.   
Only Roles can be assigned to users, not individual User Actions.  

5. Each participant will be allocated a group of Roles according to 
their participant type.   Administrators can assign one or more of 
the available Roles to each of the Users.   The Create User 
screen will display all the Roles available to your participant type.   

At a minimum a user should be allocated the compulsory role.. 
These are: CL Compulsory Role, CP Compulsory Role and IR 
Compulsory Role. 

6. Under Proxy Information in the Create User screen a list of all 
active Proxies for that Participant will be displayed.   
Administrators can assign one or more of the available proxies to 
a User.   To view roles available within each proxy refer to 
function on next page. 
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Process Steps (cont.) 

 

7. To view all available participant roles select Sub Participants ► 
Roles ► View. 

8. Specify search criteria and click search to view all Roles 
available in the system.   

9. Once all the new user details have been entered into the ‘Create 
User’ screen click OK. 

10. The creation of new users is a two-part process. Once a user is 
created in the system, Administrators will need to contact SFE 
Austraclear Client Services to apply for a unique Digital 
Certificate to enable the new user to connect to the system. 

11. Once a Digital certificate is allocated, the user must enrol the 
certificate in order to gain access to the system. An Enrolment 
Guide document is located in the following Website:    

www.sfe.com.au/index.html?Content/austraclear/operations/exig
o.Htm.   On entering the website, the user should locate the SFE 
DIGITAL CERTIFICATE USER ENROLMENT GUIDE which 
details the Digital Certificate enrolment procedure. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 

 

 

 

 

 

http://www.sfe.com.au/index.html?Content/austraclear/operations/exigo.Htm
http://www.sfe.com.au/index.html?Content/austraclear/operations/exigo.Htm
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Function 

View Roles available within each Proxy 

 

Information 

Proxies allow participants to perform transactions on behalf of their sub 
participants and other participants of the system. 

Users can log on as the “parent” participant and “Act for” those sub 
participants and other participants which they are authorised to access. 

When a proxy is assigned to a user all of the roles attached to that proxy 
will also be assigned to that user. 

Participants may have more than one active proxy with the same sub 
participant however each proxy relationship may contain different roles. 

 

Navigation Steps 

► Sub Participants ► Proxies ► View  

 

Process Steps 

1. Follow the navigation steps above to display the ‘View’ screen. 

2. Specify search criteria and click search to view all proxies 
available to your participant code. 

3. To view the roles available within each active proxy, highlight the 
proxy to be viewed and from the right click menu select View 
Proxy Roles. 

Note: Drop down window showing available proxies (ie as shown on 
Page 8 Navigation screens) can be hidden/unhidden by ticking/unticking 
the right mouse click ‘Act For’ option.   
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Function 

Unlock/Reset Password for User 

 

Information 

The system allows a user 3 attempts to log-on. After the third attempt, the 
user will be locked out and will need to be unlocked by the Administrator.  

User Passwords will expire every 90 days and it is the responsibility of 
each user to change their password.  

If a user fails to change their password on or before the expiry date, they 
have one grace log on attempt. If the user is unable to gain access to the 
system, the Administrator will need to assign a new password.  

New passwords can be set as temporary.   When a user logs on with a 
temporary password, the system will force them to change it before 
allowing them to proceed. 

(NOTE: A Password Administrator cannot reset their own password.) 

 

Navigation Steps 

► Sub Participants ► Sub Participants Users Sub Accounts ► Explore  

 

Process Steps 

1. Follow the navigation steps above to display the ‘Explore’ screen. 

2. Specify search criteria and click search to view the list of users. 

3. To Unlock a User - Highlight a User and from the right click 
menu select Unlock User to unlock a user that has forgotten 
their password. 

4. To Allocate a New Password to a User - Highlight a User and 
from the right click menu select Reset Password to reset a user 
password that has expired. 
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Function 

Modify Contact Details/Assign New Roles or Proxies for a User 

 

Information 

Amending Email Addresses - When a users’ email address is amended 
Participants should ring Austraclear Client Services to advise the new 
details.   It is necessary for SFE to update the Digital Certificate System 
with this information as when the digital certificates come up for renewal 
an email is automatically sent to each user.     If the email address is 
incorrect users will not receive this notification and hence their digital 
certificate will expire and they will not be able to access the Austraclear 
system. 

 

Navigation Steps 

► Sub Participants ► Sub Participants Users Sub Accounts ► Explore  

 

Process Steps 

1. Follow the navigation steps above to display the ‘Explore’ screen. 

2. Specify search criteria and click search to view the list of users. 

3. Highlight the user to be modified and from the right click menu 
select Properties to modify contact details, assign new roles and 
proxies to a user. 

4. The following fields in the Properties view may be modified for 
existing users:  

 Contact Information 
 State 
 Assigned Roles 
 Proxy Information 

5. The Assigned Roles displayed in Properties for a user reflect the 
roles available to your participant type eg CL = Clearing 
Participant/CP = Cash provider 

6. Once user details are completed click OK. 

Note; If assigning roles that give access to menu drop downs, users will 
be required to log off and log back in to make the changes available. 

 

 

Function 

Inactivate/Delete a User 

 

Information 

Users that are no longer required may be inactivated or deleted. Deleted 
users may not be reactivated, nor can they be reused.  

 

Navigation Steps 

► Sub Participants ► Sub Participants Users Sub Accounts ► Explore  

 

Process Steps 

1. Follow the navigation steps above to display the ‘Explore’ screen. 

2. Specify search criteria and click search to view the list of users. 
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3. Highlight the user to be deleted and from the right click menu 
select Properties.  

4. In order to delete a user they must first be made inactive.   If 
required change the state from active to inactive and click on OK. 

5. Highlight the User to be deleted and from the right click menu 
select Delete to delete a user that is no longer required. 

 

 

 

 

 

 

Function 

View User Details 

 

Navigation Steps 

► Sub Participants ► Sub Participant Users Sub Accounts ► Explore  

 

Process Steps 

1. Follow the navigation steps above to display the ‘Explore’ screen. 

2. Specify the search criteria and in View dropdown box select User.   
Click Search to view User details or 

3. Specify the search criteria and click search to view Participant 
details, right click and select Show in Tree to view your Participant 
and user details in a tree structure. 

4. Highlight the user and from the right click menu select Properties. 
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Glossary – Users 

 

Field Names Description 
General 
User The unique code used to identify the user.  Naming convention to be used is ‘AAAA2099’ where  

A = Participant Mnemonic (4 characters) 
B = Sub Participant Code (2 digits)  
C = Next available No in series (2 digits). 
e.g. For ABC Company, the 8

th
 user would be ABCA2008 

Sub Participant The sub participant to which the user belongs.  

User Locked Specifies whether the user has been locked out.  

Contact Information 
First name The first name of the user.  

Last name The last name of the user.  

E-mail The E-mail address of the user.  

State 

State The present state of the user.    Can be modified with immediate effect.    One of:  

 
Inactive -      
Active - 
Deleted - 

A created user is inactive until it has been activated. An inactive user cannot log in to the system.      
Active is the normal state of a user, that is, the user can log in and act in the system. 
A user that has been deleted is given the state deleted. A deleted user cannot be activated again. 

Assigned Roles 
Assigned roles A list of the roles assigned to the user. The user will have access to all user actions that are included in at least 

one of the listed roles.  

Proxy Information 
Proxy Information Lists the proxies assigned to the user.  

Note 
Note Free text used to describe the related action. Used for auditing purposes. 
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2.2 Sub Accounts 

 

Function 

Creating Sub Accounts 

 

Information 

All participants must have at least one Holding type sub account. 

With the exception of Associate participants, all participants can create 
multiple sub accounts within a valid Sub Account type. 

 

Navigation Steps 

► Sub Participants ► Sub Participants Users Sub Accounts ► Create 
Sub Account  

 

Process Steps 

1. Follow the navigation steps above to display the ‘Create Sub 
Account’ screen. 

2. Enter the new sub account details.   Refer to the Glossary for details 
on the fields.   The following fields are mandatory:- 

 Sub Account 
 Sub Account Type 
 Sub Account Controller 
 State 

3. The following fields are not applicable to SFE participants and should 
be ignored:- 

 Confirmation By 
 Bank Account 

4. There are four valid Sub Account Types:- 
 CSD Account is restricted for SFE use only. 
 Holding may be used by all participants. 

 Issuer Account is restricted to valid Issuers or Issuer 
Representatives only.  

5. All Sub Accounts can be assigned a Sub Account Priority of Priority, 
Active or Deferred. 

6. The Sub Account Controller may be any of your sub participant 
codes or any sub participant you access via proxy. 

7. Sub Accounts can be assigned a state of Active or Inactive.  

8. If you wish to delete a Sub Account they must be in an Inactive state 
before they can be Deleted. 

9. Sub Account names from Deleted sub accounts cannot be re-used. 

10. Once all the Sub Account details have been completed click OK. 
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Function 

View Sub Account Details 

 

Navigation Steps 

► Sub Participants ► Sub Participant Users Sub Accounts ► Explore  

 

Process Steps 

1. Follow the navigation steps above to display the ‘Explore’ screen. 

2. Specify the search criteria and in View dropdown box select Sub 
Account.   Click Search to view Sub Account details or 

3. Specify the search criteria and click search to view Participant 
details, right click and select Show in Tree to view your Participant 
and sub account details in a tree structure. 

4. Highlight the sub account and from the right click menu select 
Properties. 
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Glossary – Sub Accounts 

 

Field Names Description 
General 
Sub Account A code that uniquely identifies a sub account within a given sub participant. 

Sub Account Description An informative description of the sub account and its purposes. 

Sub Account Type A sub account type holds properties that are common for a group of sub accounts.   The eligible sub account types in the 
system:- 
Issuer Sub Account - The issue sub account is connected to one or more issued instruments. An instrument can only be 
connected to one issue sub account. A positive balance on this sub account signifies a not yet used balance. 
Safekeeping Sub Account - This sub account type is represented by the investor sub accounts which keeps the holdings. 
A positive balance on this sub account signifies a holding i.e. a legal ownership of the holding. 
 

Sub Account Priority The priority of the sub account when it comes to the locking-in of securities.    One of:-  

Priority - 
Active - 
 
Deferred - 

Highest priority. The sub account will be used to lock in cash before sub accounts with other priorities.  
Lower priority than Priority. The sub account will not be used to lock in securities if there is another sub 
account with higher priority. 
The lowest priority.   Securities CANNOT be locked-in on this sub account. 

Sub Account Controller The sub participant to which the sub account belongs. 

Confirmation By The sub participant that has to confirm trades on the sub account, if applicable. 

Bank Account Designates the bank account (at a bank outside of the SFE Austraclear System) that should be credited or debited with 
payments due to, for example, corporate actions in connection with instruments on the sub account. 

Sub Account Holder 
Name The name of the sub account holder 

Id An externally accepted and unique code that identifies the sub account holder 

Cash Record 

Cash Record 
Designates the cash record that should be credited or debited with payments due to, for example, corporate actions in 
connection with instruments on the sub account. 

Cash Record Owner The sub participant that owns the specified cash record. 

State 
State The state of the sub account.   One of:- 

Inactive - A created sub account is inactive until it has been activated, or is about to become deleted. It is only possible to 
delete a sub account in an inactive state.  
Active - Active is the normal state of the sub account and means that it can partake in the actions in the system.  
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Field Names Description 
Note 
Note Free text used to describe the reasons for modifications to the sub account. 
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2.3 SSI’s 

 

Function 

Registering SSI’s 

 

Information 

Standard Settlement Instructions (SSI’s) allow Participants to register and 
store default payment and security instructions for each of their Sub 
Participants for different types of Instruments, Series and Currencies.  

 

It is not mandatory to register Standard Settlement Instructions in the 
system however if no SSI’s exist, trades will not proceed to settlement 
until a Cash Record and/or Sub Account is specified for that trade. 

 

All users have the ability to register SSI’s provided they have been 
assigned at least one of the trade entry related roles e.g. CL DSS Trade. 

 

The system is flexible in that it allows you to register individual SSI’s for 
each Instrument Type using different Sub Accounts and/or Cash 
Records, provided you have more than one Sub Account and Cash 
Record set up in the system.   If you wish to nominate one Sub Account 
and Cash Record as the “default” accounts for all transactions, you can 
omit the selection of an Instrument Type and just select that Sub Account 
and Cash Record for your sub participant.   This becomes the SSI the 
system defaults to every time you enter a trade for any Instrument Type.     

 

When trades are created in the system the SSI field defaults to “Y” 
indicating that the cash will settle via the default Cash Record and Sub 
Account.   If participants wish to select an alternate Cash Record and/or 
Sub Account on a transaction by transaction basis, they must select “N” 
in the SSI field. The drop down list in the Cash Record and Sub 

Account fields may then be used to select from the list of available Cash 
Records and Sub Accounts. 

 

 

 

Navigation Steps 

► Sub Participants ► View Standard Settlement Instructions  

 

Process Steps 

1. Follow the navigation steps above to display the ‘Standard 
Settlement Instructions’ screen. 

2. From the right click menu select Register SSI. 

3. Standard Settlement Instructions can be registered for each of the 
Instrument Types, Instrument Classes, Series and currencies OR 
registered at Sub Participant level only. 

4. Refer to the Glossary for further details on the fields.    Select the 
Sub Participant.   Next enter details into any one of the following 
fields:- 

 Instrument Type 
 Instrument Class 
 Series 
 Currency 

The entry can be which would cover all values for that particular 
field. 

5. Once details have been completed, enter the Sub Account and Cash 
Record then click Send. 
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Function 

Rectify/Cancel an existing SSI 

 

Navigation Steps 

► Sub Participants ► View Standard Settlement Instructions  

 

Process Steps 

1. Follow the navigation steps above to display the ‘Standard 
Settlement Instructions’ screen. 

2. Specify the search criteria and click Search to view all existing SSI’s. 

3. To Rectify - From the right click menu select Rectify SSI.   Amend 
the details and click Send. 

4. To Cancel - From the right click menu select Cancel SSI.   Check 
the details and click Send. 

 

Function 

View SSI Versions 

 

Navigation Steps 

► Sub Participants ► View Standard Settlement Instructions  

 

Process Steps 

1. Follow the navigation steps above to display the ‘Standard 
Settlement Instructions’ screen. 

2. Specify the search criteria and click Search to view all existing SSI’s. 

3. From the right click menu select SSI Versions. 

4. The screen will display all previous versions of a selected SSI. 

 

Function 

Confirm DVP Instruction 

 

Information 

There may be instances where a) a trade is entered with SSI = Y but no 
SSI’s have been registered in the system or b) a trade is entered with SSI 
= N but no alternative Cash Record and/or Sub Account has been 
selected for the trade. 

If either occurs the trade will still proceed to a “Matched” state, however 
the resulting DVP Instruction will be assigned a state of “Holding” and the 
trade will not proceed to settlement.   You will be required to perform a 
“Confirm DVP” in the DVP Information screen to nominate a Cash Record 
and/or Sub Account to that trade before settlement can be effected. 

 

Navigation Steps 

► Trades ► View Reported Trades  
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Process Steps 

1. Follow the navigation steps above to display the ‘View Reported 
Trades’ screen. 

2. Specify the search criteria and click search. 

3. Highlight a trade and from the right click menu select DVP 
Information.   Two DVP Instructions will be displayed with a Settle 
Status of “Holding”. 

4. Highlight the DVP Instruction and from the right click menu select 
Confirm DVP.   Select a sub account in the First DVP Account field 
and a cash record in the Second DVP Account field and click Send. 
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Glossary – SSI’s 

 

Field Names Description 
Sub Participant Identification of an organisation unit within the participant to which the SSI is designated.   The system will display a 

wildcard ‘*’ however a sub participant must be selected from the drop down list to enable the creation of a valid SSI. 

Cash record Cash record / cash account specification. 

Created Date and time when a new version of the SSI item was last created caused by an event or action such as: registering, 
rectification or cancellation.    The Version number was incremented at the same time. 

Currency Currency code for a valid payment series. 

Instrument class Instrument class long name. 

Instrument type Instrument type long name 

ISIN International Securities Identification Number (ISIN). 

Reg name Windows user identification of the user who performed the registering of the SSI in the SFE Austraclear System on behalf 
of the party.   The field is updated with the Windows user identification of the last user who performed a rectification or 
cancellation of the SSI in the SFE Austraclear System on behalf of the party. 

Series Traded instrument series identification for which the SSI will be valid. 

Settlement instruction Free text describing settlement. 

SSI id SSI identification, automatically assigned and used by the system to identify the SSI item. 

SSI State SSI state options: 

Active - 
Cancelled - 

the SSI is active; it can be modified 
the SSI is cancelled 

Sub account Sub account / security account identification. 

Version nbr Number defining the version of the SSI (starting with 1 when the SSI is registered).    A new version of the SSI is triggered 
by an event or action such as: rectification or cancellation. 
For each new version the Version nbr is incremented and the Created date is set to <current business date>. 
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2.4 Agreements 

 

Function 

Registering Agreements 

 

Information 

Only ISDA-SWAP, FRA-AGREE and REPO-AGREE Agreement Types 
may be registered in the system. 

Only one Active Agreement per Instrument Type can exist between two 
counterparties at one time. 

Once an Agreement is registered, all transactions for that Instrument 
Type will record which Agreement was in place at the time of confirmation 
of the transaction. 

 

Navigation Steps 

► Sub Participants ► View Agreements  

 

Process Steps 

1. Follow the navigation steps above to display the ‘Agreement’ screen. 

2. From the right click menu select Register Agreement. 

3. Refer to the Glossary for further details on the fields.   One of the 
following fields are mandatory and matching fields:- 

 Counterparty 
 Agreement Type 
 Instrument Type 
 Agreement Date 

The entry can be which would cover all values for that particular 
field. 

4. All registered Agreements will need to be matched by the 
counterparty. 

5. Once details have been entered click Send. 

 

 

   
 

Function 

Rectify/Cancel Agreements 

 

Information 

Agreements in an Unmatched state may be cancelled and all fields may 
be rectified. 

Agreements in a Matched state may only have the following fields 
rectified: 

 Agreement Date 
 Agreement Version 

Agreements in a Matched state may not be cancelled. 

 

Navigation Steps 

► Sub Participants ► View Agreements  
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Process Steps 

1. Follow the navigation steps above to display the ‘Agreement’ screen. 

2. Specify search criteria and click Search to view all existing 
Agreements. 

3. To Rectify - Highlight the Agreement and from the right click menu 
select Rectify Agreement.   Rectify details and click Send. 

4. To Cancel – Highlight the Agreement and from the right click menu 
select Cancel Agreement.   Check detail and click Send. 

 

Function 

View Agreement Versions 

 

Information 

Agreements in an Unmatched state may be cancelled and all fields may 
be rectified. 

Agreements in a Matched state may only have the following fields 
rectified: 

 Agreement Date 
 Agreement Version 

Agreements in a Matched state may not be cancelled. 

 

Navigation Steps 

► Sub Participants ► View Agreements  

 

Process Steps 

1. Follow the navigation steps above to display the ‘Agreement’ screen. 

2. Specify the search criteria and click Search to view all existing 
Agreements. 

3. From the right click menu select Agreement Versions. 

4. The screen will display all previous versions of a selected 
Agreement. 
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Glossary – Agreements 

 

Field Names Description 
Agreement date Agreement date, the date that the parties agreed to sign the agreement. 

The date is entered by the user and not validated by the system. 

Agreement id Agreement identification, automatically assigned and used by the system to identify the agreement item. 

Agreement type Agreement type can be defined within the system, such as: ISDA, FRABBA 

Counterparty Identification of an opposite party with whom the agreement is signed. 

Created Date and time, when a new version of the agreement item was last created caused by an event or action such as: 
registering, matching, rectification or cancellation. 
The Version number was incremented at the same time. 

Instrument type Instrument type for which the agreement is valid. 

Participant Identification of a participant of the clearinghouse for the party to whom the agreement is registered. 

Reg name Windows user identification of the user who performed the registering of the agreement in the SFE Austraclear System on 
behalf of the party. 
The field is updated with the Windows user identification of the last user who performed a rectification or cancellation of the 
agreement in the SFE Austraclear System on behalf of the party. 

Agreement State Agreement state options:- 

Matched - 
Unmatched - 
Cancelled - 

the agreement is active and matched 
the agreement is active but not matched 
the agreement is cancelled 

User Trading code of the user within the party who performed the registering of the agreement in THE SFE AUSTRACLEAR 
SYSTEM. 
If a Clearing Office user performed the registering of the agreement in the SFE Austraclear System on behalf of the party, 
User is set to XXXXX. 

Version Agreement version description, optional free text. 

Version nbr Number defining the version of the agreement (starting with 1 when the agreement is registered). 
A new version of the agreement is triggered by an event or action such as: matching, rectification or cancellation. 
For each new version the Version nbr is incremented and the Created date is set to <current business date>. 
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2.5 Participant Details 
 

Function 

Maintaining Participant Details/Record TFN/ACN/ABN 

 

Information 

Participant contact details including contact names, addresses, email 
addresses and telephone and fax numbers must be maintained by the 
Password Administrator, however participants cannot modify the 
Participant Name, Participant Type or Investor Type fields. 

Administrators are responsible for recording TFN and ACN or ABN 
details on the system for each of their sub participants.   For security 
purposes the TFN number is masked and will appear as *********. 

If the ABN or TFN is not recorded, withholding tax will be deducted from 
coupon interest payments at the withholding tax rate (currently 48.5%).   
If the ABN is recorded in place of the TFN, then withholding tax will not 
be deducted.   If the Participant wishes to claim exemption please use 
one of the following codes in the TFN field:-    

 555 555 555 not required to lodge return - refer section 23(d) of 
the Income Tax Assessment Act or  

 666 666 666 Claiming exemption – refer section 202(d) of the 
Income Tax Assessment Act. 

 

Navigation Steps 

► Sub Participants ► Sub Participant Users Sub Accounts ► Explore  

 

Process Steps 

1. Follow the navigation steps above to display the ‘Explore’ screen. 

2. Specify the search criteria and click Search to view Participant 
details. 

3. Highlight the Participant code and from the right click menu select 
Properties. 

4. In the Properties view, the section titled External ID is used to 
record the TFN/ACN/ABN details.  

 

 

 

5. Participants with a Participant Type of Cash Provider, may also 
update the Cash Provider BSB field in the External ID section. 

6. The section titled Contact Information is used to maintain the 
Participant contact names, addresses, email addresses and 
telephone and fax numbers. 

7. Refer to the Glossary for further details on the fields.    
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Function 

View Participant Details 

 

Navigation Steps 

► Sub Participants ► Sub Participant Users Sub Accounts ► Explore  

 

Process Steps  

1. Follow the navigation steps above to display the ‘Explore’ screen. 

2. Specify the search criteria and in View dropdown box select Sub 
Participant.   Click Search to view Participant details or 

3. Specify the search criteria and click search to view Participant 
details, right click and select Show in Tree to view your Participant 
details in a tree structure. 

4. Highlight the Participant code and from the right click menu select 
Properties. 
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Glossary – Participant Details 

 

Field Names Description 
General 
Sub Participant The unique code that is used to identify the sub participant. Cannot be modified. 

Parent Sub Participant Specifies to which sub participant the sub participant belongs, if any. Cannot be modified.  

Sub Participant Type Defines the kind of relationship that the sub participant has to the CSD. One of:  
 

Clearing Sub Ptpt - A sub participant that participates in the clearing and settlement of trades. 

Institutional Investor - 
 

A sub participant, typically a large institutional investor, who is allowed to participate in clearing and 
settlement. 

Payment System - 
 

The payment system controls the settlement counterparts' cash positions. The payment system locks 
the amount of cash required for the settlement process and transfers payments between sub 
participants. 

Cash Provider - 
 

A sub participant that supplies cash for clearing sub participants in the payment system. The cash 
provider manages this by means of a standing or a temporary cash limit for the clearing sub participant 

Clearing House/CCP- An organisation, which nets settlement transactions and acts as a central counterpart. 

Sub A/C Controller - 
 

A sub participant responsible for the maintenance of the accounts towards the account holder. The sub 
account controller can open or close accounts, as well as interact with the system regarding the 
holdings at the account. 

Issuer - The issuer borrows money on the market by issuing securities. 

Issuer Rep - 
 

The issuer representative is a sub participant that is authorised to act on behalf of the issuer in the 
system. 

Linked CSD - 
 

A linked CSD is either receiving or sending securities to or from SFE Austraclear. Depending on the 
direction of the securities, it is either confirming the reception of securities, or sending the request to 
deposit securities. 

Issuer CSD - The sub participant controlling the Issuer CSD Account. 

Borrower - 
 

A sub participant that has signed an agreement to be a borrower within the SFE Austraclear system. 

Lender - A sub participant that has signed an agreement to be a lender within the SFE Austraclear system. 

Netting Sub Ptpt - A sub participant that can be involved in the payment netting external source settlement. 

External Identification 
Investor Type The investor type of the sub participant. One of:- 
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Field Names Description 
 Company - 

Trust - 
A company is a separate legal entity that is taxable on its net income. 
A trust exists when a person holds property for others from which they can benefit. 

TFN Tax File number.  

ACN/ARBN Australian Company Number.  

ABN Australian Business Number.  

Cash Provider BSB A seven positions alpha-numeric Bank State Branch code that uniquely identifies the cash provider for reporting purposes. 

Clearing Bank Bank Identification Code for the Clearing Bank where the cash provider’s bank account resides.  

Clearing Bank Accounts 
Account The bank account that the cash provider has at the clearing bank. The clearing bank is a sub participant of type payment 

system and is assigned to the currency in the instrument configuration.  

Currency The denomination currency of the bank account.  

Default 
Default Sub Account The sub participant's safekeeping sub account, only allowed for certain sub participants.  

Default Cash Records Lists the sub participant's cash records, one cash record per currency.  

Contact Information 
Sub Participant Name The full name of the sub participant.  

Country The country code for the sub participant. Displayed as a two letter code.  

Postal Code The postal code.  

City The name of the city.  

Province or State The province or state.  

Address The sub participant's address.  

Contact Person The contact person for the sub participant.  

Phone Number the telephone number to the contact person.  

Fax Number The fax number to the sub participant’s office.  

E-mail The e-mail address to the contact person.  

State 
State The state of the sub participant. One of:-  

 Inactive -  
Active - 

The sub participant is not allowed to participate in any new actions in the system when it is set to Inactive. 
Active is the normal state of the sub participant and means that all user actions can be performed, as long as no 
other limitations are valid. 

Suspended Indicates whether the sub participant is suspended. A suspension covers the exclusion of all the sub participant's users and 
proxies.  

Instruments Issued 
Instrument The instruments that the sub participant has issued in the system.  

Amount Unit Controls weather the amount of the instrument should be counted in quantity or as face value of denomination currency.  

Currency The instrument's denomination currency.  
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Field Names Description 
Issue Balance The issue balance for the instrument.  

Note 
Note Free text that describes the reasons for the action. 
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2.6 Authorisations (Administration Functions 
Only) 

 

Function 

Authorise/Reject Actions Pending Authorisations 

 

Information 

Authorisation is available on the following administration actions: 
 Create and Modify Sub Accounts 
 Create and Modify User 
 Modify Sub Participant   
 Create and Modify Series 
 Create Series Delegated 

A User cannot Authorise an Administration action that has been entered by 
that same user. An alternate User must authorise those actions. 

 

Navigation Steps 

► Administration ► Authorisations ► View Actions Pending Authorisation  

 

Process Steps 

1. Follow the navigation steps above to display the ‘Actions Pending 
Authorisation’ screen. 

2. A list of Administration actions pending authorisation will be displayed.    

3. To Authorise - Select an action to be authorised and from the right click 
menu select Authorise Action to authorise the transaction. 

4. To Reject - Select an action to be rejected and from the right click menu 
select Reject Action to reject the transaction. 

5. Refer to the Glossary for further details on the fields.    
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Glossary – Authorisations 

 

Field Names Description 
Operation The operation associated to the action that needs to be authorised. 

Timestamp The time when the note was created in the action that needs to be authorised, in UTC time. 

User The identity of the user that performed the action that needs to be authorised. 

Note Text A free text describing the action. 

Affected Object The name of the object that needs the authorisation. 

Object Type The type of object that needs the authorisation. 

Action Type The type of action. 

Participant The identification of the participant. 
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2.7 View Notes (For Audit Purposes) 
 
 

Function 

View Notes created by the system for Administration purposes 

 

Information 

When Administrators perform actions such as Creating a User, Modifying a 
User or Modifying Participant details, a “Note” is automatically created in 
the system. This “Note” includes details of the action performed, the user 
who performed it and the time it was performed.  

If an existing user is modified or participant details are updated, it will be 
possible to view the “Note” both before and after a change was made.  

The Notes screen is archived in the system for 90 days, therefore allowing 
participants to keep a record of their Administrator’s activity for audit 
purposes.    

 

Navigation Steps 

► View ► Notes  

 

Process Steps 

1. Follow the navigation steps above to display the ‘Notes’ screen. 

2. A list of Notes created by the system will be displayed.    

3. To view the details of a Note, highlight the Note and from the right 
click menu select Properties. From here it is possible to view the note 
before and after a change has been made. 
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3. Cash Clearance 

 

Introduction 

The Cash Clearance module provides for the automated settlement of 
cash transactions conducted on the Austraclear system. The system has 
been developed to provide a payments system that will manage the 
settlement of daily Austraclear transactions in an RTGS environment. 
The system allows banks to control exposures to SFE Austraclear 
customers in two ways: 

1. Under a debit cap environment, banks are able to impose a cash limit 
on each of their SFE Austraclear participants’ accounts. This is 
referred to in the system as Internal Credit Management.   

2. Through the RTGS/RITS AIF facility, banks have the ability to make 
real time credit decisions about their SFE Austraclear participants’ 
transactions. 

 

Banks may operate in two clearance type modes: 

1. AIF - AIF banks may manage their customers’ credit exposure either 
in their own Proprietary Payments System (PPS) or in Debit Caps. 
AIF Banks may also receive pre and post settlement advices for their 
customers’ transactions. 

2. Non-AIF - Non-AIF banks must manage their customers’ credit 
exposure through Debit Caps. A non-AIF bank cannot receive pre 
and post settlement advices. 

 

Additionally, the system allows all Cash Providers to maintain an Assured 
Payment Limit which becomes effective in the event that RTGS is not 
available and the system reverts to Assured Payment mode.  

The system also provides for the confirmation of maturing securities 
(corporate actions) by cash providers and paying agents, with proceeds 
credited to participants’ cash records in the Austraclear system.  

 

 
 

3.1 Cash Records 

 

Function 

Cash Record Maintenance as Cash Provider 

 

Information 

All cash records will be created on the system by SFE Austraclear with 
fields set to default values. It is the responsibility of Cash Record 
Providers to check and modify these fields as required. 

 

Navigation Steps 

► Sub Participants ► Cash Records ► View  

 

Process Steps 

1. Follow the navigation steps above to display the ‘View’ screen. 

2. Specify search criteria and click search to view the Cash Records of 
your SFE Austraclear customers.  

3. Highlight the cash record to be modified and from the right click 
menu select Properties As Provider. The system will display details 
of the selected cash record. 

4. Modify the appropriate fields and/or enter a Cash Limit.   Refer to the 
Glossary for further details on the fields.    

5. The following Cash Record fields may be modified:- 
 Cash Limit 
 Temporary Adjustment 
 Internal Credit Management 
 Pre Settlement Advice 
 Priority 
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 Post Settlement Advice 
 Cash Record Priority  

6. The Cash Limit field displays the amount that the cash record can go 
into debit when the system is operating in an RTGS environment.   
Cash providers who are Non-AIF Banks must set a Cash Limit on 
each of their customers’ cash records. 

 

7. The Temporary Adjustment field displays the adjustment from the 
normal cash limit to which the cash record can go into debit  when 
the system is operating in an RTGS environment. Updates to this 
field are valid intraday only. 

8. All Banks regardless of clearance mode may set their customer cash 
records to Internal Credit Management = True.  All transactions for 
those cash records must pass the debit caps limit test before being 
sent to RTGS for processing. (Note: any change to the Internal Credit 
Management ‘flag’ may take up to 30 minutes before it becomes 
effective.)  

9. Only banks with a clearance type AIF may set their customers’ cash 
records to Internal Credit Management = False.   AIF banks must 
also complete the following three fields for each customer’s cash 
records: 

 The Pre-Settlement Advice field may be set to True or False. If 
set to True an instruction will be sent to RTGS to create a Pre-
Settlement Advice. 

 The Priority field instructs RTGS how to prioritise transactions 
sent from the system. This field can be set to Active, Deferred or 
Priority. 

 The Post-Settlement Advice field may be set to True or False.   If 
set to True an instruction will be sent to RTGS to create a Credit 
Post-Settlement Advice. 

 The Cash Record Priority field determines how transactions will 
progress on the settlement queue within Austraclear. This field 
can be set to Active, Deferred or Priority. 

10. Once all the details have been entered click OK. 

 

 

 

Function 

Cash Record Maintenance as Cash Record Owner 

 

Information 

All cash records will be created on the system by SFE Austraclear with 
fields set to default values. It is the responsibility of Cash Record Owner 
to check and modify the cash record priority as required. 

 

Navigation Steps 

► Sub Participants ► Cash Records ► View  

 

Process Steps 

1. Follow the navigation steps above to display the ‘View’ screen. 

2. Specify search criteria and click search to view your Cash Records.  
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3. Highlight the cash record to be modified and from the right click 
menu select Properties As Owner. The system will display details of 
the selected cash record. 

4. Modify the cash record priority field as required.   Next click on OK.  

 

 

Function 

View Cash Records 

 

Navigation Steps 

► Sub Participants ► Cash Records ► View  

 

Process Steps  

To view details of a cash record if you are the Cash Record Owner 

1. Follow the navigation steps above to display the ‘View’ screen. 

2. Specify your sub participant code in the Cash Record Owner 
search field and click search to view your Cash Records.    

3. Highlight a Cash Record and right click to View Cash Record 
Transactions. 

To view details of a cash record if you are the Cash Provider 

1. Follow the navigation steps above to display the ‘View’ screen. 

2. Specify your Cash Provider sub participant code in the Cash Provider 
search field and click search to view your customers’ Cash Records. 
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Glossary – Cash Records 

Field Names Description 

Cash Record The code that together with cash record owner uniquely identifies a cash record in the system.  

Currency The currency that is held on the cash record. Only one currency per cash record is allowed.  

Cash Record Owner The owner of the cash record, that is, the person or organisation that uses the cash record.  

Cash Provider The participant (of Cash Provider type) that supplies cash to clearing participants by letting them use its own cash account 
in the payment system. This is managed by the creation of cash records in the system, where the cash record owner is the 
clearing participant.  

Cash Limit The amount to which the cash record is allowed to go into debit. That is, the amount of cash available to the cash record 
owner within the system, set by the cash record provider. The field may be set to zero.  

Temporary Adjustment A temporary adjustment from the normal cash limit, only valid during the current day.  

Reservations The amount of cash on the cash record that has been reserved, for example, to be transferred as a payment.  

Balance The balance is the total sum of the amounts in all settled settlement obligations for one cash record, including reserved 
amounts.  

Has Assigned Checked if the owner has assigned cash records to other participants.  

State 
The state of the cash record.   One of: - 

 
Active - 
Inactive - 
 
Deleted - 

The cash record is "alive", that is, it can take part in transactions within the system. 
An inactive cash record cannot take part in any transactions within the system. It is automatically prevented 
from being part of any transactions registrations. Only inactive cash records can be deleted. 
The cash record has been permanently deleted, meaning that it cannot take part of any transactions, and 
cannot be re-activated. It will remain in the system until the system is purged. 
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3.2 Assured Cash Limits 

 

Function 

Assured Cash Limit Maintenance 

 

Information 

This allows cash providers to enter a cash limit which becomes effective in 
the event that RTGS is not available and the system reverts to Assured 
Payment Mode.    

Once the Assured Payment mode has been triggered, the Assured Cash 
Limit of each cash provider automatically propagates down to the cash limit of 
each of the cash records belonging to the customers of that cash provider. 
This limit will override the existing cash limit of each customer’s cash record 
while the system remains in Assured Payment mode. 

When the system resumes operating in RTGS, the cash limits of the 
customer cash records will be reset to their original values. 

 

Navigation Steps 

► Sub Participants ► Sub Participants Users Sub Accounts ► Explore  

 

Process Steps 

1. Follow the navigation steps above to display the ‘Sub Participant 
Explorer’ screen. 

2. Specify search criteria and click search to view the Cash Provider Sub 
Participant details.    

3. Highlight the Sub Participant code and from the right click menu select 
Properties.  

4. The Assured Cash Limit field can be modified once the system is 
operating in Assured Payment mode. 

5. Once the appropriate fields have been modified click OK. 
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3.3 Corporate Actions 

 

Function 

View DSS Maturity Corporate Actions 

 

Information 

Corporate Actions for Discount Securities consist of Maturity payments only. 

All Maturity Corporate Actions will be created automatically by the system in 
the overnight recurring tasks depending on the template setup. 

The ability to View Holder List on Corporate Actions is restricted to Issuer 
Representatives only. (This list will be available on the day of the Corporate 
Action) 

Discount Security Series that have matured will be displayed in the View 
Series screen until the following day. 

 

For Issuers Only 

On the Maturity Date, the Issuer (or their Paying Agent) will be able to print 
the “Maturing Securities Report” via the Report Server, which will detail 
maturity payments due that day and the holders entitled to receive those 
payments.   The same details may also be obtained via the on line enquiry 
screens and requested as .csv files. 

After ensuring the details reported are correct, the Issuer (or their Paying 
Agent) will access the View Corporate Actions Settlement Instructions 
screen to Instruct (Confirm) payments of maturities for the day. 

Maturity proceeds are payable on an Irrevocable (I) settlement basis only. 

Maturity payments for Discount Securities are available for confirmation upon 
System open each morning. 

 

 

 

 

 

 

For Holders of Discount Securities  

Participants who hold Discount Securities within the system will receive 
automatic maturity payments to their nominated cash record. 

Participants will be able to view information relating to Maturity Payment 
Dates for each of the series available via the View Corporate Actions 
screens. 

On the morning of the payment day the Income Receivable Report will be 
available via the Report Server for holders of Discount Securities.   This 
report will display all maturity payments due to the Holder for that day.   
These details may also be obtained via the on line enquiry screens and 
requested as .csv files. 

 

Navigation Steps 

► Series ► View Corporate Actions  

 

Process Steps 

1. Follow the navigation steps above to display the ‘Corporate Actions’ 
screen. 

2. Specify search criteria and click search to display current Corporate 
Actions.   The Corporate Actions displayed will be for Maturities and 
Coupon Payments. 

3. To view the Holder List, right click and select View Holder List. 

4. To view the details of an individual Corporate Action, right click and 
select Properties. 

5. Refer to the Glossary for further details on the fields.    
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Function 

View Corporate Actions Settlement Instructions and Select Instruct – For 
Issuers Only 

 

Navigation Steps 

► Settlements ► View Settlements ► Corporate Actions Settlement 
Instructions 

 

Process Steps 

1. Follow the navigation steps above to display the ‘Corporate Actions 
Settlements Instruction’ screen. 

2. Specify search criteria and click search to display current Corporate 
Action Settlement Instructions.    

3. Alternatively select Corporate Action from the operation type drop down 
menu and press search.   This will display the Actual Gross Corporate 
Action to be instructed and not list every single Corporate Action. 

4. Select the Corporate Action to be released, right click and select 
Instruct Underlying Obligation.   This will release the Corporate Action 
for Settlement. 

5. To view the details of an individual Corporate Action, right click and 
select Properties. 

6. Refer to the Glossary for further details on the fields. 
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Function 

Monitor Corporate Action Execution 

 

Information 

This is available to Issuer Representatives only.   This screen provides a 
summary of all Corporate Actions for the current business day for that Issuer 
and shows the current settlement state for each Corporate Action.    

 

Navigation Steps 

► Administration ► Monitor ► Corporate Action Execution 

 

Process Steps 

1. Follow the navigation steps above to display the ‘Monitor Corporate 
Action Execution’ screen. 

2. Enter search criteria and click Search to display execution states. 

3. Select ‘Preparing for Settlement’ then right click and select Corporate 
Action Settlement Instructions. 

4. Issuer Representatives may Instruct their Corporate Action payments 
from this screen via a right click action and selecting instruct 
underlying obligations. 

5. A message will appear asking the Issuer to confirm the instructing 
settlement instruction.   Click Yes. 

6. Refer to the Glossary for further details on the fields. 
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Glossary – Corporate Actions 

 

Corporate Actions 

Field Names Description 

Corporate Actions Corporate action name. 

Complete Yes - 
No - 

Indicates that the corporate action setup is completed. 
Indicates that additional information is required before completion. 

List Complete Specifies if the corresponding holder list is completed. 

State State of the corporate action. 

Underlying Series The underlying series code which gives the holder rights to entitled benefits.  

Description Description of the underlying series. 

Event Short name of the corporate action event. 

Issuer  Sub Participant code of the issuer. 

Issuer Representative Sub Participant code of the issuer representative or CSD itself. 

Record Datetime Date when the system should check which investors should be entitled to the benefits. 

Mandatory Indicates whether the corporate action is mandatory or optional. By default set to True (mandatory). 

 

Corporate Action Holder List 

Field Names Description 

Corporate Action The unique code used to identify the Corporate Action. 

Record Datetime The date and time when the list was recorded. 

List Completed  Is set to TRUE if no further entries are expected to the list. 

Sub Participant The sub participant to which the sub account belongs, i.e. the sub account controller. 

Sub Account The sub account to which the holding belongs. 

Volume The total volume of security held. 

Alternative If there are different alternatives, the choice is specified here. 

Benefit Defines which instructions are included and the execution date they should be settled. 

 

Corporate Actions Settlement Instructions 

Field Names Description 

Corporate Action Corporate action name. 

Event Ref Code The corresponding corporate event.  

Series The series involved in the corresponding trade. 
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Field Names Description 

Issuer The sub participant that issued the series.  

ISIN The ISIN code of the series.  

Settlement Instruction 
Number 

Sequence number that uniquely identifies the instruction. Set by the system. 

Settlement Date The settlement instruction's settlement date. 

Volume The size of the delivery. 

Sub Account The sub account code. 

Payment Amount Specification of the payment amount. 

Payment Currency Specification of the currency. 

Message Type Specifies properties that decide how the settlement is to be handled. One of the following:- 
  

DVP - The security is delivered in exchange for the payment, in a final and irreversible manner. 
Note: This message type is also used for DaP, Delivery and Payment, by changing the sign for 
the amount to be paid. 

DVD - The security is delivered in exchange for another security, in a final and irreversible manner. 

FOP - A security is delivered without any kind of delivery in the opposite direction. 

PVP - An amount of money is transferred in exchange for another amount of money. 

PVN - An amount of money is transferred without any kind of delivery in the opposite direction. 

CANC - Request to cancel another instruction. 

REC - A recall instruction. 

NOM - The sub participant nominates the security that will be used for trading later. 

RNOM - Message type used when the sub participant wants to release a bill nomination. 

PLVPL - This is used to substitute a parcel of unpledged securities for a parcel of pledged securities. The 
substitution is initiated by the pledgee and completed once the counterparty confirms. 

PLVP - Funds are transferred from the pledgee's bank sub account to the pledgor's sub account after 
passing the cash limit test, and a hold is placed on the pledged securities. 

PLOP - No cash is transferred between the sub participant's cash records by the system but a hold is 
placed on the pledged securities. 

RLVP - Funds are transferred between the pledgee's and pledgor's cash records after passing the cash 
limit test, and the pledged securities are released. 

RLOP - No cash is transferred by the system, between the sub participants' cash records but a release is 
made in the pledged securities. 

CORP - The message is a result of a benefit instruction of a corporate action. 
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Field Names Description 

TRANS - One-sided transfer of a holding between a sub participant's sub accounts. 
 

Operation Type Specifies the type of operation that resulted in the settlement instruction being created. One of the following:-  
 

NORMAL - A normal settlement instruction. 

MATP - Maturity payment. 

CPON - Coupon. 

PAYM - Payment. 

CORP - Corporate Action. 

SFET - SFE Transaction, special cash payment for margin requirement. 

RBA REPO - First leg in create liquidity repo. 

REVERSE RBA 
REPO - 

Second, or reversed, leg in create liquidity repo. 

  
 

Settlement Method Specifies the settlement method to be used to settle the corresponding trade. One of the following:-  
 

RTGS Real Time Gross Settlement. Trades are settled individually and immediately.  

EoD Gross settlement at the end of day, when the system is in end-of-day mode.  

External Gross settlement of securities legs only, the cash is handled outside of the system.  

BISM1 Gross settlement, trade for trade at a given point in time.  

BISM2 Batchwise net settlement for cash legs but gross settlement for securities legs.  

BISM3 Batchwise net settlement.  

RTAIB Real time adjust issue balance, that is, the settlement is done immediately. 

BAIB Batch adjust issue balance, that is, the settlement is done at the specified time. 

DWNET Deposit/Withdraw net, used for netting settlement instructions in the deposit/withdrawal of 
securities functionality. 

Payment Netting Net settlement of cash. 
 

Sub Participant The sub participant involved in the leg of the deal to which the settlement instruction refers.  

Cash Record A code that together with the cash record owner uniquely define a cash record in the system. 

Cash Record Owner The owner of the cash record. 

State The state of the settlement instruction. One of:  

Unmatched The instruction has been created but not yet matched with the instruction of the other leg in the 
deal.  
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Field Names Description 

Matched The instruction has been matched with the instruction of the other leg in the deal.  

Recall Requested A recall has been requested for the instruction.  

Pending Payment 
System Recall 

The recall request has been passed on to the payment system.  

Cancelled The instruction has been cancelled successfully.  

Cancel Pending A sub participant has requested to cancel the settlement instruction.  

Cancel Requested The counterparty has requested to cancel the settlement instruction.  

Cancel Completed A cancel request has been completed.  

Recall Complete The recall request has been completed.  

Recalled A sub participant has recalled the instruction.  

Recalled by 
Counterpart 

The counterpart has recalled the settlement instruction.  

Rejected The instruction has been rejected by a user.  

Completed Final state for a settlement instruction involved in corporate action, where the settlement 
instruction is only used to lock in the issuers amount and will never settle.  

Settled The settlement has been carried out successfully.  

Failed The instruction failed to be settled.  
 

Instructed Specifies if the settlement instruction will be automatically executed (True) or if it has to be finally instructed by the sub 
participant as a separate action (False).  

Counterpart The sub participant that acts as a counterpart in the transaction.  

Issuer Representative The sub participant code of the issuer representative taken from the underlying series. 

 

Monitor Corporate Action Execution 

Field Names Description 

Corporate Action The name of the corporate action.  

No. of Settlement 
Instructions 

The number of settlement instructions for the corporate action. 

State The state of the corporate action. One of:-  
 Planned  
 Holder List Created  
 Settlement Instruction Created  
 Preparing for Settlement  
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Field Names Description 

 Currently executing  
 Successfully executed  
 Failed 

 
 
 

Note: Corporate actions that are not instructed prior to End of Day will be Failed in the overnight batch run. The ‘Failed’ status will not be able to be viewed until 
next day. 
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3.4 Cash Clearance Sessions 
 

When DAY session ends at End of Day (EOD) 4:28pm Eastern Standard 
Time (EST), the following rules apply:- 

 Any existing transactions already on the RTGS queue can settle 
up to the end time of DAYEND session (5:17pm). 

 No new transactions with a cash element are allowed to settle 
until the EVENING session (5:25pm – 6:32pm winter and 5:25pm 
– 8:32pm summer). Settlement in EVENING session is only 
allowed between approved CLS Banks.  

 

At the close of DAYEND session (5:17pm), the following rules apply:- 

 All transactions on the RTGS queue where one or both parties 
 to the transaction are not approved CLS Banks will be 
 automatically Recalled/Rejected. 

 All transactions on the RTGS queue where both parties to the 
transaction are approved CLS Banks will be retained on the 
queue for possible settlement in the EVENING session. 

 

At INTERIM session (5:17pm – 5:25pm), the following rules apply:- 

 An Interim Cashlist is produced for printing. This report will 
display any outstanding transactions that have been allowed to 
remain for possible settlement in the EVENING session. This 
report will include transactions completed in DAY session. 

 No transactions will settle in the interim session. 

 

At EVENING session (5:25pm – 6:32pm winter and 5:25pm – 8:32pm 
summer) the following rules apply:- 

 Approved CLS Banks may complete transactions in this period. 

 These will be processed by the system to RTGS in the same 
manner as in DAY session. 

 

 

 

 

 
 

At DAYCLOSE session (6:32pm – 7:00pm winter and 8:32pm – 9:00pm 
summer) the following rules apply:- 

 A Final Cashlist is produced for printing showing the final cash 
position of each customer’s cash records. This report will include 
transactions completed in both DAY and EVENING sessions. 

 

On NON-CLS days (days with shortened sessions as requested by the 
RBA) the following rules apply:- 

 MORNING, DAY and DAYEND sessions will operate as normal. 

 At the end of DAYEND session the system will move through 
INTERIM, EVENING and into DAYCLOSE. The Interim Cashlist 
will still be generated, which will move the system into EVENING 
session. The Final cashlist report will be generated as normal at 
DAYCLOSE.   

As all transactions are settled in IRREVOCABLE mode, Cash Providers 
are not required to perform any clearances. 
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4. Issuance, Deposits and Withdrawals 

4.1 DSS Issuance 

Introduction 

The Discount Security functionality enables Participants (Issuers) to issue 
both paper and electronic securities.  

The following are types of securities accepted for deposit in the system:- 
 BA – Bank Accepted Bills 
 EBA – Electronic Bank Accepted Bills 
 CD – Negotiable Certificates of Deposit 
 ECD – Electronic Negotiable Certificates of Deposit 
 PN – Promissory Notes 
 EPN – Electronic Promissory Notes 
 NB – Non Bank Bills 

 

Function 

Issue a Discount Security 

 

Information 

The ability to create a DSS series is restricted to ISSUERS ONLY. 

The maturity date of all paper and electronic securities must be 4 
business days forward of Deposit date. 

 

Navigation Steps 

► Series ► Series ► View Delegated  

 

Process Steps 

1. Follow the navigation steps above to display the ‘Delegated 
Series Objects’ screen. 

2. Enter the search criteria and click Search.   A list of Delegated 
Series Templates will be displayed. 

3. Highlight the required Series Template and select Create Series 
from the right click menu. 

4. Enter the series details and click OK.   Refer to the Glossary for 
further details on the fields. 

5. The creation of a new Series requires the entry of the following  
fields:- 

General: 

 Series Code (refer to glossary for guidelines on how to 
construct the Series Code) 

 Series Name 

 Description 

 Issuer 

 Issuer Representative 

 Issue Balance Responsible 

 ISIN Code (either check tick box ‘Automatic’ for ISIN to 
be automatically generated or leave blank if ISIN is to be 
entered manually). 

General Volume Units: 

 Total Volume on Issue  

 Minimum Settlement Volume 

 Multiple Volume 

 Unit Face Value 

Corporate Action General Information:  

 Issue Date 

 CA Cash Record Owner 

 CA Cash Record 

 CA Sub Account 

 Corporate Action Maturity Information: 

 Maturity Date 

 Maturity Cash Record 

 Discount Securities:  

 Drawer 
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 Prime Name 

 Place Payable 

 Payee (note this should be ‘Bearer’ or full name of 
payee) 

 

6. The Issuer Balance Responsible field indicates who is acting as 
the depository for the series. This field should always be 
populated with ACLR20 for immobilised Discount securities and 
the Issuer’s sub participant code for all dematerialised Discount 
Securities 

7. The CA Cash Record Owner field is used to record the sub 
participant code of the place payable. This indicates who owns 
the cash record that will be used for the payment of Corporate 
Actions relating to that series 

8. The CA Cash Record field allows the Issuer Representative to 
nominate a specific cash record to be used for the payment of 
Corporate Actions relating to that series.   It is the place payables 
cash record. 

9. The CA Sub Account field is used to record the Issuer 
Representative’s sub account that will be used in the payment of 
corporate actions for that series. This field should be populated 
with the  “Issuer Account” type sub account   

10. Once a new DSS series has been created, participants can view 
the series details in the View Series screen 

11. The issuance of Discount Securities is a two step process and 
requires Issuer Representatives to create a series from a 
delegated template and subsequently deposit that series.  
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Glossary – DSS Issuance 

 

Field Names Description 
Change Time 
Activation Time The point in time when the series template should be set in Active state. 

General 
Series (code) The guideline on how to construct the Series ID is as follows: 

 

The DSS Series ID will be 15 or 16 characters long (depending on the Series Sub-Type).  There should be no spaces between the 

characters.  

 

First 4 Characters - Issuer Participant Code - e.g. WPAC 

Next 6 Characters - Maturity Date - in the form DDMMYY e.g. 310605. Please note that the year is essential as the system will 

ensure uniqueness of the Series ID over a number of years (up to 7 years). 

Next 2/3 Characters - Series Sub-Type e.g. EBA, BA, CD, ECD etc 

Last 2 Characters - Sequence Number to be used where an Issuer has multiple issues of the same sub-type for any given maturity 

date - e.g. 01 to 99.  If there were more than 99 of the same sub type for the same maturity date then this number when then go to 

A1-A9 to Z1-Z9, giving a further 234 possibilities. 

 
To give a working example of the above, 2 EBAs issued by WPAC for the same maturity date, 31/06/05 would become:   
WPAC310605EBA01; and,  WPAC310605EBA02 

Series Name A long name describing the series uniquely. 

Manual Entry of 
Corporate Action Dates 

Specifies if Corporate Action dates can be entered manually.  

Description Concise description of the series template.   This field is utilised for recording distinguishing marks on discount securities. 

Parent Series Template The series template that the series inherits from. 

External Template 
Reference 

The template in external systems that the related series should be mapped to.   I.e. if the security is to be traded as both a DSS 
outright security and Repo then the external template ref. will be T_REPD otherwise to be set to T_BILL. 

Issuer The code of the participant that issued the series. Normally only specified at series level.  

Issuer Representative Participant responsible for the series in the system (but not for the Deposit/Withdrawal) 

Issuer Balance 
Responsible 

Participant responsible for the Deposit/Withdrawal of the series.  

Form Specifies whether the series is immobilised or dematerialised.  

Deposit Allowed Indicates whether the series can be object of a deposit request. 

Withdrawal Allowed Indicates whether the series can be withdrawn.  
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Field Names Description 
Has Redemption 
Values 

Specifies if the series has redemption values, that is, partial maturity date, partial redemption amount and capital value.  

Identifiers & Classifications 
ISIN The ISIN code for a series.   Check tick box Automatic for ISIN to be auto generated or leave blank for ISIN to be entered manually. 

Series Class A classification of the series object that is defined and applied for the specific market. This can be used by the CSD to group series 
according to any suitable logic for external users. For example, "Fixed Interest Security" or "Discount".  

Series Subclass A more detailed classification of the series.  

Non-fungible Specifies whether the series is non-fungible (Yes) or fungible (No).  

General Volume Units 
Denomination Currency The currency in which the series is denominated. 

Total Volume on Issue The total volume on issue of the series. This can differ from the actual balance in the CSD if, for example, the series is also issued 
in another CSD.  

Volume Unit Specifies whether the amount of the series should be a quantity or a face value of the Denomination Currency.  

Decimals in Volume The number of decimals that volumes of the series are specified with.  
Range: 0 – 4 

Minimum Settlement 
Volume 

The minimum volume that can be settled in the system. Must equal a multiple of Multiple Volume.  

Multiple Volume The smallest volume of the series that can be handled. All settled volumes have to be multiples of this value.  

Corporate Action: Maturity Information 
Issue Date The legal issue date. Specifies when the series balance is issued (made available to the market). May differ from the time when the 

information was stored or the issue was performed in the system.  

Request confirmation Indicates if the issuer representative is required to instruct the settlement instructions debiting the total volume or amount that will 
be delivered or paid from the issuer representative's sub accounts. 

Automatic corporate 
action 

Specifies if a corporate action type will be created automatically. 

Corporate Action Cash 
Record 

Cash record used for automatic corporate actions. The cash record must have the same currency as the denomination currency 
and belong to the sub participant who is the Place Payable. 

Corporate Action Cash 
Record Owner 

The sub participant who is the Place Payable.     

Corporate Action Sub 
Account 

Sub Account used as issuer sub account for maturity for automatic corporate actions. The sub account must belong to the issuer 
representative. 

Rate Rounding 
Decimals 

Defines the number of decimals to which the percentage form of rate should be rounded. Used when calculating coupons or 
maturity for automatic corporate actions. Must be between 0 and 8.  

Books Close 
Convention 

Day convention for the books closing period, Business Days or Calendar Days.  
Business days means that the record date is on the business date a number of business days before the coupon/maturity date. 
Business days are defined in the calendar.  
Calendar days means that the record date is on the date that occurs a certain number of calendar days before the coupon/maturity 
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Field Names Description 
date.  
Must be defined if Coupon Books Close Period or Maturity Books Close period are defined.  

Record Date 
Adjustment Convention 

Describes how to push the record date of a corporate action when it occurs on a non-business day.  

Payment adjustment 
convention 

Describes how to push the payment of an corporate action when it occurs on a non-business day. 

CA Days 1-4 The days when settlement of corporate actions can occur, that is, when money or securities for corporate actions can be transferred 
between sub participants. The system stores a maximum of four calendars per series. The calendars are combined as a logical 
AND operation, that is, all calendars must allow a day for the day to be allowed.  

Corporate Action: Maturity Information 
Maturity Formula Sets the formula to be used for maturity calculations. Only mandatory if Maturity is set to Automatic Corporate Action.  

Maturity date The date when the series will (finally) mature to redemption.  
Must be later than the First Maturity date.  

Maturity books close 
period 

The number of days in the books close period between record date and maturity payment date. (No settlements are allowed in the 
close period.)  

Corporate Action: Coupon Information 
Coupon Formula The formula to be used for coupon calculations. Mandatory only if coupon is set up as automatic corporate action. 

Annual Interest Rate % Effective yearly rate used for coupon payments.  
Must be >= 0.  

Coupon Rate Rounding 
Decimals 

Defines the number of decimals the percentage form of coupon rate should be rounded to. Must be between 0 and 8. 

Rate Rounding 
Decimals 

Defines the number of decimal places the percentage form of coupon rate should be rounded to. Must be between 0 and 8. 

Market Ref. Rate Index Reference to the market reference rate used for coupon payments.  

Rate Type Indicates the type of rate, one of the following: - 
 

Fixed  One and the same rate is used through the life time of the series.  

Floating  The rate is manually modified before each interest period.  
 

Rate Adjustment An additive margin on the annual interest rate.  

Accrual convention Day count fraction to use in calculations of accrued interest for a period of days. One of the following:- 
  

Actual/Actual - Actual number of days in the period divided by the actual number of days in the year. 

Actual/360 - The actual number of days in the period divided by 360. 

Actual/365 - The actual number of days in the period divided by 365. This is a way of ignoring leap years (??). 

30/360 - The number of months in the period multiplied by 30/360. 
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Field Names Description 
Last Day in Month Specifies whether the corporate action dates for coupons should always be set (calculated) to the last day in the month.  

Adjustment Convention Describes how to push the coupon date if it occurs on a non-business day. One of the following:- 
  

Next The first valid business date after the original settlement date for the current kind of transaction. 

Previous The last valid business date before the original settlement date for the current kind of transaction. 

Modified 
Next 

The next business date, except if this lies in the following month, in which case the previous business date is 
chosen. 

 

First Payment Date The date at which the series will produce the first coupon payment.  

Last Payment Date The date at which the series will produce the last coupon payment.  
Must be >= First Coupon Date.  

Months Between 
Payments 

Number of months between coupon payments, for a security with reoccurring coupon payments.  

Coupon Books Close 
Period 

Number of days in the book's close period between record date and coupon date.  

Information Dissipation 
Country of Issue The country where the series is issued, from a legal point of view. Displayed as a two letter code.  

Issuing CSD The primary registry responsible for the series. 

Registrar The name of the organisation acting as registrar for this issue. The organisation does not have to be a participant in the system.  

Holder List Public Indicates whether the holders of the series are allowed to be displayed or not.  

Syndication Describes, for debt series, whether the series is primarily issued at another Issuer CSD.  

Discount Securities 
Drawer Issuer of the bill and liable to pay the acceptor on maturity. (This payment is not handled by the system.)  

Display Drawer Specifies if the identity of the drawer should be disclosed on market wide screens (Yes or No).  

Prime Name The guarantor backing the bill. This is often the same as the Acceptor, unless there is an endorsement.  

Place Payable Agent that will perform the maturity payment on behalf of the Acceptor. (Often the Acceptor himself)  

Payee This is the initial payee of the bill, before it was entered in the system. Information field only. (Note: The words ‘Bearer’ or Full Name 
of payee should be used. Participant/Sub-participant codes should be avoided). 

Trading Information 
Novation Allowed N/A  

Settlement Attributes 
Settlement Days The days when settlement can occur.  

Cash 
Cash True – the series is a cash series, i.e. a currency.  

False – the series is not a cash series. 

External Clearing Indicates that settlement in the given currency is performed outside the default payment system of the settlement process.  
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Field Names Description 
Payment System The code for the bank responsible for the clearing of currencies.  

Payment System Cut-
off Time 

Indicates the latest time on a business day that the system can send instructions to settle payments in the given currency (when 
External Clearing is set to TRUE). Expressed in CSD Local Time (according to the System Time settings).  

Note 
Note Free text that describes the reason for the action. 
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 4.2  DSS and FIS Deposits 
 

Introduction 

The Deposit functionality enables Participants to deposit both paper and 
electronic securities.  

The following are types of discount securities accepted for deposit in the 
system:- 

 BA – Bank Accepted Bills 
 EBA – Electronic Bank Accepted Bills 
 CD – Negotiable Certificates of Deposit 
 ECD – Electronic Negotiable Certificates of Deposit 
 PN – Promissory Notes 
 EPN – Electronic Promissory Notes 
 NB – Non Bank Bills 

 

The following are types of fixed income securities accepted for deposit in 
the system:- 

 FRN – Floating Rate Notes 
 ABS – Asset Backed Securities 
 TB – Treasury Bonds 
 TA – Treasury Adjustable Bonds 
 TI – Treasury Indexed Bonds 
 TN – Treasury Notes 
 CB - Zero Coupon Bonds (i.e. commercial paper and short term 

registered notes) 
 SG - Semi Government and Fixed Rated Bonds 

 

The Austraclear system also has the ability to record and settle Fixed 
Income Securities and Discount Securities.  

A Fixed Income Security (FIS) is typically a Bond issued by either of:- 
 The Commonwealth Government 
 State Treasuries 
 Corporate Entities 
 Foreign Entities  

 

 

 

 

 

Function 

Deposit a Discount/Fixed Income Security 

 

Information 

For all deposits of paper securities and electronic obligations, the system 
will automatically generate an ISIN code in line with international 
standards. 

In the case of BA, EBA, BE and NB securities, if the depositing 
participant is also the Acceptor of that security, they have the option to 
display the Drawer Name.    Drawer details will be displayed as per series 
setup performed by the Issuer. 

The maturity date of all paper and electronic securities must be 4 
business days forward of Deposit date. 

Deposits entered into the system will remain on the system for two    
business days. If the securities are not delivered within this period the 
details will have to be re-entered and a new Deposit Receipt printed. 

 

Navigation Steps 

► Series ► Series ► View 

 

Process Steps 

1. Follow the navigation steps above to display the ‘Series’ screen. 

2. Enter the search criteria and click Search.   The system will 
display a list of valid series. 

3. The View Series screen displays all active Discount Securities 
and their ISIN codes held in the system.  
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4. Right click on the required Series and select Request to 
Deposit Security from the menu. 

5. Enter Deposit details and click OK.   Refer to the Glossary for 
further details on the fields. 

6. After the request to Deposit a security is entered, the user may 
select to print a Deposit Receipt. 

 

 

 

Function 

Print a Deposit Receipt 

 

Navigation Steps 

► Holdings ► View Deposits and Withdrawals 

 

Process Steps 

1. Follow the navigation steps above to display the ‘Deposits and 
Withdrawals’ screen. 

2. Enter the series search criteria and click Search.   The system 
will display a list of valid series. 

3. Select the deposit transaction and from the right click menu, 
select View Security Deposit Receipt to Print.   Deposit 
Receipts may be reprinted from this screen 

 

 

 

 

 

 

 

Function 

Modify/Delete a Deposit Request 

 

Navigation Steps 

► Holdings ► View Deposits and Withdrawals  

 

Process Steps 

1. Follow the navigation steps above to display the ‘Deposits and 
Withdrawals’ screen. 

2. Enter the search criteria and click Search.    

3. To Modify - Select the deposit transaction and from the right 
click menu select Properties to modify the deposit details. 

4. To Delete – Select the deposit transaction and from the right 
click menu select Delete to delete the deposit before Austraclear 
confirmation. 

5. Enter Deposit details and click OK. 

6. After the request to Deposit a security is entered, the user may 
select to print a Deposit Receipt. 
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Function 

Complete Deposit Procedure for Fixed Interest Securities 

 

Process Steps  

1. When depositing Fixed Interest securities into the system, 
participants must complete a Transfer and Acceptance (T/A) form as 
the TRANSFEROR and arrange to have the T/A marked before 
presenting it to SFE Austraclear with two copies of the Deposit 
Receipt signed in accordance with your signing authorities.  

 

Function 

Complete Deposit Procedure for Paper Discount Securities 

 

Process Steps  

For BA, CD, PN 

1. Participants are requested to deliver all securities intended for 
Deposit in the system, together with two copies of the Deposit 
Receipt signed in accordance with participants’ signing authorities, to 
the Austraclear depository. 

2. Upon receipt of the securities, Austraclear staff will check that the 
securities and Deposit Receipt details are correct before confirming 
the Deposit in the system. 

3. If a Deposit is found to be incorrect, Austraclear will notify the 
participant who may be asked to use the Rectify function to correct 
the Deposit details. The Cancel function also allows for Deposits to 
be cancelled if necessary. 

 

 

Function 

Complete Deposit Procedure for Electronic Discount Securities 

 

Process Steps  

For EBA, ECD, EPN 

1. Electronic (E) security Deposits require no physical securities to be 
delivered to Austraclear at the time of the Deposit. 

2. After an E security Deposit is entered, the Deposit of the Security 
must be accepted by the depositing participant. 

3. The Depositing participant of an E security must be the 
Acceptor/Issuer of that security, unless Austraclear has received an 
authorised request for a nominated participant branch to be the 
depositing participant. 

4. The minimum unit face value for Depositing ECD’s and EPN’s is 
$50,000. There is no restriction on EBA’s. 

5. While an E security Deposit is pending authorisation it may be 
corrected or deleted via the View Deposit and Withdrawal screen. 

 

Function 

Accept/Reject an E Security Deposit Request 

 

Navigation Steps 

► Holdings ► View Deposits and Withdrawals  

 

Process Steps 

1. Follow the navigation steps above to display the ‘Deposits and 
Withdrawals’ screen. 

2. Enter the search criteria and click Search.    

3. To Accept - Select the deposit transaction and from the right click 
menu select Accept Deposit Request to accept the deposit request. 

4. To Reject - Select the deposit transaction and from the right click 
menu select Reject Deposit Request to reject the deposit request. 

 



        

 Austraclear System Participant User Guide 

          84  

 



        

 Austraclear System Participant User Guide 

          85  

Glossary – Deposits 

Field Names Description 

Series The series code of the security. 

Series Description A description of the series. 

ISIN The ISIN code for the series. 

CUSIP The CUSIP code of the series. 

Sub Participant The participant that entered the request. 

Holding Sub Account The safekeeping account code where to credit the volume of the deposit or to debit the volume of the withdrawal. 

Volume The volume of the deposit or withdrawal.  

Earliest Settlement Date The earliest date the deposit or withdrawal for execution. 

Comment A comment regarding the deposit or withdrawal 

 

 

 



        

 Austraclear System Participant User Guide 

          86  

 4.3  DSS and FIS Withdrawals 

 

Introduction 

The Withdrawal function enables participants to input a request for the 
removal of DSS securities and FIS (non paper instruments) securities 
from the Austraclear system. 

 

Function 

Withdraw a Discount/Fixed Income Securities 

 

Information 

 

Navigation Steps 

► Holdings ► View Holdings 

 

Process Steps 

1. Follow the navigation steps above to display the ‘Holdings’ screen. 

2. Enter the search criteria and click Search.   All holdings will be 
displayed according to search criteria. 

3. Select the Series from the display, right click and select Withdraw 
Security. 

4. Enter the Volume and click OK.   Refer to the Glossary for further 
details on the fields. 

5. Once the Withdrawal details have been entered the user may right 
click to view and print the Transfer and Release Form. This form 
may be reprinted. 
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Function 

Delete a Withdrawal Request 

 

Information 

When a withdrawal request is entered based on an existing holding, the 
system automatically assigns a state of “Locked In” to the withdrawal 
request. Once a withdrawal request is “Locked In”, it cannot be deleted 
without first cancelling the relevant ‘reservation’ Settlement Instruction. 

 

Navigation Steps 

► Holdings ► View Deposits and Withdrawals 

 

Process Steps 

1. Follow the navigation steps above to display the ‘Deposits and 
Withdrawals’ screen. 

2. Enter the search criteria and click Search.   All holdings will be 
displayed according to search criteria. 

3. Select the Withdrawal Transaction from the display, right click and 
select Delete. 

4. Check the details and click OK. 

 

 

Function 

Complete Withdrawal Procedure for Fixed Interest Securities 

 

Process Steps  

1. When withdrawing securities from the system, participants must 
complete a Transfer and Acceptance (T/A) form as the 
TRANSFEREE and present it to Austraclear with two copies of the 
Transfer and Release form. SFE Austraclear will then complete the 
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T/A and within one hour have the stock inscribed in the Participants 
name at the Registry. 

 

 

 

Function 

Complete Withdrawal Procedure for Paper Discount Securities 

 

Process Steps  

For BA, CD, PN 

1. After entering a Withdrawal, Participants will need to print two copies 
of the Transfer and Release Form and have it signed in accordance 
with their signing authority.  

2. Before the reports are delivered to Austraclear, the person 
designated to collect the securities must sign the section titled 
“specimen signature for receipt of documents”. 

3. When the securities are collected from the Austraclear depository, 
the courier will be required to sign for receipt of the securities on the 
Withdrawal report. 

 

Function 

Complete Withdrawal Procedure for Electronic Discount Securities 

 

Process Steps  

For EBA, ECD, EPN 

1. After entering a Withdrawal, Participants will need to print two copies 
of the Transfer and Release form. 

2. The Transfer and Release Form will advise the withdrawing 
participant whether there are physical securities to be collected. 

3. Austraclear will monitor the Withdrawal request and confirm the 
details of the Withdrawal using the View Deposits and Withdrawals 
screen. 

4. Upon confirmation, SFE Austraclear will advise the Acceptor/Issuer 
whether physical securities are required to be presented to 
Austraclear. 



        

 Austraclear System Participant User Guide 

          89  

Glossary – Withdrawals 

Field Names Description 

Series The series code of the security, mandatory for a withdrawal. 

Series Description A description of the series. 

ISIN The ISIN code of the series. 

CUSIP The CUSIP code of the series 

Sub Participant The participant that entered the request. 

Holding Sub Account The safekeeping account code where to credit the volume of the deposit or to debit the volume of the withdrawal. 

Volume The volume of the deposit or withdrawal.  

Earliest Settlement Date The earliest date the deposit or withdrawal for execution. 

Comment A comment regarding the deposit or withdrawal. 

Note Enter a description of the request and its context.  
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6. Enter a Trade 

6.1 Cash 

 

Introduction 

The Cash Trade facility allows participants to pay and receive cash on 
the Austraclear system, either as a same day transaction or for a date in 
the future. A Cash Trade is a two sided transaction that requires both the 
payer and receiver to enter their respective instructions which will be 
matched by the system to effect the settlement. Settlement can be 
automatic, where if the payer has sufficient funds available the system 
will effect the transfer of funds with no intervention required by either 
counterparty, or it can be a manual process, where participants set their 
cash records to a deferred state and selectively process transactions on 
their settlement queue.  

 

Function 

Enter a Cash Trade 

 

Information 

All fields in the cash entry screen are matching with the exception of:- 
 Trade Date 
 Sub Participant 
 Cash Type 
 Information 
 Participant Reference 

 

Navigation Steps 

► Trades ► Create Trades ► Cash  

 

Process Steps 

1. Follow the navigation steps above to display the ‘Cash’ screen. 

2. Enter the cash transfer details.   Refer to the Glossary for further 
details on the fields. 

 

 

 

3. The Sub Participant field is used to specify the sub participant 
code through which settlement will occur. 

4. The Cash Type field is used to specify the payment type relating 
to the Cash Trade. This field is for information purposes only. 

5. The SSI field defaults to Y indicating that the cash will settle via 
the default Cash Record. To select an alternate Cash Record on 
a transaction by transaction basis, select N in the SSI field. The 
drop down list in the Cash Record field may be used to select 
from the list of available Cash Records  

Note – If SSI is set to ‘Y’ and there is no SSI set up then the 
trade will not settle.   Ensure that the Cash Record field is not 
blank. 

6. Once all details have been entered, click Send. 
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Glossary – Cash 

 

Field Names Description 
Participant/Counterparty Information 
Participant Automatically displayed participant for the user that logged in; cannot be changed. 

This will be the party to whom the trade will be registered. 

Participant name Automatically displayed participant name 

Counterparty 
Specify an opposite party to the trade. 

Type to select a particular counterparty, a valid exchange customer or select from the drop-down list.  

There is a space between the parts of the identification. 

AC 2 characters 

Participant Mnemonic 4 characters 

Sub Participant Code 2 characters 

If the user only enters the Participant Mnemonic the system automatically inserts the AC Prefix 

Counterparty name Automatically displayed participant name for the counterparty. 

Trade Information 
Series Specify an existing instrument series to trade, or select it from the drop-down list.  

Side Select trade side option: 

Pay pay side 

Receive receive side 
 

Trade date Original registration date and time for the trade. 
Enter a date, current business date or earlier. Default is current business date.  

Settlement date Settlement date/value date; date for delivery/settlement.  
Enter a date, current business date or later. Default is current business date. 

Amount Specify cash amount to be transferred.  
The entered number of decimals must be the same as in the default value 0.00 displayed in the field. 

Interest rate Enter interest rate to be used for information purposes. 
The entered number of decimals must be the same as in the default value 0.00 displayed in the field. 

Agreement type If matched agreements exist between the parties, the agreement type is automatically displayed as defined in the system, as soon 
as the parties are entered, and cannot be overwritten, examples: ISDA, FRABBA 

Sub participant Automatically displayed organisation unit within the participant for the user that logged in. 

https://exigotc.austraclear.com.au/exigoonlinehelp/00secur/rea/rea_app_sec.xml#dat
https://exigotc.austraclear.com.au/exigoonlinehelp/00secur/rea/rea_app_sec.xml#dat
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Field Names Description 
Cash type Select cash type option from the drop down list,  

11AM Call 11AM Call 

24HR Call 24 HR Call 

FORX Foreign Exchange 

SWAP Swaps 

FINT Fixed Interest 

COUP Coupon Payment 

OPTN Options 

FNTR Funds Transfer 

Repo Repurchase 

ELEC Electricity Payment 

TCSH Term Cash 
 

Cash record If SSI Yes is selected, the cash record value is automatically specified otherwise specify the code, up to 24 characters: 
Or select it from the scroll list. The scroll list contains cash records dedicated to the Participant specified in the Sub participant field. 

Settlement Information 
Payment settle Select one of the Yes | No radio buttons. Default = Yes. 

Please not foreign currency is currently not available. 

Settle currency Automatically displayed settlement currency code for the instrument class of the series. 

SSI Select one of the Yes | No radio buttons. Default = Yes. 
If a Standard Settlement Instruction (SSI) is defined for the Sub participant and instrument (Participant → SSI) the parties have the 
option to use or not to use it for a certain trade. 

Yes the SSI is used and settlement instruction is retrieved from the SSI item 

No a content of the settlement instruction must be specified manually below 
 

Sell settlement 
instruction 

Enter free text for the sell side, manually describing settlement instead of using the SSI max. 120 characters, recommended if SSI = 
No and Payment settle = No. 
External interfaces and foreign currency trades require Settlement instructions to instruct the payer where to pay the funds. 
The SWIFT interface will use the Participant ref. for identification. 

Information Enter participant information, free text using printable characters, max. 80 characters. 

Participant ref Enter participant reference, free text using printable characters, max. 32 characters. It is used as link for a trade in an external 
system.  
SWIFT requires the Participant ref to send SWIFT payment instructions and confirmations for example the BIC.  

 
 
 

https://exigotc.austraclear.com.au/exigoonlinehelp/00secur/rea/rea_app_sec.xml#ent
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6.2 DSS 

 

Introduction 

The Discount Security functionality enables participants to settle both 
paper securities and electronic obligations.  

Securities can be pledged for secured borrowing in the system and 
maturity payments are paid automatically to holders of paper securities 
and electronic obligations. 

A Discount Security Trade is a two sided transaction that requires both 
the buyer and seller to enter their respective instructions which will be 
matched by the system to effect the settlement of the transaction. A 
Discount Security trade can be initiated by either the Buyer or the seller.  

The following are types of securities accepted for deposit in the system: 

BA – Bank Accepted Bills 

EBA – Electronic Bank Accepted Bills 

CD – Negotiable Certificates of Deposit 

ECD – Electronic Negotiable Certificates of Deposit 

PN – Promissory Notes 

EPN – Electronic Promissory Notes 

NB – Non Bank Bills 

 

Function 

Enter a DSS Trade 

 

Information 

All fields in the Discount Security trade entry screen are matching with 
the exception of the following:-    

 Trade Date 
 Sub Participant 
 Information 

 Participant Reference 

  

 

 

 

 

Participants may trade securities from and buy directly into any available 
sub account.  

 

Both Buyer and Seller must enter the Trade Details in order for the trade 
to be confirmed. 

 

For automatic settlement to occur, both parties sub accounts and cash 
records must be set to “Active” or “Priority”.  If one participant sub 
account or cash record is set to “Deferred” the transaction can only be 
settled manually 
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Navigation Steps 

► Trades ► Create Trades ► Discount Securities  

 

Process Steps 

1. Follow the navigation steps above to display the ‘Discount 
Security’ screen. 

2. Enter the trade details.   Refer to the Glossary for further details 
on the fields. 

3. When the Series Code is entered and User tabs out of the field, 
the ISIN and Maturity Date details are automatically displayed 
from the Series. 

4. The Sub Participant field is used to specify the sub participant 
code through which settlement will occur. 

5. Trade Date and Settlement Date will default to the current 
business date. Participants may backdate the trade date and 
forward date the settlement date on a trade by trade basis. 

6. The SSI field defaults to Y indicating that the cash and securities 
will settle via the default Cash Record/Sub Account. To select an 
alternate Cash Record and/or Sub Account on a transaction by 
transaction basis, select N in the SSI field. The drop down list in 
the Sub Account and Cash Record fields may be used to select 
from the lists available. 

7. Once all details have been entered click Calculate.   The 
consideration will be displayed.  

8. Finally click Send. 
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Function 

Confirm a DSS Trade 

 

Information 

Users have the ability to either enter a matching DSS trade OR just 
confirm the DSS trade. 

 

Navigation Steps 

► Trades ► View Reported Trades   

 

Process Steps 

1. Follow the navigation steps above to display the ‘View Reported 
Trades’ screen. 

2. Under the ‘Type’ field select Discount Securities and press 
Search.    

3. Select the trade to be confirmed, right mouse click and select 
Confirm Trade Report.   When the counterparty selects the 
menu option to confirm or reject, a mirrored image of the original 
contrary trade report to be confirmed/rejected will be displayed. 

4. Confirm the details of the trade then press Send. 
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Glossary – DSS 

 

Field Names Description 
Participant Information 
Participant Automatically displayed participant for the user that logged in; cannot be changed. 

This will be the party to whom the trade will be registered. 

Participant name Automatically displayed long participant name for the party. 

Counterparty Specify an opposite party to the trade. 
Type to select a particular counterparty, a valid exchange customer or select it from the drop-down list. 
There is a space between the parts of the identification. 

AC  2 characters  

Participant Mnemonic 4 characters 

Sub Participant Code 2 characters 

If the user only enters the Participant Mnemonic the system automatically inserts the AC Prefix 

Counterparty name Automatically displayed long participant name for the counterparty 

Trade Information 
Series Specify an existing series to trade, or select it from the drop-down list. Either Series or ISIN must be specified.   Alternatively if the 

Maturity Date is selected, the Series List will only show series for that maturity date. 

ISIN Instrument series’ International Securities Identification Number (ISIN).  
Specify a valid ISIN to identify the instrument series, or select it from the drop-down list. Either Series or ISIN must be specified. 

Coupon rate The field is not used. Frozen = 0. 

Maturity date Automatically displayed or entered value. 
Specify a maturity date, or select it from the drop-down list. The value must be equal to the instrument series expiration date. 

Underlying Automatically displayed or entered value. 
Enter underlying long name, or select it from the drop-down list. 

Issuer Automatically displayed or entered value. 
Specify an issuer, or select it from the drop-down list. 

Side Select trade side option:- 

Buy buy side 

Sell sell side 
 

Trade date Original registration date and time for the trade. 
Enter a date, current business date or earlier. Default is current business date. 

Settlement date Settlement date/value date; date for delivery/settlement. The date must be a valid settlement date according to CDB. 
Enter a date, current business date or later. Default is current business date. 

Face value Face value of the DSS Trade. 

https://exigotc.austraclear.com.au/exigoonlinehelp/00secur/rea/rea_app_sec.xml#dat
https://exigotc.austraclear.com.au/exigoonlinehelp/00secur/rea/rea_app_sec.xml#dat
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Field Names Description 
When entering the value, the following abbreviations are available: 

K for thousand 

T for thousand 

M for million 

The entered number of decimals must be the same as in the default value 0.00 displayed in the field. 
The maximum value is configurable up to 10 billions. 
Example: 12.5M is equal to 12,500,000.00 

Yield Enter a yield within 0 to 100. 
The entered number of decimals must be the same as in the default value 0.00 displayed in the field. 

Agreement type If matched agreements exist between the parties, the agreement type is automatically displayed as defined, as soon as the parties are 
entered, and cannot be overwritten, examples: ISDA, FRABBA 

Sub participant Automatically displayed organisation unit within the participant for the user that logged in.  

Sub account If SSI Yes is selected, the sub account value is automatically specified otherwise specify the code, up to 24 characters: 
Or select it from the scroll list. The scroll list contains cash records dedicated to the participant specified in the Account field. 

Cash record If SSI Yes is selected, the cash record value is automatically specified otherwise specify the code, up to 24 characters: 
Or select it from the scroll list. The scroll list contains cash records dedicated to the participant specified in the Account field. 

Settlement Information 
Payment settle Select one of the Yes | No radio buttons. Default = Yes. 

For foreign currency, Yes is only available if the participant is a SWIFT participant with BIC identification. 
The system validates the consideration amount.  

Yes and if the consideration amount is greater than 0, a payment will be performed using a DVP instruction for SWIFT or CSD. 

No or if the consideration amount is 0, a Free Of Payment (FOP) delivery will still be performed. 
 

Settle currency Automatically displayed settlement currency code for the instrument class of the series. 

SSI Select one of the Yes | No radio buttons. Default = Yes. 
If a Standard Settlement Instruction (SSI) is defined for the account and instrument (Participant → SSI) the parties have the option to 
use or not to use it for a certain trade. 

Yes the SSI is used and settlement instruction is retrieved from the SSI item 

No a content of the settlement instruction must be specified manually below 
 

Sell settlement 
instruction 

Enter free text for the sell side, manually describing settlement instead of using the SSI max. 120 characters, recommended if SSI = No 
and Payment settle = No. 
External interfaces and foreign currency trades require Settlement instructions to instruct the payer where to pay the funds. 
The SWIFT interface will use the Participant ref. for identification. 

Novation The field is not used. Frozen = 0. 

Information Enter participant information, free text using printable characters, max. 80 characters. 

Participant ref Enter participant reference, free text using printable characters, max. 32 characters. It is used as link for a trade in an external system.  

https://exigotc.austraclear.com.au/exigoonlinehelp/00secur/rea/rea_app_sec.xml#ent
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Field Names Description 
SWIFT requires the Participant ref to send SWIFT payment instructions and confirmations for example the BIC.  

Consideration Consideration /settlement amount is calculated from yield by the system when Calculate is selected, but can be overwritten by the user 
(0 is allowed).  
The entered number of decimals must be the same as in the default value 0.00 displayed in the field. 
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6.3 FIS 

 

Introduction 

A Fixed Income Security (FIS) is typically a Bond issued by either of:- 

- The Commonwealth Government 

- State Treasuries 

- Corporate Entities 

- Foreign Entities  

  

The Austraclear system has the ability to record and settle non paper 
Fixed Income Securities.  

A Fixed Income Trade is a two sided transaction that requires both the 
buyer and seller to enter their respective instructions which will be 
matched by the system to effect the settlement of the transaction. FIS 
trades can be initiated by either the buyer or the seller.  

Fixed Income Securities can be pledged for secured borrowing in the 
system and interest and maturity payments are paid automatically in the 
system to holders of Fixed Income securities 

 

Function 

Enter a FIS Trade 

 

Information 

All fields in the Fixed Income Security trade entry screen are matching 
with the exception of the following:-    

 Trade Date 
 Sub Participant 
 Information 
 Participant Reference 

  

Participants may trade securities from and buy directly into any available 
sub account.  

 
 

 

 

 

Both Buyer and Seller must enter the Trade Details in order for the trade 
to be confirmed. 

 

For automatic settlement to occur, both parties sub accounts and cash 
records must be set to “Active” or “Priority”.  If one participant sub 
account or cash record is set to “Deferred” the transaction can only be 
settled manually. 
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Navigation Steps 

► Trades ► Create Trades ► Fixed Income  

 

Process Steps 

1. Follow the navigation steps above to display the ‘Fixed Income’ 
screen. 

2. Enter the trade details.   Refer to the Glossary for further details 
on the fields. 

3. When the Series Code is entered and User tabs out of the field, 
the ISIN and Maturity Date details are automatically displayed 
from the Series. 

4. The Sub Participant field is used to specify the sub participant 
code through which settlement will occur. 

5. Trade Date and Settlement Date will default to the current 
business date. Participants may backdate the trade date and 
forward date the settlement date on a trade by trade basis. 

6. The SSI field defaults to Y indicating that the trade will settle via 
the default Cash Record/Sub Account. To select an alternate 
Cash Record and/or Sub Account on a transaction by transaction 
basis, select N in the SSI field. The drop down list in the Sub 
Account and Cash Record fields may be used to select from the 
lists available. 

7. Once all details have been entered click Calculate.    

8. Finally click Send. 
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Glossary – FIS 

 

Field Names Description 
Participant Information 
Participant Automatically displayed participant for the user that logged in; cannot be changed. 

This will be the party to whom the trade will be registered. 

Participant name Automatically displayed participant name. 

Counterparty Specify an opposite party to the trade. 
Type to select a particular counterparty, a valid exchange customer or select it from the drop-down list. 
There is a space between the parts of the identification. 

AC  2 characters  

Participant Mnemonic 4 characters 

Sub Participant Code 2 characters 

If the user only enters the Participant Mnemonic the system automatically inserts the AC Prefix 

AC  2 characters  

Participant Mnemonic 4 characters 

Sub Participant Code 2 characters 
 

Counterparty name Automatically displayed participant name for the counterparty 

Trade Information 
Series Specify an existing series to trade, or select it from the drop-down list. Either Series or ISIN must be specified.   Alternatively if the 

Maturity Date is selected, the Series List will only show series for that maturity date. 

ISIN Instrument series’ International Securities Identification Number (ISIN).  
Specify a valid ISIN to identify the instrument series, or select it from the drop-down list. Either Series or ISIN must be specified. 

Coupon rate Automatically displayed or entered value. 
Specify a coupon rate value or select from the drop-down list. 

Maturity date Automatically displayed or entered value. 
Specify a maturity date or select from the drop-down list. The value must be equal to the instrument series expiration date. 

Underlying Automatically displayed or entered value. 
Enter underlying long name, or select it from the drop-down list. 

Issuer Automatically displayed or entered value. 
Specify an issuer or select from the drop-down list. 

Side Select trade side option:- 

Buy buy side 

Sell sell side 
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Field Names Description 
Default = Buy. 

Trade date Original registration date and time for the trade. 
Enter a date, current business date or earlier. Default is current business date. 

Settlement date Settlement date/value date; date for delivery/settlement. The date must be a valid settlement date according to CDB. 
Enter a date, current business date or later. Default is current business date. 

Face value Face value; the value of a bond, note or other security as printed on the document; throughout the lifetime of a security its market price 
will fluctuate but at maturity date the face value is payable. 
Enter face value. When entering the value, the following abbreviations are available: 

K for thousand 

T for thousand 

M for million 

The entered number of decimals must be the same as in the default value 0.00 displayed in the field. 
The maximum value is configurable up to 10 billions. 
Example: 12.5M is equal to 12,500,000.00 

Yield Enter a yield within 0 to 100. 
The entered number of decimals must be the same as in the default value 0.00 displayed in the field. 

Agreement type If matched agreements exist between the parties, the agreement type is automatically displayed as defined, as soon as the parties are 
entered, and cannot be overwritten, examples: ISDA, FRABBA 

Sub participant Automatically displayed organisation unit within the participant for the user that logged in;  

Sub account If SSI Yes is selected, the sub account value is automatically specified otherwise specify the code, up to 24 characters: 
Or select it from the scroll list. The scroll list contains cash records dedicated to the participant specified in the Account field. 

Cash record If SSI Yes is selected, the cash record value is automatically specified otherwise specify the code, up to 24 characters: 
Or select it from the scroll list. The scroll list contains cash records dedicated to the participant specified in the Account field. 

Settlement Information 
Payment settle Select one of the Yes | No radio buttons. Default = Yes. 

For foreign currency, Yes is only available if the participant is a SWIFT participant with BIC identification. 
The system validates the consideration amount.  

Yes and if the consideration amount is greater than 0, a payment will be performed using a DVP instruction for SWIFT or CSD. 

No or if the consideration amount is 0, a Free Of Payment (FOP) delivery will still be performed. 
 

Settle currency Automatically displayed settlement currency code for the instrument class of the series. 

SSI Select one of the Yes | No radio buttons. Default = Yes. 
If a Standard Settlement Instruction (SSI) is defined for the account and instrument (Participant → SSI) the parties have the option to 
use or not to use it for a certain trade. 

Yes the SSI is used and settlement instruction is retrieved from the SSI item 

No a content of the settlement instruction must be specified manually below 
 

https://exigotc.austraclear.com.au/exigoonlinehelp/00secur/rea/rea_app_sec.xml#dat
https://exigotc.austraclear.com.au/exigoonlinehelp/00secur/rea/rea_app_sec.xml#dat
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Field Names Description 
Sell settlement 
instruction 

Enter free text for the sell side, manually describing settlement instead of using the SSI max. 120 characters, recommended if SSI = No 
and Payment settle = No. 
External interfaces and foreign currency trades require Settlement instructions to instruct the payer where to pay the funds. 
The SWIFT interface will use the Participant ref. for identification. 

Novation Not Used 

Information Enter participant information, free text using printable characters, max. 80 characters. 

Participant ref Enter participant reference, free text using printable characters, max. 32 characters. It is used as link for a trade in an external system.  
SWIFT requires the Participant ref to send SWIFT payment instructions and confirmations for example the BIC.  

Consideration Consideration /settlement amount is calculated from yield by the system when Calculate is selected, but can be overwritten by the user 
(0 is allowed).  
The entered number of decimals must be the same as in the default value 0.00 displayed in the field. 

PPH Price per Hundred.   Bond price including accrued interest, is calculated by the system when Calculate is selected. 
 
 
 

https://exigotc.austraclear.com.au/exigoonlinehelp/00secur/rea/rea_app_sec.xml#ent
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6.4 FRAS 
 

Introduction 

A Forward Rate Agreement (FRA) is a forward transaction in Bank Bill 
interest rates without exchange of the principal amount. The Austraclear 
system has the ability to record and settle FRA transactions. A Forward 
Rate Agreement is a two sided transaction that requires both the buyer 
and seller to enter their respective instructions which will be matched by 
the system to effect the settlement of the transaction.   FRA’s can be 
initiated by either the buyer or the seller.  

 

Function 

Enter a FRA Trade 

 

Information 

FRA transactions may be entered in the system any time up to 12 noon 
on the day of settlement. 

All fields in the FRA entry screen are matching with the exception of:- 
 Sub Participant 
 Information 
 Participant Reference 

 

Navigation Steps 

► Trades ► Create Trades ► FRA  

 

Process Steps 

1. Follow the navigation steps above to display the ‘FRA’ screen. 

2. Enter the FRA trade details.   Refer to the Glossary for further 
details on the fields. 

3. The Sub Participant field is used to specify the sub participant 
code through which settlement will occur. 

4. The Fixing Date field may be used to specify the date on which 
the rate fixing will occur for the floating rate. If this field is left 
blank, the rate that will be used will be today’s BBSW rate.  

 

5. The Float Rate Option field is optional. If a Float Rate Option is 
selected eg BBSW the value selected must match with that of the 
counterparty. 

6. If a Float Rate Option is not selected, the transaction will still 
match but both parties will need to manually enter an agreed 
Floating Rate before settlement can occur. 

7. The SSI field defaults to Y indicating that the cash will settle via 
the default Cash Record. To select an alternate Cash Record on 
a transaction by transaction basis, select N in the SSI field. The 
drop down list in the Cash Record field may be used to select 
from the list of available Cash Records.  

8. Once all details have been entered, click Send. 
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Function 

View Rate Fixings 

 

Information 

 

Navigation Steps 

► Trades ► View Fixing Values 

 

Process Steps 

1. Follow the navigation steps above to display the ‘Fixing Values’ 
screen. 

2. Enter search criteria and click Search. 

3. The fixing values for the search criteria will be displayed. 

 

 

 

 

 

 

Function 

Manually Rate Set a FRA 

 

Information 

If a Float Rate Option is not selected when entering a FRA trade, the 
transaction will still match but both parties will need to manually enter an 
agreed Floating Rate before settlement can occur. 

The transaction state will be Matched with a sub state of Pending Fixing 
when one participant has set the Floating Rate but the counterparty has 
not.  

Either party to a FRA can initiate the entry of a Floating Rate.   



        

Austraclear System Participant User Guide 

          109 

 

Navigation Steps 

► Trades ► View Reported Trades  

 

Process Steps 

1. Follow the navigation steps above to display the ‘Reported 
Trades’ screen. 

2. Specify search criteria and click search to view all Forward Rate 
Agreements to which you are a party. 

3. Highlight the transaction to be rate set and from the right click 
menu select Set Floating Rate. 

4. Enter the Floating Rate and then click on Send. 
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Glossary – FRAS 

 

Field Names Description 
Participant Information 
Participant Automatically displayed participant for the user that logged in; cannot be changed. 

This will be the party to whom the trade will be registered. 

Participant name Automatically displayed long participant name for the party. 

Counterparty Specify an opposite party to the trade. 
Type to select a particular counterparty, a valid exchange customer or select it from the drop-down list. 
There is a space between the parts of the identification. 
 

AC  2 characters  

Participant Mnemonic 4 characters 

Sub Participant Code 2 characters 

If the user only enters the Participant Mnemonic the system automatically inserts the AC Prefix 

Counterparty name Automatically displayed long participant name for the counterparty 

Trade Information 
Series Specify an existing series to trade, or select it from the drop-down list 

Side Select trade side option: 
Buy or Sell 

Trade date Enter a date, current business date or earlier. Default is current business date. 
The trade date is the date that a contract is made between two parties.  
Compare the clearing date, which is the date that the trade will be cleared in the clearinghouse. 
The trade date could be earlier than the clearing date. 

Settlement date Settlement date/value date; date for delivery/settlement. The date must be a valid settlement date according to CDB. 
Enter a date, current business date or later. Default is current business date. 

Fixing date Enter a fixing date for the settlement rate (floating rate) less than or equal to the settlement date. 

Termination date Termination date for the underlying; the last date that the underlying is available. 
Enter a date, current business date or later. Default is current business date. 

Notional amount An amount to use as basis for calculations of payments. The notional amount will never be exchanged between the parties, only used 
for calculations.   Specify notional amount.  

Fixed rate Fixed rate/price tick is decimals in the premium from the instrument class. 
Enter a value greater than zero.  

Floating rate option A valid rate type defined for the instrument class. 
BBSW is only option available currently. 
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Field Names Description 
Day count conv. 
(fraction) 

Day count convention/fraction; day calculation rule from underlying.  
Select a value from the drop-down list.  

Agreement type If matched agreements exist between the parties, the agreement type is automatically displayed as defined, as soon as the parties are 
entered, and cannot be overwritten, examples: ISDA, FRABBA 

Sub participant Automatically displayed organisation unit within the participant for the user that logged in.  

Cash record If SSI Yes is selected, the cash record value is automatically specified otherwise specify the code, up to 24 characters: 
Or select it from the scroll list. The scroll list contains cash records dedicated to the participant specified in the Sub participant field. 

Settlement Information 
Currency Select a valid settlement currency code. 

SSI Select one of the Yes | No radio buttons. Default = Yes. 
If a Standard Settlement Instruction (SSI) is defined for the Sub participant and instrument (Participant → SSI) the parties have the 
option to use or not to use it for a certain trade. 

Yes the SSI is used and settlement instruction is retrieved from the SSI item 

No a content of the settlement instruction must be specified manually below 
 

Novation The field is not used. Frozen = 0. 

Information Enter participant information, free text using printable characters, max. 80 characters. 

Participant ref Enter participant reference, free text using printable characters, max. 32 characters. It is used as link for a trade in an external system.  
SWIFT requires the Participant ref to send SWIFT payment instructions and confirmations for example the BIC.  
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6.5 FX 
 

Introduction 

The Austraclear system allows for electronic confirmation of spot and 
forward currency deals for both $A and cross currency transactions and 
enables settlement of the $A transaction leg. There are two methods for 
confirming Foreign Exchange deals in the system:-  

1. The first is a two sided transaction that requires both parties to enter 
their respective instructions which will be matched by the system to 
effect the settlement.  

2. The second method applies only to FX transactions between Banks 
and their Corporate counterparties and involves the Bank entering 
their side of an FX transaction and the Corporate Counterparty 
confirming the entry, effectively eliminating the need for a dual sided 
entry. Transactions confirmed using this method will also generate a 
Confirmation Report to Corporate participants which they can print 
and retain. This process eliminates the need for Banks to send 
paper-based confirmations to their Corporate counterparties and 
allows them to be certain that confirmations are being received by the 
counterparty.  

 

Function 

Enter an FX Trade 

 

Information 

All fields in the FX entry screen are matching with the exception of:- 
 Trade Date 
 Sub Participant 
 Information 
 Participant Reference 

 

Navigation Steps 

► Trades ► Create Trades ► FX  

 

 

 

 

 

Process Steps 

1. Follow the navigation steps above to display the ‘FX’ screen. 

2. Enter the FX trade details.   Refer to the Glossary for further 
details on the fields. 

3. The Sub Participant field is used to specify the sub participant 
code through which settlement will occur. 

4. Once all details have been entered, click Send. 
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FX Transaction Entry via SWIFT 

The SWIFT interface allows Bank users to send MT300 SWIFT 
messages to initiate FX transactions without having to make any software 
changes to their internal systems or SWIFT interfaces. This has been 
achieved by the creation of a SWIFT bureau BIC service for corporate 
users to allow Bank users to route MT300 messages directly to a 

participant without having to nominate a specific sub participant code 
within the text of the SWIFT message for FX transactions. 

SFE is responsible for the allocation of SWIFT BIC’s to corporate users 
and for the maintenance of SWIFT BIC’s for Bank users.  When initiating 
an FX transaction via SWIFT, Bank users can elect to receive an 
MT300U response message when their counterparty confirms the 
transaction 

In addition, if a counterparty rejects a transaction, the Bank user can elect 
to receive an MT398 response message indicating the reject reason  
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Glossary – FX 

 

Field Names Description 
Participant Information 
Participant Automatically displayed participant for the user that logged in; cannot be changed. 

This will be the party to whom the trade will be registered. 

Participant name Automatically displayed long participant name for the party. 

Counterparty Specify an opposite party to the trade. 
Type to select a particular counterparty, a valid exchange customer or select it from the drop-down list. 
There is a space between the parts of the identification. 

AC  2 characters  

Participant Mnemonic 4 characters 

Sub Participant Code 2 characters 

If the user only enters the Participant Mnemonic the system automatically inserts the AC Prefix 

Counterparty name Automatically displayed long participant name for the counterparty 

Trade Information 
Series Specify an existing instrument series to trade, or select it from the drop-down list 

Trade date Original registration date and time for the trade. 
Enter a date, current business date or earlier. Default is current business date. 

Settlement date Settlement date/value date; date for delivery/settlement. The date must be a valid settlement date according to CDB. 
Enter a date, current business date or later. Default is current business date. 

Exchange rate Specify exchange rate between the buy and sell currencies.  

Agreement type If matched agreements exist between the parties, the agreement type is automatically displayed as defined, as soon as the parties are 
entered, and cannot be overwritten, examples: ISDA, FRABBA 

Sub participant Automatically displayed organisation unit within the participant for the user that logged in. 

Method dealt Select a method option from the drop-down list: 
DIRECT 
BROKER 
REUTERS 
TELERATE 
TELEX 

Amount Specify amount of currency to buy and to sell from the drop-down list. Both trade sides are mandatory. 

Currency Select a currency code to buy and to sell from the drop-down list. Both trade sides are mandatory. 

SSI Select one of the Yes | No radio buttons. Default = Yes. 
If a Standard Settlement Instruction (SSI) is defined for the Sub participant and instrument (Participant → SSI) the parties have the 
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Field Names Description 
option to use or not to use it for a certain trade. 

Yes the SSI is used and settlement instruction is retrieved from the SSI item 

No a manual settlement instruction is used specifying this manually 
 

Settlement 
instruction 

Enter free text for the buy and sell sides, manually describing settlement instead of using the SSI max. 120 characters. 
The sell trade side is mandatory if SSI is not used for the buy side. 

Settlement Information 
Settle domestic 
currency 

Select one of the Yes | No radio buttons. Default = Yes. 
Options how to settle the domestic currency leg, AUD: 

Yes the domestic currency leg will be netted before settlement 

No an individual delivery record will be created for the domestic currency leg 

Note: When settling any domestic FX trades confirmation can be done from any of the underlying trades. However it is recommended 
that confirmation be done  from the DVP Instruction screen as this will show the final netted amount. 

Domestic currency Currency code for the domestic currency, AUD. 

Settle foreign 
currency 

Select one of the Yes | No radio buttons. Default = No. 
Options how to settle the foreign currency leg or legs: 

Yes the foreign currency leg (or legs) will be settled via SWIFT 

No individual delivery records will be created for the foreign currency legs 
 

Information Enter participant information intended for the counterparty, free text, max. 80 characters. 

Participant ref Enter participant reference, free text using printable characters, max. 32 characters. It is used as link for a trade in an external system.  
SWIFT requires the Participant ref to send SWIFT payment instructions and confirmations, for example the BIC.  
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6.6 Market Repos 
 

Introduction 

A Repurchase Agreement (repo) is a contract involving the sale of a 
security and the simultaneous agreement to buy it back at an agreed 
price at a future date. The Austraclear Market Repo module provides a 
facility to record and settle both 1st and 2nd transaction legs of a repo. 
The system also allows participants to renegotiate and unwind the 2nd 
leg of repos. Market Repos can be entered using both Fixed Income 
Securities and Discount Securities.  

 

Function 

Enter a Market Repo Trade 

 

Information 

All fields in the Repo entry screen are matching with the exception of:- 
 Trade Date 
 Sub Participant 
 Information 
 Participant Reference 

 

Navigation Steps 

► Trades ► Create Trades ► Fixed Income Repo or  
► Trades ► Create Trades ► Discount Security Repo  

 

Process Steps 

1. Follow the navigation steps above to display the ‘Fixed Income or 
Discount Security’ screen. 

2. Enter the Market Repo trade details.   Refer to the Glossary for 
further details on the fields. 

3. The Sub Participant field is used to specify the sub participant 
code through which settlement will occur. 

 

 

 

 

 

4. The SSI field defaults to Y indicating that the cash will settle via 
the default Cash Record. To select an alternate Cash Record on 
a transaction by transaction basis, select N in the SSI field. The 
drop down list in the Cash Record field maybe used to select 
from the list of available Cash Records  

5. Once all details have been entered, click Send. 
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Glossary – Market Repos 

 

Field Names Description 
Participant Information 
Participant Automatically displayed participant for the user that logged in; cannot be changed. 

This will be the party to whom the trade will be registered. 

Participant name Automatically displayed long participant name for the party. 

Counterparty Specify an opposite party to the trade. 
Type to select a particular counterparty, a valid exchange customer or select it from the drop-down list. 
There is a space between the parts of the identification. 

AC  2 characters  

Participant Mnemonic 4 characters 

Sub Participant Code 2 characters 

If the user only enters the Participant Mnemonic the system automatically inserts the AC Prefix 

Counterparty name Automatically displayed long participant name for the counterparty 

Trade Information 
Series Specify an existing series to trade, or select it from the drop-down list. Either Series or ISIN must be specified. 

ISIN Instrument series’ International Securities Identification Number (ISIN).  
Specify a valid ISIN to identify the instrument series, or select it from the drop-down list. Either Series or ISIN must be specified. 

Coupon rate Automatically displayed or entered value. 
Specify a coupon rate value, or select it from the drop-down list. 

Maturity date Automatically displayed or entered value. 
Specify a maturity date, or select it from the drop-down list. The value must be equal to the instrument series expiration date. 

Underlying Automatically displayed or entered value. 
Enter underlying long name, or select it from the drop-down list. 

Issuer Automatically displayed or entered value. 
Specify an issuer, or select it from the drop-down list. 

Side Select trade side option: 
Buy or Sell 
Default = Buy. 

Trade date Original registration date and time for the trade. 
Enter a date, current business date or earlier. Default is current business date. 

1st Trans date 1st transaction date, date for delivery/settlement set for the 1st leg when the deal is generated.  
The date must be a valid settlement date according to CDB and the date must not exceed the maturity date of the traded instrument 
series. 
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Field Names Description 
Enter a date, current business date or later. Default is current business date. 

2nd Trans date 2nd transaction date, date for delivery/settlement set for the 2nd leg when the deal is generated.  
The date must be a valid settlement date according to CDB and the date must not exceed the maturity date of the traded instrument 
series. 
Enter a date equal to or later than the 1st transaction date. Default = <blank>.  
If a value is entered the number of days are automatically calculated and displayed. 
Attention!   The system determines the Repo type by validating the entered value. The type will be assigned to the Repo item. 
Repo type options: 

Fixed term if the 2nd transaction date is later than the 1st 

Intraday if the 2nd transaction date is equal to the 1st 

At call if the 2nd transaction date is <blank> 
 

Face value Face value of the Repo.    
Enter face value. When entering the value, the following abbreviations are available: 

K for thousand 

T for thousand 

M for million 

The entered number of decimals must be the same as in the default value 0.00 displayed in the field. 
The maximum value is configurable up to 10 billions. 
Example: 12.5M is equal to 12,500,000.00 

Yield Enter a yield within 0 to 100. 
The entered number of decimals must be the same as in the default value 0.00 displayed in the field. 

Cash rate Enter a cash rate for the Repo trade within 0 to 100. 
The entered number of decimals must be the same as in the default value 0.00 displayed in the field. 

Settle currency Automatically displayed settlement currency code for the instrument class of the series. 

Agreement type If matched agreements exist between the parties, the agreement type is automatically displayed as defined, as soon as the parties are 
entered, and cannot be overwritten, examples: ISDA, FRABBA 

Sub participant Automatically displayed organisation unit within the participant for the user that logged in.  

SSI Select one of the Yes | No radio buttons. Default = Yes. 
If a Standard Settlement Instruction (SSI) is defined for the Sub participant and instrument (Participant → SSI) the parties have the 
option to use or not to use it for a certain trade. 

Yes the SSI is used and settlement instruction is retrieved from the SSI item 

No a content of the settlement instruction must be specified manually below 
 

Sub account If SSI Yes is selected, the sub account value is automatically specified otherwise specify the code, up to 24 characters: 
Or select it from the scroll list. The scroll list contains cash records dedicated to the participant specified in the Account field. 

Cash record If SSI Yes is selected, the cash record value is automatically specified otherwise specify the code, up to 24 characters: 
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Field Names Description 
Or select it from the scroll list. The scroll list contains cash records dedicated to the participant specified in the Account field. 

Novation Select novation option: 

Yes both parties are validated against the <Novation allowed flag> in the Customer Legal Instrument Type in CDB. Also the series 
must be validated against the <Novation allowed flag> in CDB. The trade is a BRC trade 

No no novation is performed 

Default = No. 

Margin ratio Enter a 3 digit integer for margin ratio/haircut, 0-9. 
The value is only used as information not for calculations. 
 

Settlement Information 
Payment settle Select one of the Yes | No radio buttons. Default = Yes. 

For foreign currency, Yes is only available if the participant is a SWIFT participant with BIC identification. 
The system validates the consideration amount.  

Yes and if the consideration amount is greater than 0, a payment will be performed using a DVP instruction for SWIFT or CSD. 

No or if the consideration amount is 0, a Free Of Payment (FOP) delivery will still be performed. 
 

Sell settlement 
instruction 

Enter free text for the sell side, manually describing settlement instead of using the SSI max. 120 characters, recommended if SSI = No 
and Payment settle = No. 
On the other hand, if SSI = Yes and Payment settle = No and an SSI including settlement instruction is defined, this settlement 
instruction will be used and displayed in the field. 
External interfaces and foreign currency trades require Settlement instructions to instruct the payer where to pay the funds. 
The SWIFT interface will use the Participant ref. for identification. 

Information Enter participant information, free text using printable characters, max. 80 characters. 

Participant ref Enter participant reference, free text using printable characters, max. 32 characters. It is used as link for a trade in an external system.  
SWIFT requires the Participant ref to send SWIFT payment instructions and confirmations for example the BIC.  

Consideration Consideration /settlement amount is calculated from yield by the system when Calculate both Considerations is selected, but can be 
overwritten by the user (0 is allowed).  
The entered number of decimals must be the same as in the default value 0.00 displayed in the field. 

Unwind 
consideration 

Consideration /settlement amount for the 2nd leg, is calculated by the system when Calculate both considerations button is selected 
according to the following Repo type calculation options: 

Fixed term a value is calculated based on the number of days between the 1st and 2nd transaction dates 

Intraday a value must be entered by the user 

At call a value is calculated assuming that the Repo will unwind the next business date 

If you enter a Consideration value manually and you want to calculate a new Unwind Consideration value based on the entered 
consideration value, you must use the Calculate Unwind Consideration button. 
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6.7 SWAPS 
 

Introduction 

An Interest Rate Swap is an agreement between two parties to exchange 
a series of future cash flow payments. Each cash flow is exchanged 
using market values determined by current interest rates. The Interest 
Rate Swaps (IRS) module provides a facility to record and confirm $A 
transactions in advance of settlement and subsequently settle cash flow 
payments automatically. The system also allows participants to enter and 
settle up-front payments and both partial and full termination payments 
relating to a Swap. 

 

Function 

Enter a SWAP Trade 

 

Information 

Arrears swaps commencing today may be entered both before and after 
the daily settlement run. If entered before the settlement run, rates will be 
set at the time of the run. However, if entered after the settlement run the 
system cannot perform a rate set and participants will have to set the rate 
for those swaps manually.  

Advance swaps commencing today may be entered before the daily 
settlement run. The system will set the rate at the time of the settlement 
run. 

All fields in the SWAP entry screen are matching with the exception of:- 
 Sub Participant 
 Information 
 Participant Reference 
 SSI – Y/N 
 Cash Record 

Navigation Steps 

► Trades ► Create Trades ► SWAP  

Process Steps 

1. Follow the navigation steps above to display the ‘SWAP’ screen 
as shown on next page. 

2. The Swap Trade Entry screen is divided into two sections:- 

 Details relating to the life of the swap. 

 Details relating to individual payments. 

3. Enter the Swap trade details.   Refer to the Glossary for further 
details on the fields. 

4. The Sub Participant field is used to enter the sub participant 
code through which settlement will occur. 

5. The Conditions field allows for the entry of detailed swap 
conditions. This field is optional.   If Swap conditions are entered 
they must be confirmed as read by the counterparty before a 
transaction can be considered Matched. Swaps will remain in a 
Paired state until such time as conditions are confirmed.   A 
Swap will be Paired when high level details of the Swap match 
but there are Unmatched Swap Conditions or Unmatched 
Payment Rows. 

6. The Upfront Payments field allows for the entry of any “one off” 
settlement amounts on a Swap. This field is optional.   For an 
Upfront Payment to settle, both parties to the Swap must enter 
matching Upfront details. 

7. The Reset Days field is used to define the number of days prior 
to the date that the rate set will be performed. Rate resets can be 
performed on either the first or the last day of the period. The 
Rate Reset field allows participants to specify when rate sets are 
to occur. 

8. Participants may enter their agreed swap business day rules in 
the State Holidays field on a trade by trade basis. State holidays 
in states entered by either party are non-payment days, therefore 
payments cannot be settled on those days.   The entry of State 
Holidays is optional.    If State Holidays are not entered, 
payments will only be checked for weekends and national holiday 
dates 

9. Once all details have been entered, click Send. 
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Function 

Confirm SWAP Conditions 

 

Information 

If Swap conditions are entered they must be confirmed as read by the 
counterparty before a transaction can be considered Matched.   Swaps 
will remain in a Paired state until such time as conditions are confirmed.   
A Swap will be Paired when high level details of the Swap match but 
there are Unmatched Swap Conditions. 

 

Navigation Steps 

► Trades ► View Reported Trades  

 

Process Steps 

1. Follow the navigation steps above to display the ‘View Reported 
Trades’ screen. 

2. Specify search criteria and click search to view all Swaps to 
which you are a party. 

3. Highlight the transaction to be confirmed and from the right click 
menu select Confirm Swap Conditions, check the details and 
click OK. 
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Glossary – SWAPS 

 

Field Names Description 
Participant Information 
Participant Automatically displayed participant for the user that logged in; cannot be changed. 

This will be the party to whom the trade will be registered. 

Participant name Automatically displayed long participant name for the party. 

Counterparty Specify an opposite party to the trade. 
Type to select a particular counterparty, a valid exchange customer or select it from the drop-down list. 
There is a space between the parts of the identification. 

AC  2 characters  

Participant Mnemonic 4 characters 

Sub Participant Code 2 characters 

If the user only enters the Participant Mnemonic the system automatically inserts the AC Prefix  

Counterparty name Automatically displayed long participant name for the counterparty 

Trade Information 
Series Specify an existing series to trade, or select it from the drop-down list.  

Sub participant Automatically displayed organisation unit within the participant for the user that logged in. 

Side Select trade side option:- 

Fixed-float 1st leg pays fixed rates and receives floating rates 

Float-fixed 1st leg pays floating rates and receives fixed rates 

Float-float both legs pay floating rates and receive floating rates 

Default = Fixed-float. 

Trade date Enter a date, current business date or earlier. Default is current business date. 
The trade date is the date that a contract is made between two parties.  
Compare the clearing date, which is the date that the trade will be cleared in the clearinghouse. 
The trade date could be earlier than the clearing date. 

Effective date Start date for the first rollover period. 
Enter a date, current business date or later. Default is current business date. 

Term. date Termination date for the underlying; the last date that the underlying is available. 
Enter a date.  

Bus. day conv. Select business day convention option:- 

Modified 
following  

a non-business date will be adjusted to the first following date that is a business date, unless that date falls in the next 
calendar month, in which case that date will be the first preceding date that is a business date 
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Field Names Description 
Following a non-business date will be adjusted to the first following date that is a business date 

Preceding a non-business date will be adjusted to the first preceding date that is a business date 

Default = Modified following.  

Notional amount An amount to use as basis for calculations of payments. The notional amount will never be exchanged between the parties, only used 
for calculations. 
Specify notional amount.  

Currency Automatically displayed currency code from instrument class, which is a valid payment series. 

Rate reset Select rate reset option: 

First the Rate date, the date when the floating rate is set, will be the First date (in Advance) 

Last the Rate date, the date when the floating rate is set, will be the Last date (in Arrears) 

Default = Last.  

Reset days Select number of business days with which the Rate date will be reduced. 
Rate date = First | Last (date of the rollover period according to the Rate reset selection) - Reset days number of business days 

Payment set Select payment set option: 

First the Pay date, the date when the payment is set, will be the First date of the rollover period (in Advance) 

Last the Pay date, the date when the payment is set, will be the Last date of the rollover period (in Arrears) 

Default = Last.  

Payment settle Select one of the Yes | No radio buttons. Default = Yes. 
For foreign currency, Yes is only available if the participant is a SWIFT participant with BIC identification. 
The system validates the consideration amount.  

Yes and if the consideration amount is greater than 0, a payment will be performed using a DVP instruction for SWIFT or CSD. 

No or if the consideration amount is 0, a Free Of Payment (FOP) delivery will still be performed. 
 

Novation The field is not used. Frozen = 0. 

SSI Select one of the Yes | No radio buttons. Default = Yes. 
If a Standard Settlement Instruction (SSI) is defined for the Sub participant and instrument (Participant → SSI) the parties have the 
option to use or not to use it for a certain trade. 

Yes the SSI is used and settlement instruction is retrieved from the SSI item 

No a content of the settlement instruction must be specified manually below 
 

Cash record If SSI Yes is selected, the cash record value is automatically specified otherwise specify the code, up to 24 characters: 
Or select it from the scroll list. The scroll list contains cash records dedicated to the participant specified in the Sub participant field. 

Agreement type If matched agreements exist between the parties, the agreement type is automatically displayed as defined, as soon as the parties are 
entered, and cannot be overwritten, examples: ISDA, FRABBA 

Information Enter participant information, free text using printable characters, max. 80 characters. 

Participant ref Enter participant reference, free text using printable characters, max. 32 characters. It is used as link for a trade in an external system.  
SWIFT requires the Participant ref to send SWIFT payment instructions and confirmations for example the BIC.  
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Field Names Description 
State Holiday Check the checkbox to select calendars. 

Apply state 
holidays 

Two different calendars can be selected in the two drop-down lists that become available. The holidays included in both these calendars 
will be regarded by the system when calculating flow values. 

Cond. conf Automatically displayed confirmed or not confirmed condition. 

Conditions Swap conditions, free text using printable characters, max. 255 characters. 

Upfront Extension Information 
Upfront payer Identification of the party or counterparty as upfront payer. 

Upfront date Mandatory only if the Upfront payer is entered. Enter a valid settlement date later than current.  

Upfront amt Upfront payment amount.   Mandatory only if the Upfront payer is entered. Enter a value greater than 0. 

Upfront curr Upfront payment currency.   Mandatory only if the Upfront payer is entered. Select currency code. 

Leg Information 
1st leg: <participant> pays <1st leg side>. 
2nd leg: <counterparty> pays <2nd leg side>. 

Rate | Spread If the leg side is Fixed, the field contains fixed Rate. Enter a fixed rate. If the leg side is Float, the field contains Spread rate, a rate 
which will be added to the fixing value of the floating rate. Enter a spread rate in Basis Points without decimals + or -. 
Example: If you enter 7, 0.07 % will be added to the rate. 
Example: If you enter -5, -0.05 % will be added to the rate. 

Floating rate option Floating rate option; open only If the leg side is Float. A valid rate type defined for the instrument class.  
Select a value from the drop-down list. If the field is left empty, the rate can be entered later but before settlement. 

Day count fraction Day count convention/fraction; day calculation rule from underlying.  
Select a value from the drop-down list.  

Initial rate Enter interest rate for the first payment flow. 

1st Roll date First rollover End date. Enter a business date later than the Effective date.  

Roll period The rollover period and rollover date define the payment/end date in each flow and the start date of the next flow. Default = <blank>. 
Select rollover period option: 

1M 1 month 

3M 3 months 

6M 6 months 

12M 12 months (Note: there is currently no published 12 month float rate). 
 

Roll day Select rollover End date option: 1 to 31 a in each month. Default = <blank>. 
If the field is left empty, the 1st roll date will serve as rollover End date. 

Flow Information 
Start date Start date for the rollover period. The date is a valid business date.  

For the first rollover period, the Start date equals the Effective date. 
For the next rollover period, the Start date equals the End date of the previous rollover period. 

End date End date for the rollover period. The date is a valid business date.  
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Field Names Description 
For the first rollover period, the End date equals the 1st roll date. 
Next End date is calculated by first adding one rollover period, Roll per, to the previous End date. Then if Roll day is defined, finding the 
closest Roll day date. Finally applying the Business day convention to find the closest business date. 
For the last rollover, the End date is equal to the Termination date. 

Rate date Date when the floating rate is set, as defined by the Rate reset and Reset days. Mandatory for floating rate legs. 

Rate The floating rate will be set exactly on the First or Last date of the rollover period or on a date certain days ahead of either. Mandatory 
for fixed rate legs.   For the first rollover period, the value defined in Initial rate will be used. 
Note: Currently a 12 mth float rate is not a published rate  

Not. amount Notional amount covered during the rollover period.  

Pay date Date when the payment is calculated, on the First or Last date of the rollover period, as defined by the Payment set value.  

Consid. Consideration/payment amount for the rollover period. Mandatory for fixed rate legs. 

Days in per. Number of days in the rollover period, = End date - Start date. 
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6.8 RBA Repos 
 

Introduction 

The Austraclear RBA REPO facility enables Cash Providers to nominate 
eligible securities for Repo to the RBA for improved intraday liquidity 
management. Both the 1st and 2nd transaction legs of an RBA Repo can 
be recorded and settled on the system.  

RBA Repos are a one sided function and do not require system interaction 
by the RBA. The counterparty to transactions is RBAA25 for Fixed Income.  

The system also allows participants to reverse the 2nd leg of repos.  

The RBA sets rules for the trading of RBA Repos. These rules allow the 
RBA to:- 

 Maintain Margin Ratio Rates used in the calculation of payment 
amounts 

 Add Securities acceptable for RBA Repos 

 Remove Securities acceptable for RBA Repos 

 

Function 

Enter an RBA Repo Trade 

 

Information 

An RBA Repo cannot be entered for an amount greater than the volume 
held by the participant. 

RBA Repos do not need to be confirmed by the RBA, but will be submitted 
for settlement automatically. 

The Reference Price for each eligible security is pre-determined by the 
RBA and the consideration for both legs is calculated automatically. 

If the first leg of an RBA repo is deleted prior to authorisation (if applicable) 
then the second leg is automatically deleted. 

 

Navigation Steps 

► Holdings ► View Holdings  

 

 

 

Process Steps 

1. Follow the navigation steps above to display the ‘Holdings’ screen. 

2. Highlight the transaction, Right Click and select Create RBA 
Repo based on Holding.  

3. Enter transaction details into the Create RBA Repo screen and 
click Calculate.   Refer to the Glossary for further details on the 
fields 

4. When all details have been entered, click OK to submit the trade 
for settlement. 
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Glossary – RBA Repos 

 

Field Names Description 
Payment Instruction 
Currency The currency in which the repo is payable.  

Cash Record The cash record to be debited or credited.  

Security Instructions 
Series An instrument eligible to include in a security instruction of an RBA repo under a specific rule.  

Issuer The issuer of the series included in the repo.  

Full Name Issuer The name of the issuer.  

Volume The size of the delivery. It cannot be negative.  

Sub Account The sub account that the loan should be put to. This is also the sub account that the loan will be returned from.  

Calculated 
Payment Amount 

The amount to be paid out in connection with the repo, as calculated using the Calculate button.  

Public Information 
Participant Short name that uniquely identifies the participant to whom the RBA repo belongs.  

Public Comment Informative free-text description of the RBA repo.  

Internal Information 
Override Cash 
Record Priority 

Indicates the priority the instruction of the delivery of payments has relative to other instructions.  
One of the following: Priority, Active or Deferred. 

Override Sub 
Account Priority 

Indicates the priority the instruction of the delivery of securities has relative to other instructions.  
One of the following: Priority, Active or Deferred. 

Participant 
Reference 

Optional reference to other internal systems. Set by the participant.  

Internal Comment Free-text field.  

Current Repo Rule 
Current Reference 
Price 

Reference price specified for the specified collateral series.  

Current Margin 
Ratio 

Margin ratio specified for the collateral.  

Current Penalty 
Interest  

Penalty interest specified for the collateral 

 
 



Austraclear System Participant User Guide 

          131  

6.9 Uploading Messages via H2HLink 
 

Introduction 

The Common Gateway GUI Application provides users with access to the 

following: 

 Uploading H2HLink messages 

 Searching and printing messages  

 

Function 

Logging into/Exiting H2HLink 

 

Information 

 

Navigation Steps 

Windows Menu ► Programs ► OM Common Gateway ► SWGUI.exe  

 

Process Steps 

1. Follow the navigation steps above to display the Login screen. 

2. Enter the New SFE Austraclear System Username and 
Password. 

3. Select the corresponding SFE Austraclear Digital Certificate from 
the dropdown box and then click Login. 

4. Once the new system validates your login credentials it will 
activate the appropriate menu items on the main menu bar. 

5. To exit the interface application click File ► Close. 
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Function 

Uploading H2HLink Files 

 

Information 

A user can choose which H2HL file they wish to upload via the Common 
Gateway. The file will be processed by the Gateway. You can view the 
message uploaded via the Message Explorer (refer to Section 2.3.1). 

 

Navigation Steps 

File ► Upload Host-to-Host File  

 

Process Steps 

1. Follow the navigation steps above to display a popup window. 

2. Select the file to be uploaded.   H2HL files are generally located 
in the H2HL folder and have a DAT extension. 

3. Select Open.   The file will then be uploaded.   Progress is shown 
on a progress bar.    

 

 

 

 

 

 

 

 

 

 

 

Function 

View Messages 

 

Information 

This function is used to view Incoming and Outgoing messages from the 
H2HL Common Gateway System.   The message explorer is the main 
screen for searching, viewing and printing H2HL messages.   The user 
can query on H2HL messages to display both log information and raw 
message data. 

 

Navigation Steps 

Gateway Messages ► Explore Messages  

 

Process Steps 

1. Follow the navigation steps above to display the ‘Explore 
Messages’ window. 

2. Enter data into the search criteria fields and click Search. 

3. Highlight the message required.   The raw message information 
will be displayed in the Raw Message section at the bottom right 
of the window. 

4. To Print, right click the Raw Message section.   A popup window 
will be displayed.   Select Print and click OK. 
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7. Confirm/Reject a Trade 

7.1 FX 

 

Introduction 

The Austraclear system allows for electronic confirmation of spot and 
forward currency deals for both $A and cross currency transactions and 
enables settlement of the $A transaction leg.  

A Bank will enter their side of an FX transaction and the Corporate 
Counterparty will confirm the entry, effectively eliminating the need for a 
dual sided entry. Transactions confirmed using this method will also 
generate a Confirmation Report to Corporate participants which they can 
print and retain. This process eliminates the need for Banks to send 
paper-based confirmations to their Corporate counterparties and allows 
them to be certain that confirmations are being received by the 
counterparty.  

 

Function 

Confirm/Reject an FX Trade 

 

Information 

This confirmation/rejection function is for Corporate Participants. 

 

Navigation Steps 

► Trades ► View Reported Trades  

 

Process Steps 

1. Follow the navigation steps above to display the ‘Reported 
Trades’ screen. 

2. Specify search criteria and click search to view all FX 
transactions to which you are a party. 

3. To Confirm - Highlight the transaction to be confirmed and from 
the right click menu select Confirm Trade Report.  

 

4. The following fields are mandatory when confirming an FX 
transaction:-   

- Sub Participant 
- Participant Reference  

 

5. To Reject - Highlight the transaction to be rejected and from the 
right click menu select Reject Trade Report. 

6. The following fields are mandatory when rejecting an FX 
transaction:- 

- Information 
- Sub Participant 
- Participant Reference 

7. If a corporate counterparty rejects an FX transaction, the system 
will require them to enter a reason for the rejection. The reject 
reason will be notified to the Bank counterparty via a return 
SWIFT message. 

8. FX transactions that have been rejected cannot be corrected by 
either counterparty. 

 

9. The Sub Participant field is used to specify the sub participant 
code through which settlement will occur.  

10. The Participant Reference is the internal reference number of 
the Corporate Participant. Upon confirmation, a return SWIFT 
message is sent to the Bank counterparty advising them of the 
confirmation reference.  The Participant Reference field will 
accept a reference number up to 16 characters long. 

11. Refer to the Glossary for further details on the fields. 
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Function 

View/Print FX Confirmation Letter 

 

Information 

On entry of an FX transaction by a Bank the system will create an FX 
Confirmation Letter which the corporate counterparty can view and/or 
print. 

As an FX Confirmation Letter is printed, a confirmation will be sent to the 
Bank counterparty providing them with acknowledgment that the FX 
transaction was actually delivered and handled by the counterparty. 

The system will record when FX Confirmation Letters were printed and 
the reprinting of letters is allowed. 

 

Navigation Steps 

► Trades ► View Reported Trades  

 

Process Steps 

1. Follow the navigation steps above to display the ‘Reported 
Trades’ screen. 

2. Specify search criteria and click search to view all FX 
transactions to which you are a party. 

3. Highlight the transaction to be viewed and from the right click 
menu select Print Confirmation Letter ► Preview 
Confirmation Letter. 

4. Highlight the transaction to be viewed and from the right click 
menu select Print Confirmation Letter ► Print Confirmation 
Letter, select a printer and click OK or 

5. Highlight the transaction to be viewed and from the right click 
menu select Print Confirmation Letter ► Print Confirmation 
Letter and click OK to automatically print to your default printer. 

 

 

 

 

 

DETAILS OF FOREIGN EXCHANGE DEAL

---------------------------------------------------------

Participant: AC ANZB ANZ BANKING GROUP LTD

Counterparty: AC WPAC WESTPAC BANKING CORPORATION

Deal Ref Deal Date Method Dealt

---------- ------------ ----------------

Emma test 20/07/2004 DIRECT

Confirmation Reference

-----------------------------

Emma test

FOREIGN EXCHANGE DEAL FOR VALUE DATE 20/07/2004

AC ANZB 30 SOLD EXCHANGE RATE AC ANZB 30 PURCHASED

------------------------- ------------------------- ------------------------------------

AUD 3,000,000.00 1.2000000 GBP 1,000,000.00

SOLD AMOUNT PAYABLE TO PURCHASE AMOUNT PAYABLE TO

----------------------------------------- -------------------------------------------------

ssi for anzb30

NOTE: THIS REPORT IS COMPUTER GENERATED AND IS PROVIDED FOR INFORMATION ONLY, FOR THE PURPOSE OF    

ASSISTING THE COUNTERPARTIES TO CONFIRM THEIR TRANSACTION  

DETAILS OF FOREIGN EXCHANGE DEAL

---------------------------------------------------------

Participant: AC ANZB ANZ BANKING GROUP LTD

Counterparty: AC WPAC WESTPAC BANKING CORPORATION

Deal Ref Deal Date Method Dealt

---------- ------------ ----------------

Emma test 20/07/2004 DIRECT

Confirmation Reference

-----------------------------

Emma test

FOREIGN EXCHANGE DEAL FOR VALUE DATE 20/07/2004

AC ANZB 30 SOLD EXCHANGE RATE AC ANZB 30 PURCHASED

------------------------- ------------------------- ------------------------------------

AUD 3,000,000.00 1.2000000 GBP 1,000,000.00

SOLD AMOUNT PAYABLE TO PURCHASE AMOUNT PAYABLE TO

----------------------------------------- -------------------------------------------------

ssi for anzb30

NOTE: THIS REPORT IS COMPUTER GENERATED AND IS PROVIDED FOR INFORMATION ONLY, FOR THE PURPOSE OF    

ASSISTING THE COUNTERPARTIES TO CONFIRM THEIR TRANSACTION   
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Glossary – FX 

 

Field Names Description 
Participant Information 
Participant Automatically displayed participant for the user that logged in; cannot be changed. 

This will be the party to whom the trade will be registered. 

Participant name Automatically displayed long participant name for the party. 

Counterparty Specify an opposite party to the trade. 
Type to select a particular counterparty, a valid exchange customer or select it from the drop-down list. 
There is a space between the parts of the identification. 

AC  2 characters  

Participant Mnemonic 4 characters 

Sub Participant Code 2 characters 

If the user only enters the Participant Mnemonic the system automatically inserts the AC Prefix  

Counterparty name Automatically displayed long participant name for the counterparty 

Trade Information 
Series Specify an existing series to trade, or select it from the drop-down list 

Trade date Original registration date and time for the trade. 
Enter a date, current business date or earlier. Default is current business date 

Settlement date Settlement date/value date; date for delivery/settlement. The date must be a valid settlement date according to CDB. 
Enter a date, current business date or later. Default is current business date. 

Exchange rate Specify exchange rate between the buy and sell currencies.  

Agreement type If matched agreements exist between the parties, the agreement type is automatically displayed as defined, as soon as the parties are 
entered, and cannot be overwritten, examples: ISDA, FRABBA 

Sub participant Automatically displayed organisation unit within the participant for the user that logged in. 

Method dealt Select a method option from the drop-down list: 

DIRECT 

BROKER 

REUTERS 

TELERATE 

TELEX 
 

Amount Specify amount of currency to buy and to sell from the drop-down list. Both trade sides are mandatory. 

Currency Select a currency code to buy and to sell from the drop-down list. Both trade sides are mandatory. 

SSI Select one of the Yes | No radio buttons. Default = Yes. 
If a Standard Settlement Instruction (SSI) is defined for the Sub participant and instrument (Participant → SSI) the parties have the 
option to use or not to use it for a certain trade. 

Yes the SSI is used and settlement instruction is retrieved from the SSI item 

No a manual settlement instruction is used specifying this manually 
 

https://exigotc.austraclear.com.au/exigoonlinehelp/00secur/rea/rea_app_sec.xml#dat
https://exigotc.austraclear.com.au/exigoonlinehelp/00secur/rea/rea_app_sec.xml#dat
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Field Names Description 
Settlement 
instruction 

Enter free text for the buy and sell sides, manually describing settlement instead of using the SSI max. 120 characters. 
The sell trade side is mandatory if SSI is not used for the buy side. 

Settlement Information 
Settle domestic 
currency 

Select one of the Yes | No radio buttons. Default = Yes. 
Options how to settle the domestic currency leg, AUD: 

Yes the domestic currency leg will be netted before settlement 

No an individual delivery record will be created for the domestic currency leg 
 

Domestic currency Currency code for the domestic currency, AUD. 

Settle foreign 
currency 

Select one of the Yes | No radio buttons. Default = No. 
Options how to settle the foreign currency leg or legs: 

Yes the foreign currency leg (or legs) will be settled via SWIFT 

No individual delivery records will be created for the foreign currency legs 
 

Information Enter participant information intended for the counterparty, free text, max. 80 characters. 

Participant ref Enter participant reference, free text using printable characters, max. 32 characters. It is used as link for a trade in an external system.  
SWIFT requires the Participant ref to send SWIFT payment instructions and confirmations, for example the BIC.  

 
 

https://exigotc.austraclear.com.au/exigoonlinehelp/00secur/rea/rea_app_sec.xml#ent
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7.2 OCH/SFE Margins 

 

Introduction 

The OCH and SFE Margin facilities allow participants to pay and receive 
OCH and SFE Margins respectively on the Austraclear system as a same 
day transaction.  

OCH Margin data is entered daily by Options Clearing House (OCH).   
SFE Margin data is entered daily by SFE Clearing.   Participants confirm 
their respective instructions to effect the settlement of the Transfer. 

If the participant has sufficient funds available, the system will affect the 
transfer of funds with no further intervention required by either 
counterparty. 

 

OCH Margins 

In order to use Austraclear for the settlement of OCH margin payments, 
OCH Participants are required to make prior arrangements with both the 
Options Clearing House (OCH) and SFE Austraclear.  

Participants will need to complete application forms for both OCH and 
SFE Austraclear and also notify bank account details for their HOUSE 
and CLIENT accounts to SFE Austraclear. These bank accounts will be 
set up as the default Cash Records for both the HOUSE and CLIENT 
accounts in the system. 

OCH will determine if a Participant may confirm their own position or 
whether it must be cleared by another Participant. 

 

SFE Margins 

In order to use Austraclear for the settlement of SFE margin payments, 
SFE Clearing Participants are required to make prior arrangements with 
both SFE Clearing and SFE Austraclear.  

Participants will need to complete application forms and notify bank 
account details for their HOUSE and CLIENT accounts to both SFE 

Clearing and SFE Austraclear. These bank accounts will be set up as the 
default Cash Records for both the HOUSE and CLIENT accounts in the 
system. 

 

 

SFE Clearing will determine if a Clearing Participant may confirm their 
own position or whether it must be cleared by another Clearing 
Participant. 

SFE Clearing may make payments and/or receipts on public holidays 
provided the participant acting on side 2 of the transaction has a Holiday 
cash record set up for either or both the HOUSE and CLIENT accounts. 

 

Function 

View OCH/SFE Margin Cash Transfers 

 

Information 

For Clearing Participants (ie. Those that have the facility to confirm their 
own payments) the system will display if the payment is their own 
(HOUSE) or for another Participant (CLIENT). 

 

Navigation Steps 

► Trades ► View Reported Trades  

 

Process Steps 

1. Follow the navigation steps above to display the ‘Reported 
Trades’ screen. 

2. Specify either OCHCASH or SFECASH in the Series field search 
criteria and click Search to view all OCH or SFE Margin Cash 
Transfers awaiting confirmation. 
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3. OCH/SFE Margin Cash Transfers will be displayed for both 
HOUSE and CLIENT Accounts. 
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Function 

Confirm/Reject OCH/SFE Margin Cash Transfers 

 

Information 

All debit/credits will be generated from participants’ nominated OCH/SFE 
accounts.   The system will prevent Participants from overriding this field 
when confirming/rejecting OCH and SFE Margin Cash Transfers. 

OCH and SFE Margin Cash Transfers will be Paired when high level 
details of the transaction match but authorisation is pending on one or 
both sides of the transaction.  

For OCH Margins, Participants need to have their side of the daily cash 
transfer in the system ready for settlement at 10.30am  

All SFE Margin Cash Transfers which are a DEBIT to Participants, must 
be confirmed by 10:30am 

All SFE Margin Cash Transfers which are a CREDIT to Participants, can 
be confirmed any time until the EOD time (4:28pm) 

 

Navigation Steps 

► Trades ► View Reported Trades  

 

Process Steps 

1. Follow the navigation steps above to display the ‘Reported Trades’ 
screen. 

2. Specify either OCHCASH or SFECASH in the Series field search 
criteria and click Search to view all OCH or SFE Margin Cash 
Transfers awaiting confirmation. 

3. To Confirm - Highlight the transaction to be confirmed and from the 
right click menu select Confirm Trade Report.   Check the details 
and click Send to confirm the transaction and submit for settlement 
or 

4. To Reject - Highlight the transaction to be rejected and from the 
right click menu select Reject Trade Report and click Send. 

5. The Participant Reference field may be updated by Participants when 
confirming or rejecting an OCH or SFE Margin Cash Transfer. 

6. The Sub Participant field is used to specify the sub participant code 
through which settlement will occur. 
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8. Rectify/Cancel a Trade 
 

Definition 

The ability to rectify or cancel a trade for Cash, DSS, FIS, FX, Market 
Repos and SWAPS. 

 

Function 

Rectify or Cancel a Trade 

 

Information 

The generic process to rectify or cancel a trade is detailed in the process 
steps below.   The system rules describe, by product, what states a trade 
can be rectified/cancelled.     

 

Navigation Steps 

► Trades ► View Reported Trades  

 

Process Steps 

1. Follow the navigation steps above to display the ‘View Reported 
Trades’ screen. 

2. Specify search criteria and click on ‘Search’ to view all trades to 
which you are party. 

3. To Rectify – Highlight the transaction to be rectified and from the 
right click menu select Rectify Trade Report.   Rectify the trade 
(if necessary press the Recalculate button) and then press the 
Send button. 

4. To Cancel – Highlight the transaction to be cancelled and from 
the right click menu select Cancel Trade Report.   When the 
details of the trade to be cancelled appear press the Send 
button. 

 

System Rules 

All Transactions in an Unmatched state may be cancelled and any field 
may be rectified. 

 

 

CASH 

 Transactions in a Paired state may be cancelled and the following 
fields may be rectified: Sub Participant, Cash Record, Information, 
and Participant Reference. 

 Transactions in a Matched state may only be cancelled. 

 If transactions in a Paired state are rectified they must be 
confirmed/authorised by the counterparty. 

 If a transaction in a status of Pending Rectification is not confirmed or 
rejected, then the transaction will remain in a Pending status and will 
not proceed to settlement. 

 Cancellations of Matched or Paired transactions must be 
confirmed/authorised by the counterparty. 

 If a transaction in a status of Pending Cancellation is not confirmed or 
rejected, then the transaction will remain in a Pending status and will 
not proceed to settlement.  

 To reject a transaction in a state of Pending Cancellation, Right Click 
on the Trade and Select Reject Pending Cancel Trade Report. 

 The Trade state will then revert to Matched. 
 

 

DSS/FIS 

 Transactions in a Paired state may be cancelled and the following 
fields may be rectified: Sub Participant, Cash Record, Information, 
and Participant Reference. 

 Transactions in a Matched state may only be cancelled. 

 If transactions in a Paired state are rectified they must be confirmed/ 
authorised by the counterparty. 

 If a transaction in a status of Pending Rectification is not confirmed or 
rejected, then the transaction will remain in a Pending status and will 
not proceed to settlement. 
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 Cancellations of Matched or Paired transactions must be 
confirmed/authorised by the counterparty. 

 If a transaction in a status of Pending Cancellation is not confirmed or 
rejected, then the transaction will remain in a Pending status and will 
not proceed to settlement. 

 To reject a transaction in a state of Pending Cancellation, Right 
Click on the Trade and Select Reject Pending Cancel Trade 
Report. 

 The Trade state will then revert to Matched. 
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FRA 

 Transactions in a Paired state may be cancelled and all the fields may be 
rectified with the exception of the counterparty.  

 Transactions in a Matched state may be cancelled and all fields may be 
rectified with the exception of the counterparty. 

 Where the Float Rate Option of a FRA is undefined and the Float Rate has not 
yet been set, the trade can be rectified. Once the Float Rate has been manually 
set, the trade can no longer be rectified. 

 If transactions in a Paired or Matched state are rectified they must be 
confirmed/authorised by the counterparty. 

 If a transaction in a status of Pending Rectification is not confirmed or rejected, 
then the transaction will remain in a Pending status and will not proceed to 
settlement. 

 Cancellations of Matched or Paired transactions must be confirmed/ authorised 
by the counterparty. 

 If a transaction in a status of  Pending Cancellation is not confirmed or rejected, 
then the transaction will remain in a Pending status and will not proceed to 
settlement. 

 

FX 

 Transactions in a Paired or Matched state may be cancelled and the following 
fields may be rectified: Sub Participant, Method Dealt, Information, 
Participant Reference   

 If transactions in a  Matched or Paired state are rectified they must be 
confirmed/ authorised by the counterparty 

 If a transaction in a status of Pending Rectify is not confirmed or rejected, then 
the  transaction will remain in a Pending status and will not proceed to 
settlement  

 Cancellations of Matched or Paired transactions must be confirmed /authorised 
by the counterparty. The counterparty must cancel their side of the trade in 
order to confirm the cancellation.  

 If a transaction in a status of Pending Cancel is not confirmed or rejected, then 
the transaction will remain in a Pending status and will not proceed to 
settlement. 

 FX trades which are Rejected by a corporate counterparty cannot be rectified 
by the Bank counterparty. The Bank must enter a new trade to replace the 
Rejected trade. 

 Corporate participants who opt to confirm FX trades entered by their bank 
counterparty cannot rectify or cancel FX trades. The ability to rectify or cancel a 
FX trade is restricted to the counterparty who entered the original trade. 

 
 
 
 
 

MARKET REPOS 

 Transactions in a Paired state may be cancelled and the following fields may 
be rectified: Sub Participant, Cash Record, Information and Participant 
Reference. 

 Transactions in a Matched state may only be cancelled. 

 If transactions in a Paired state are rectified they must be  

 confirmed/authorised by the counterparty. 

 If a transaction in a status of Pending Rectification is not confirmed or rejected, 
then the transaction will remain in a Pending status and will not proceed to 
settlement. 

 Cancellations of Matched or Paired transactions must be confirmed/authorised 
by the counterparty. 

 If a transaction in a status of Pending Cancellation is not confirmed or rejected, 
then the transaction will remain in a Pending status and will not proceed to 
settlement. 

 To reject a transaction in a state of Pending Cancellation, Right Click on the 
Trade and Select Reject Pending Cancel Trade Report. 

 The Trade state will then revert to Matched.  
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SWAPS 

To Rectify Payment Rows of a SWAP trade in an unmatched state 

 When a field in an individual payment row/s is rectified, the payment amount for 
that row will need to be re-calculated by selecting the Calculate Flows button 

at the bottom of the screen. 
 
SWAP trades in a Paired or Matched state  

 These trades may be cancelled and the following fields may be rectified: Sub 
Participant, Information, Conditions and Participant Reference, as well as 

all the individual payment rows provided the Effective Date of the Swap has not 
passed. Once the Effective Date of a Swap has passed, it must be terminated. 

 
To Rectify Payment Rows of a SWAP trade in a Paired or Matched state  

 User may update Start and End Dates, Rate, Notional Amount, Pay Date, 
Consideration.   If the field rectified is the End Date field, the payment rows 
that follow need to be checked to ensure the Start Date and End Date fields 

are correct – ensure all dates are sequential. 

 If a field in an individual payment row/s is rectified, the payment amount for that 
row will need to be re-calculated by selecting Calculate Consideration from 

the right hand mouse options. 

 Right click on Payment Row to either delete Row, Insert New Row before row 
selected, Add New Row at end or Calculate Consideration. 

 
 

 If transactions in a Matched or Paired state are rectified they must be 
confirmed/authorised by the counterparty.  

 If a transaction with a sub status of Pending Rectification is not confirmed or 
rejected, then the transaction will remain in a Pending sub status and will not 
proceed to settlement.  

 Cancellations of Matched or Paired transactions must be confirmed /authorised 
by the counterparty. The counterparty must cancel their side of the trade in 
order to confirm the cancellation.  

 If a transaction in a status of Pending Cancellation is not confirmed or rejected, 
then the transaction will remain in a Pending sub status and will not proceed to 
settlement. 

 

 

 

 

 

 

 

 

 
Rectify Swap Screen – Matched State 
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9. Authorise a Trade 

 

Definition 

The ability to authorise a trade for Cash, DSS, FIS, FX, Market Repos, 
OCH Margins, SFE Margins and SWAPS 

 

Function 

Authorise a Trade 

 

Information 
Authorisation state options are:- 

 Authorised - the trade is authorised 
 Needed - the trade requires authorisation 
 Not needed - authorisation is not required 

 
A trade with Authorisation state = Needed must be authorised before it can 
be matched. The authorisation must be performed by a user other than the 
user who performed the transaction on the trade. 

Trades will be Paired when high level details of the transaction match but 
authorisation is pending on one or both sides of the transaction.  

 

For all Products except RBA Repos 

Navigation Steps 

► Trades ► View Reported Trades   

 

Process Steps 

1. Follow navigation steps above to display the ‘View Reported 
Trades’ screen. 

2. Specify search criteria and click on ‘Search’ to view all trades to 
which you are party. 

3. Highlight the transaction to be authorised and from the right click 
menu select Authorise Trade Report, check the details and click 
OK. 

 

 

 

4. Alternatively, highlight the transactions to be authorised and from 
the right click menu select Bulk Authorise Trade Report, check 
the details and click OK. 

 

 

For RBA Repos 

Navigation Steps 

► Trades ► View RBA Repos   

 

Process Steps 

1. Follow navigation steps above to display the ‘RBA Repos’ screen.   
This will default to the Open RBA Repos view. 

2. Select the Unauthorised view and click search to view all RBA 
Repos to which you are a party. 

3. Highlight the transaction to be authorised and from the right click 
menu select Authorise, check the details and click OK. 
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10. Reverse an RBA Repo Trade 

 

Definition 

The ability to reverse a trade for RBA Repos 

 

Function 

Reverse an RBA Repo Trade 

 

Information 

Both partial and full reversals are permitted on RBA Repo transactions 

RBA Repos will not automatically be reversed. All reversals must be 
initiated by participants, not the RBA  

The reversal of an RBA Repo is a one sided transaction that does not 
require the RBA to confirm each transaction. 

At the close of the day session, all outstanding RBA Repo reversals will not 
automatically be sent to the RTGS queue for reversal.  The Repo will be 
available for reversal in the following available session. 

These transactions will automatically roll over to the next trading session for 
unwinding. The cash component of the unwind will include an interest 
component set by the RBA. 

 

Navigation Steps 

► Trades ► View RBA Repos   

 

Process Steps 

1. Follow navigation steps above to display the ‘RBA Repos’ screen. 

2. Specify search criteria and click on ‘Search’ to view all RBA Repos 
to which you are party. 

3. Highlight the transaction to be reversed and from the right click 
menu select Reverse, check the details and click OK. 
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11. Settle a Trade 
 

Definition 

The ability to view the settlement details of a trade/transaction for Cash, 
DSS, FIS, FRA’s, FX, Market Repos, OCH Margins, SFE Margins, RBA 
Repos and SWAPS. 

Function 

View Reported Trades 

 

Information 

The generic settlement process is detailed below.   Where there are 
differences, the system rules have been specified by product.  

 

Navigation Steps 

► Trades ► View Reported Trades  

 

Process Steps 

1. Follow navigation steps above to display the ‘View Reported 
Trades’ screen. 

2. Specify search criteria and click Search to view all Trades to which 
the user is a party or proxy 

3. Highlight a transaction and from the right click menu select DVP 
Information. The DVP Information screen will be displayed. 

4. The following information will be displayed: 

- Settlement Status 
- Sub Settlement Status  

 

 

 

 

 

 

 

 

 

 

Function 

View Settlement Instructions 

 

Information 

Participants can use this screen to check on the status of their trade related 
settlement instructions 

 

Navigation Steps 

► Settlement ► View Settlements ► Settlement Instructions 
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Process Steps 

1. Follow navigation steps above to display the ‘Settlement 
Instructions’ screen. 

2. Specify search criteria and click Search to view all Instructions to 
which the user is a party or proxy 

3. Users are also able to right click an instruction to view the State 
History, which shows whether the Security and/or cash is locked in 
and whether Cash Limits and RTGS processing have taken place 

 

 

 

 

 

 

 

 

 

System Rules  

 When trades are Matched, the system will automatically create a DVP 
instruction with a settle status of Accepted and a Settlement Instruction 
with a state of Matched in preparation for settlement  

 On the settlement day, the Settlement Instruction will undergo Cash 
Limits testing and RTGS processing 

 On completion of Cash Limits and RTGS processing, the Settlement 
Instruction state will change to Settled and the Holdings and/or Cash 
Records of both the buyer and seller will be updated (for FX, FRAS, 
RBA Repos and SWAPS the cash records will be updated with the net 
settlement amounts). The settle status in the DVP Information screen 
will then be updated to Completed.   

 When Cash Limits testing is not yet complete, a state of Waiting in 
Queue will be displayed as the last state in the State History screen 

 When RTGS processing is not yet complete,  a state of Payment 
Pending will be displayed as the last state in the State History screen 

 To settle a Trade manually, set the Cash Record priority to Deferred in 
order to prevent the system from automatically processing the 
transaction.  

 Trades entered against a Cash Record in a Deferred state will not 
progress to the settlement queue until the priority is changed to Priority 
or Active.  

 
 
 
CASH 

 When a Cash Trade is Matched, the system will automatically create a 
DVP instruction with a settle status of Accepted and a Settlement 
Instruction with a state of Matched in preparation for settlement.  

 

FRA 

 FRA’s are bilaterally netted for settlement and as such the system will 
create one Settlement Instruction and one Settlement Obligation per 
counterparty, which will correspond to a number of FRA transactions.  



        

 Austraclear System Participant User Guide 

          149  

 The settlement run for FRA’s is completed at 12 noon on a daily basis, 
after SFE enters the BBSW rates. 

 

Process Steps 

To view Market Reference Rate values 

1. Select Trades ► View Fixing Values from the Main Menu. 

2. Specify search criteria and click Search to view the BBSW 
rates entered for the current day. 

 

 

 

FX 

 On the settlement day, provided an FX transaction is Matched, the 
system will automatically create Settlement Instructions with a state of 
Matched and Settlement Obligations with a state of Ready to Settle for 
the AUD leg of a transaction to indicate that the transaction has been 
accepted for settlement and is undergoing Cash Limit testing 

 FX transactions are bilaterally netted for settlement and as such the 
system will create one Settlement Instruction and one Settlement 

Obligation per counterparty, which will correspond to a number of FX 
transactions  

 Once the netting process is complete, participants will be required to 
confirm the DVP instructions resulting from the netting before the 
trades can proceed to settlement. 

 

Process Steps 

To confirm/authorise the DVP Instruction of netted FX Trades 

1. Select Settlement ► View Settlements ► DVP Instructions. 

2. Specify search criteria and click search to view all FX Trades to 
which you are a party or proxy. 

3. Two DVP instructions will be displayed per FX trade. Highlight your 
sub participant’s trade and from the right click menu select 
Confirm DVP, enter a cash record and click send. 

4. Both counterparties to the trade must confirm a domestic currency 
DVP instruction before it can progress to the RTGS queue. 

5. If authorisation is required confirmed DVP Instructions must be 
authorised by a user other than the user who confirmed it. 

6. To authorise select ► Settlement ► View Settlements ► DVP 
Instructions. 

7. Specify search criteria and click search to view all FX Trades to 
which you are a party or proxy. 

8. Two DVP instructions will be displayed per FX trade. Highlight your 
sub participant’s trade and from the right click menu select 
Authorise DVP to view the Holding Authorisation screen. 

9. Right click to View Authorisations and select Authorise or 
Reject. 
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SWAPS 

 Swaps are bilaterally netted for settlement and as such the system will 
create one Settlement Instruction and one Settlement Obligation per 
counterparty, which will correspond to a number of Swap transactions.  

 The settlement run for Swaps is completed at 11am on a daily basis, 
after SFE enters the BBSW rates. 

  

Process Steps 

To view Market Reference Rate values 

1. Select Trades ► View Fixing Values from the Main Menu. 

2. Specify search criteria and click Search to view the BBSW rates 
entered for the current day. 
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12. Queue Management 

 

Definition 

The ability to change the priority of Cash Records and Sub Accounts of 
transactions in the settlement queue. 

 

Function 

Manage queue priority 

 

Information 

This is a generic function for all products – Cash, DSS, FIS, FRA’s, FX, 
Market Repos, RBA Repos, OCH Margins, SFE Margins and SWAPS. 

 

Navigation Steps 

► Settlement ► Manage Queue Priority  

 

Process Steps 

1. Follow navigation steps above to display the ‘Manage Queue 
Priority’ screen. 

2. Specify search criteria and click Search to view all transactions 
waiting in the queue. 

3. Highlight the transaction to be changed and from the right click 
menu select Set Priorities to change either the cash record 
priority or the sub account priority. 

4. Refer to the Glossary for further details on the fields 

 

 

 

 

 

 

System Rules 

 Sub Accounts and Cash Records can be assigned one of the 
following priorities: 

o Priority 
o Active 
o Deferred 

 Priority is the highest level status given to Sub Accounts and 
Cash Records on the queue.  

 Active is the status given to Sub Accounts and Cash Records 
with medium priority. Transactions linked to Sub Accounts/Cash 
Records with a medium priority will be processed when there are 
no Priority transactions on the queue. 

 Deferred is given to Sub Accounts and Cash Records when 
settlement is to be deferred. Transactions linked to Sub 
Accounts/Cash Records in a Deferred status will not proceed to 
Cash Limit Testing or the RTGS queue.  

 Before each transaction can be processed, the Sub Accounts 
and Cash Records will require a Priority or Active status. 
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Glossary – Queue Priority 

 

Field Names Description 
Settlement 
Obligation No 

A sequence number set by the system, identifying the obligation.  

Sub Account 
Priority 

Indicates the priority the instruction of the delivery of securities has relative to other instructions.  
One of the following: Priority, Active or Deferred. 

Cash Priority Indicates the priority the instruction of the delivery of payments has relative to other instructions.  
One of the following: Priority, Active or Deferred. 

Security Locked In A flag indicating if the securities have been locked-in.  

Cash Locked In A flag indicating if the cash has been locked-in.  

Series The series code. 

ISIN A unique identification of securities. Stands for International securities identification numbering system.  

Volume The size of the delivery. It cannot be negative.  

Payment Amount The size of the payment. It cannot be negative.  

Currency The currency in which the payment will be done.  

Settlement Date The date that the obligation will be settled.  
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13. Recall a Trade 

 

Definition 

The ability to recall a trade from the RTGS queue. 

 

Function 

Recall a Trade 

 

Information 

This is a generic function for all products – Cash, DSS, FIS, FRA’s, FX, 
Market Repos, RBA Repos, OCH Margins, SFE Margins and SWAPS. 

Only Trades with Settlement Instructions in a state of Payment Pending 
can be recalled from the RTGS queue.  

 

Navigation Steps 

► Settlement ► View Settlements ► Settlement Instructions  

 

Process Steps 

1. Follow navigation steps above to display the ‘Settlement 
Instructions’ screen. 

2. Specify search criteria and click Search to view all Trades 
settling today. 

3. Highlight the transaction to be recalled and from the right click 
menu select Recall to request that the transaction be removed 
from the queue. 
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14. Terminate a Swap Trade 

 

Definition 

The ability to terminate a SWAP trade. 

 

Function 

Terminate a Swap Trade. 

 

Information 

Swap transactions in a Matched state may be either partially or fully 
terminated.   Either counterparty may initiate the termination, but both 
counterparties must enter their side of a termination.  

When terminating a swap the entry of the following fields is optional:- 
 Termination Payer 
 Termination Payment Date  
 Termination Payment Amount 

Payment flows will continue to settle on swaps in a Terminated state until 
the Termination Agree Date is reached. 

If a partial termination is entered the notional amount and any future 
payment flows relating to the swap will be reduced by the amount of the 
termination notional amount.  

Swaps that are pending termination will appear in the Reported Trades 
window in a state of Matched with a sub state of Pending Termination. 

 

Navigation Steps 

► Trades ► View Reported Trades  

 

 

 

 

 

 

 

 

Process Steps 

1. Follow navigation steps above to display the ‘Reported Trades’ 
screen. 

2. Specify search criteria and click Search to view all Swap 
transactions to which you are a party. 

3. Highlight the transaction to be terminated and from the right 
click menu select Terminate Swap. 

4. Enter the Termination details and click Send.   Refer to the 
Glossary for further details on the fields 

 



        

 Austraclear System Participant User Guide 

          157  

 

 

 

 

Function 

View a Swap Pending Termination 

 

Navigation Steps 

► Trades ► View Reported Trades  

 

Process Steps 

1. Follow navigation steps above to display the ‘Reported Trades’ 
screen. 

2. Specify search criteria and click Search to view all Swap 
transactions to which you are a party. 

3. Highlight the transaction to view and from the right click menu 
select Swap Terminations. 

 

Function 

View Swap Terminations 

 

Navigation Steps 

► Trades ► View Swap Terminations  

 

Process Steps 

1. Follow navigation steps above to display the ‘Swap Terminations’ 
screen. 

2. Specify search criteria and click Search to view all Swaps that 
are Pending Termination or have been Terminated. 

3. Highlight the transaction to view and right click to view 
Properties, Show Reported Trade and Swap Termination 
History. 

 

 

 

 

Function 

Authorise Pending Swap Terminations 

 

Navigation Steps 
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► Trades ► View Swap Terminations  

 

Process Steps 

1. Follow navigation steps above to display the ‘Swap Terminations’ 
screen. 

2. Specify search criteria and click Search to view all Swaps that 
are Pending Termination. 

3. Highlight the transaction and right click to Authorise. 
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Glossary – Terminations 

 

Field 
Names 

Description 

Trade rpt nbr Trade report number. 
Automatically displayed identification of the original trade that the termination is based on. 

Full 
termination 

Select full or partial termination: 

Yes when selected the entire notional amount will be terminated and the Notional amount field will be frozen. 

No when selected a part of the notional amount will be terminated and the Notional amount field will be open. 
 

Notional mat Notional amount. 
An amount to use as basis for calculations of payments. The notional amount will never be exchanged between the parties, only 
used for calculations. 
If Full termination is No this field is open for editing. 
Specify a notional amount less than the original amount. 

Agree date Agreement date. 
Default is current business date 
Select a termination agreement date. 

Payer Select the agreed payer of the termination. 

Payment 
date 

Select date when the termination payment will be calculated.  

Payment amt Specify the agreed termination payment amount. 

Currency Automatically displayed currency for the termination payment. 

Information Enter termination information, free text 
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15. Split a Trade 

 

Definition 

The ability to split a trade. 

 

Function 

Split a Trade 

 

Information 

This function is performed for DSS, FIS and Market Repos. 

Trade splits can be initiated by either counterparty to a trade, but must be 
confirmed before the split can proceed to settlement. 

The settle status for the original DVP must be Pending or Accepted 
otherwise the request is rejected.   The current date must be settlement 
date. 

. 

Navigation Steps 

► Trades ► View Reported Trades  

 

Process Steps 

1. Follow navigation steps above to display the ‘Reported Trades’ 
screen. 

2. Specify search criteria and click Search to view all Trades to 
which you are a party or proxy. 

3. Highlight the transaction to be split and from the right click menu 
select Rectify DVP. 

4. The Rectify DVP screen will be displayed with the following 
fields to be rectified for the split of the DSS trade: 

- First New Quantity 

5. Enter the value of the first split and the system will calculate the 
consideration and the split value.  

 

6. Select Send to commit the split trade. 

7. The Sub Settle Status will now show as Holding. 

8. Once the counterparty confirms the split the Sub Settle Status 
will show as Pending Split. 

 Note: The trade split cannot be cancelled by cancelling the trade 
or the DVP however the Settlement Instruction can be cancelled which 
achieves the same result (i.e. trade will not settle). 
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Function 

Authorise a Trade Split 

 

Information 

This function is performed for DSS, FIS and Market Repos. 

Trade splits can be initiated by either counterparty to a trade, but must be 
confirmed before the split can proceed to settlement 

 

Navigation Steps 

► Administration ► Authorisations ► Holding Authorisations 

 

Process Steps 

1. Follow navigation steps above to display the ‘Holding 
Authorisations’ screen. 

2. Specify search criteria and click Search to view all Trade split 
transaction awaiting authorisation. 

3. Highlight the transaction to be authorised and from the right 
click menu select View Authorisation to view the trade split 
details. 

4. Check the details and select Authorise to authorise or Reject to 
reject the trade split 

 

 

 

 

 

 

 

 

 

 

 

Function 

Confirm/Reject a Trade Split 

 

Information 

This function is performed for DSS, FIS and Market Repos. 

Trade splits can be initiated by either counterparty to a trade, but must be 
confirmed before the split can proceed to settlement 

 

Navigation Steps 

► Settlements ► View Holding Rectify DVP  

 

Process Steps 

1. Follow navigation steps above to display the ‘Holding Rectify 
DVP’ screen. 

2. Specify search criteria and click Search to view all Trade split 
transaction awaiting confirmation. 

3. To Confirm - Highlight the transaction to be confirmed and from 
the right click menu select Confirm DVP to confirm the split. 

4. To Reject – Highlight the transaction to be rejected and from the 
right click menu select Reject DVP to reject the split. 

5. Click OK. 
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16. Renegotiate/Unwind a Market Repo 
Trade 

 

Definition 

The ability to renegotiate or unwind a Market Repo trade. 

 

Function 

Renegotiate/Unwind a Market Repo Trade 

 

Information 
This function is performed for Market Repos only.   Renegotiations can 
be effective for both same day and next day.   All Fixed Term, Intraday 
and At Call repos can be renegotiated.   The 2nd leg of a repo cannot be 
renegotiated until the 1st leg is settled. 
Both partial and full unwinds are permitted on repo transactions.   Repos 
will not automatically be unwound on 2nd transaction date. All unwinds 
must be initiated by participants and either the buyer or the seller may 
initiate the unwind.   An unwind may only be initiated for the current or 
next settlement day. 

 

Navigation Steps 

► Trades ► View Reported Trades  

 

Process Steps 

1. Follow navigation steps above to display the ‘Reported Trades’ 
screen. 

2. Specify search criteria and click Search to view all Trades to 
which you are a party. 

3. To Renegotiate - Highlight the transaction to be renegotiated 
and from the right click menu select Renegotiate Trade Report 
and click OK. 

4. To Unwind - Highlight the transaction to be unwound and from 
the right click menu select Unwind Trade Report and click OK. 

5. Enter the value of the first split, click Calc Unwind and the 
system will calculate the consideration and the split value.  

6. Refer to the Glossary for further details on the fields. 

7. Select Send to commit the split trade. 

 

Function 

Authorise a Renegotiation/Unwind on a Market Repo Trade 

 

Information 

A User cannot Authorise a transaction that has been entered by that 
same user. An alternate User must authorise those transactions 

 

Navigation Steps 

► Trades ► View Repo Renegs/Unwinds  

 

Process Steps 

1. Follow navigation steps above to display the ‘Reported Trades’ 
screen. 

2. Specify search criteria and click Search to view all Trades to 
which you are a party. 

3. Highlight the transaction to be authorised and from the right 
click menu select Authorise Renegotiation/Unwind and click 
OK. 
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Glossary – Renegs/Unwinds 

 

Field 
Names 

Description 

Renegotiation Fields 
1st Trans 
date 

1st transaction date, date for delivery/settlement set for the 1st leg displayed only.  

2nd Trans 
date 

2nd transaction date, date for delivery/settlement set for the 2nd leg when the deal is generated.  
The date must be a valid settlement date according to CDB and the date must not exceed the maturity date of the traded 
instrument series. 
Enter a date equal to or later than the 1st transaction date. Default = <blank>. . 
If a value is entered the number of days are automatically calculated and displayed. 
Attention - The system determines the Repo type by validating the entered value. The type will be assigned to the Repo item. 
Repo type options: 

Fixed term if the 2nd transaction date is later than the 1st 

Intraday if the 2nd transaction date is equal to the 1st 

At call if the 2nd transaction date is <blank> 
 

Cash rate Enter a new cash rate for the Repo trade within 0 to 100. 
The entered number of decimals must be the same as in the default value 0.00 displayed in the field. 

Settlement 
instruction 

Enter free text for the sell side, manually describing settlement instead of using the SSI max. 120 characters, opened for editing if 
SSI = No and Payment settle = No. 

Effective 
date 

Date and time for the transaction to be executed. 
Enter a date, current business date or next, not later than settlement date.. 

Unwind Fields 
Face value Face value; the value of a bond, note or other security as printed on the document; throughout the lifetime of a security its market 

price will fluctuate but at maturity date the face value is payable. 
Enter a new face value. . When entering the value, the following abbreviations are available: 

K for thousand 

T for thousand 

M for million 

The entered number of decimals must be the same as in the default value 0.00 displayed in the field. 
The maximum value is configurable up to 10 billions. 
Example: 12.5M is equal to 12,500,000.00 

SSI Select one of the Yes | No radio buttons. Default = Yes. 

https://exigotc.austraclear.com.au/exigoonlinehelp/00secur/rea/rea_app_sec.xml#dat
https://exigotc.austraclear.com.au/exigoonlinehelp/00secur/rea/rea_app_sec.xml#ent
https://exigotc.austraclear.com.au/exigoonlinehelp/00secur/rea/rea_app_sec.xml#dat
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Field 
Names 

Description 

If a Standard Settlement Instruction (SSI) is defined for the Sub participant and instrument (Participant → SSI) the parties have 
the option to use or not to use it for a certain trade. 

Yes the SSI is used and sub account and cash record are retrieved from the SSI item 

No sub account and cash record must be specified manually below 
 

Sub account If SSI Yes is selected, the sub account value is automatically specified otherwise specify the code, up to 24 characters: 
Or select it from the scroll list. The scroll list contains cash records dedicated to the participant specified in the Account field. 

Cash record If SSI Yes is selected, the cash record value is automatically specified otherwise specify the code, up to 24 characters: 
Or select it from the scroll list. The scroll list contains cash records dedicated to the participant specified in the Account field. 

Unwind 
consideration 

Consideration /settlement amount for the 2nd leg, is calculated by the system when Calculate Unwind Consideration button is 
selected according to the following Repo type calculation options: 

Fixed term a value is calculated based on the number of days between the 1st and 2nd transaction dates 

Intraday a value must be entered by the user 

At call a value is calculated assuming that the Repo will unwind the next business date 
 

Effective 
date 

Date and time for the transaction to be executed. 
Enter a date, current business date or next, not later than settlement date.. 

 
 
 

https://exigotc.austraclear.com.au/exigoonlinehelp/00secur/rea/rea_app_sec.xml#dat
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17. Pledge a Holding 
 

Definition 

The ability to pledge a holding. 

 

Function 

Enter a Pledge for DSS/FIS Holding/Authorise a Pledge 

 

Information 

The Create Pledge screen enables participants to use securities from 
their FIS/DSS Holdings as security for a secured loan to be settled via 
Austraclear. 

Pledge transactions must be initiated by the Pledgor, who must hold 
the securities in their Holdings.  

Securities held in any sub account may be used for a Pledge. 

Pledges may be entered against receipt of a payment amount or free of 
payment ie no payment received for the pledge.  

 

Navigation Steps 

► Holdings ► View Holdings  

 

Process Steps 

1. Follow navigation steps above to display the ‘Holdings’ screen. 

2. Specify search criteria and click Search.   Holdings will be 
displayed according to the search criteria. 

3. Select the Holding from list, right click and select Create Pledge 
from Holding. 

4. Enter Pledgee details, Volume and Payment Instructions if 
applicable. If entering a pledge free of payment, right click in the 
Payment Instruction field and select Delete to delete the row.  
Click OK. Refer to the Glossary for further details on the fields. 

5. If the Pledgor requires authorisation, this must be completed 
before the Pledgee will be able to accept the Pledge. 

6. To Authorise – Select Trades ► View Pledges and select 
Pending from the View dropdown box. 

7. Select the Pledge from list, right click and select Authorise. 

8. Check the details and click OK to authorise.   Authorisation must 
be carried out by a user other than the user who entered the 
transaction. 

It is also possible to create a pledge via the trades menu. If this option is 
used information about the relevant holdings will need to be input. Also 
note that in both options, fields in the ‘Pledges’ and ‘Payment 
Instructions’ are not marked as mandatory. 
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Function 

Accept/Reject a Pledge 

 

Navigation Steps 

► Trades ► View Pledges  

 

Process Steps 

1. Follow navigation steps above to display the ‘Pledges’ screen. 

2. A View dropdown box will be displayed with available search 
criteria of Active, Pending and Historical. 

3. In the Pending View select Accept/Reject from the right click 
menu to accept/reject a pledge. Enter your cash record and 
select Accept or Reject. 

4. If the Pledgor requires authorisation, this must be completed 
before the Pledgee will be able to accept the transaction. 

5. To Authorise – Select Trades ► View Pledges and select 
Pending from the View dropdown box. 

6. Select the Pledge from list, right click and select Authorise. 

7. Check the details and click OK to authorise. 

8. Authorisation must be carried out by a user other than the user 
who entered the transaction. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



        

 Austraclear System Participant User Guide 

          171  
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Function 

Release a Pledge/Authorise Release 

 

Information 

The Release Pledge screen enables participants to release securities 
used for a secured loan when the loan is repaid. 

Pledges may be entered as Free of Payment or Delivery versus 
Payment. 

Release Pledge transactions must be initiated by the participant (Pledgor) 
who entered the original Pledge, with the securities not being released 
until the other participant (Pledgee) has confirmed the release pledge. 

 

Navigation Steps 

► Trades ► View Pledges  

 

Process Steps 

1. Follow navigation steps above to display the ‘Pledges’ screen. 

2. A View dropdown box will be displayed with available search 
criteria of Active, Pending and Historical. 

3. In the Active View select Release from the right click menu.   
The system will display the Release Pledge screen. 

4. Enter the release details and click OK. 

5. If the Pledgor requires authorisation, this must be completed 
before the Pledgee will be able to accept the transaction. 

6. To Authorise – Select Trades ► View Pledges and select 
Pending from the View dropdown box. 

7. Select the Pledge from list, right click and select Authorise. 

8. Check the details and click OK to authorise. 

9. Authorisation must be carried out by a user other than the user 
who entered the transaction. 
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Function 

Accept/Reject a Released Pledge (Pledgee) 

 

Navigation Steps 

► Trades ► View Pledges  

 

Process Steps 

1. Follow navigation steps above to display the ‘Pledges’ screen. 

2. A View dropdown box will be displayed with available search 
criteria of Active, Pending and Historical. 

3. In the Pending View select Accept/Reject from the right click 
menu.   The system will display the Release Pledge screen.  

4. Select Accept to accept the release pledge transaction or Reject 
to reject the release pledge. 

5. If the Pledgor requires authorisation, this must be completed 
before the Pledgee will be able to accept the transaction. 
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Function 

Substitute a Pledge/Authorise Substitute 

 

Information 

The Substitute Pledge screen enables participants to substitute 
securities used for a secured loan for alternate securities, without 
repaying the loan.  

Substitute pledges may only be entered as Free of Payment. 

Substitute Pledge transactions must be initiated by the participant who 
entered the original Pledge, with the securities not being substituted until 
the other participant has confirmed the substitute pledge 

 

Navigation Steps 

► Trades ► View Pledges  

 

Process Steps 

1. Follow navigation steps above to display the ‘Pledges’ screen. 

2. A View dropdown box will be displayed with available search 
criteria of Active, Pending and Historical. 

3. In the Active View select Substitute from the right click menu.   
The system will display the Substitute Pledge screen.  

4. Enter the substitute details by typing over the original series in 
the series field and then click OK. 

5. If the Pledgor requires authorisation, this must be completed 
before the Pledgee will be able to accept the transaction. 

6. To Authorise – Select Trades ► View Pledges and select 
Pending from the View dropdown box. 

7. Select the Pledge from list, right click and select Authorise. 

8. Check the details and click OK to authorise. 

9. Authorisation must be carried out by a user other than the user 
who entered the transaction. 

 

 

 

 
 

Function 

Accept/Reject a Substitute Pledge 

 

Navigation Steps 

► Trades ► View Pledges  

 

Process Steps 

1. Follow navigation steps above to display the ‘Pledges’ screen. 

2. A View dropdown box will be displayed with available search 
criteria of Active, Pending and Historical. 

3. In the Pending View select Accept/Reject from the right click 
menu.   The system will display the Substitute Pledge screen.  

4. Select Accept to accept the substitute pledge transaction or 
Reject to reject the substitute pledge. 
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Glossary – Pledges 

 

Field Names Description 
Public Settlement Details 
Pledgor The borrower.  

Pledgee The lender.  

Settlement Date The date and time the settlement is carried out.  

Pledgee Reference xxx.  

Rate/Public 
Comments 

Informative free-text description of the pledge.  

Internal Settlement Details 
Override Sub 
Account Priority 

Overrides the priority the instruction of the delivery of securities has over other instructions.  
One of the following: Priority, Active or Deferred. 

Override Cash 
Record Priority 

Overrides the priority the instruction of the delivery of payments has over other instructions.  
One of the following: Priority, Active or Deferred. 

Sub Participant 
Reference 

Optional reference to other internal systems. Set by the sub participant.  

Internal Comments Free-text field.  

Pledges 
+/- Specify that the involved sub account should be debited (-).  

Series Security pledged as collateral.  

Series Description Short description of the series.  

Volume The size of the delivery. It cannot be negative.  

Full Name Issuer The name of the issuer of the series.  

Sub Account Sub Account where securities are encumbered.  

Priority The priority of the collateral.  

Payment Instruction 
+/- Specify whether the involved cash record should be debited (-) or credited (+).  

Amount The size of the payment..  

Currency Identifies the currency that is valid.  

Cash Record The cash record to be debited or credited.  

Priority The priority of the payment instruction 
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18. Transfer a Holding 
 

Definition 

The ability to transfer a holding. 

 

Function 

Transfer a DSS/FIS Holding 

 

Information 

Participants may transfer holdings to either another of their sub 
participants or to another existing sub account. 

 

Navigation Steps 

► Holdings ► View Holdings  

 

Process Steps 

1. Follow navigation steps above to display the ‘Holdings’ screen. 

2. Specify search criteria as required and click Search.   Holdings 
will be displayed according to the search criteria. 

3. Select the Holding to be transferred, right click and select 
Transfer Holding.   The system will display the Transfer 
Holding screen. 

4. Enter transfer details and click OK. 

 

 

 

 

 

 

 

 

 

 

Function 

Authorise Transfer of a DSS/FIS Holding 

 

Information 

A User cannot authorise a trade that has been entered by that same 
user. An alternate User must authorise those trades. 

 

Navigation Steps 

► Settlements ► View Settlements ► Settlement Instructions 

 

Process Steps 

1. Follow navigation steps above to display the ‘Settlement 
Instructions’ screen. 

2. Specify search criteria as required and click Search to view the 
settlement instructions of all FIS or DSS transfers settling today. 

3. Select the Holding to be transferred, right click and select 
Authorise.    

4. Check details and click OK. 
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19. Corporate Actions (For Issuers) 
 

Definition 

The ability to view, instruct and monitor Corporate Actions relating to DSS 
and FIS Securities. 

 

Function 

View and confirm DSS Maturity/FIS Coupon, Redemption and Maturity 
Corporate Actions 

 

Information 

Corporate Actions for Discount Securities consist of Maturity payments 
only. Corporate Actions for Fixed Income Securities consist of Coupon, 
Redemption and Maturity payments. 

Maturity and Coupon corporate actions are generated automatically by 
the system in the overnight recurring tasks, while Redemption corporate 
actions are generated manually by SFE Austraclear after entry of the 
partial redemption values and interest and principal PPH. 

The ability to View Holder List on Corporate Actions is restricted to 
Issuer Representatives only. 

Discount Security Instruments and Fixed Income Security Series that 
have matured will be displayed in the View Series screen until such time 
as they are deleted from the system by the CSD Administrator. 

Corporate Actions can be viewed and confirmed (instructed) via all of the 
following screens: 

 

 Series >> View Corporate Actions 
All summary Corporate Actions are displayed in this screen once they 
have been created, 5 business days prior to Booksclose (record date) 
 

 Settlement >> View Settlements >> Corporate Action  
Settlement Instructions 

All Corporate Action Settlement Instructions are displayed in this 
screen once they have been created (after Booksclose (record date).   
This will consist of one gross Corporate Action Settlement Instruction 
for each series, representing the total payment amount for that series 
and a number of underlying Corporate Action Settlement Instructions, 
representing the individual coupon, redemption and maturity payment 
amounts to each Holder.   
 
 Administration >> Monitor >> Corporate Action Execution 

The Monitor Corporate Action Execution screen is available to 
Issuer Representatives only.  This screen provides a summary of all 
Corporate Actions for the current business day for that Issuer and 
shows the current settlement state for each Corporate Action. 

 

Navigation Steps 

► Series ► View Corporate Actions  

 

Process Steps 

1. Follow navigation steps above to display the ‘Corporate Action’ 
screen. 

2. Specify search criteria as required and click Search to display 
current Corporate Actions. The Corporate Actions displayed for 
DSS will be for Maturities and for FIS will be for Coupon 
Payments, Redemptions and Maturities. 

3. To view the Holder List, right click and select View Holder List. 

4. To view the details of an individual Corporate Action, right click 
and select Properties. 

5. To confirm (instruct) right click and select view Corporate 
Action Settlement Instructions   

6. Refer to Glossary for further details on fields. 

 

Information 

The View Corporate Actions screen will display planned Corporate 
Actions for all Issuer Representatives.  To view only the Corporate 
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Actions where you are the Issuer Representative, enter your Issuer 
Representative code in the relevant search criteria field. 

The system will prevent you from viewing the Holder Lists and Corporate 
Action Settlement Instructions of other Corporate Actions. The Holder 
Lists will be available for viewing after Booksclose (record date). 

Corporate Action Settlement Instructions will be available to confirm 
(instruct) after Booksclose (record date) ie on the settlement date. 

All “Active” Corporate Actions automatically change to a state of 

“Inactive” on the settlement date. Therefore, to view your Corporate 
Actions via this screen on the settlement date, select “Inactive” in the 
“State” search criteria field before you click search.    

 

Navigation Steps 

► Settlements ► View Settlements ► Corporate Action Settlement 
Instructions 

 

Process Steps 

1. Follow navigation steps above to display the ‘Corporate Action 
Settlement Instructions’ screen. 

2. Specify search criteria as required and click Search to display 
current Corporate Action Settlement Instructions.    

3. To confirm a Corporate Action, right click and select Instruct 
Underlying Obligation. 

4. To view the details of an individual Corporate Action, right click 
and select Properties. 

 

 

 

 

Information 

 
The system will create one gross Corporate Action Settlement 
Instruction per series for Issuer Representatives to confirm (instruct). 
 
To view only the Corporate Action Settlement Instructions waiting to 
be confirmed on the settlement day, select “Corporate Action” in the 
Operation Type search criteria field. 
 
The system will also create underlying Corporate Action Settlement 
Instructions for the individual Maturity, Coupon and Redemption 
payments to each Holder. 
 
For each Coupon Corporate Action, the system will display two 
settlement instructions. The first instruction will display a credit (+) 
payment amount to the Holder and the second instruction will display 
a debit (-) payment amount to the Issuer Representative. 
For each Maturity Corporate Action, the system will display four 
settlement instructions. The first set of instructions relate to the 
removal of the securities from the Holders portfolio while the second 
set of instructions display a credit (+) payment amount to the Holder 
and a debit (-) payment amount to the Issuer Representative.  
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To view the underlying payment instructions to each Holder, select 
“Maturity”, “Coupon” or “Redemption” in the Operation Type search 
criteria field. 
 
On confirmation, the state of the gross Corporate Action Instruction 
will change to Completed and the state of the individual underlying 
instructions will change to Settled. 
 
All Coupon, Maturity and Redemption proceeds are payable on an 
Irrevocable (I) settlement basis only. 

 

 

 

 

 

 
 

 

 

 

 

 

 

 

 

 

 

Navigation Steps 

► Administration ► Monitor ► Corporate Action Execution 

 

Process Steps 

1. Follow navigation steps above to display the ‘Monitor Corporate 
Action Execution’ screen. 

2. Specify search criteria as required and click Search to display 
execution states.    

3. Issuer Representatives may Instruct (Confirm) their Corporate 
Action payments from this screen via a right click action to view 
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the Corporate Action Settlement Instructions.   This will take 
you to the ‘Corporate Action Settlement Instructions’ screen 
where you can then follow the process steps opposite. 

 

Information 

The Monitor Corporate Action Execution screen is available to Issuer 
Representatives only. 

This screen provides a summary of all Corporate Actions for the current 
business day for that Issuer Representative and shows the current 
settlement state for each Corporate Action.  
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The following table defines the settlement states displayed in this screen: 

 

 

 

 

 

 

Definition 

The ability to view, download and print reports for Corporate Actions 
relating to DSS and FIS Securities. 

 

Function 

View, download and print reports for DSS Maturity/FIS Coupon, 
Redemption and Maturity Corporate Actions 

 

Information 

 
The following reports will be available at the start of each business day 
as a result of overnight processing: for Issuers of Discount 
Securities: 

Place Payable Maturity Report 
Issuer Representative’s Holding Report 
Issuer Representative’s Turnover Report 
Issuer Representative’s DSS Maturities Payments Report 
 

The Place Payable Maturity Report displays details on the Maturity date 
of all maturing immobilised DSS securities payable on the day. The 
format of this report is PDF only. 

The Issuer Representative’s Holding Report lists all sub participants 
who hold a particular Issuers securities and how much of that security 
they hold. The format of this report is PDF only. 

The Issuer Representative’s Turnover Report lists all completed trades 
involving a particular Issuer’s securities. The format of this report is PDF 
only. 

The Issuer Representative’s DSS Maturities Payments Report details 
all DSS securities which are due to mature on the current business day 
and who the beneficial owner of those securities are, including the 
maturity amount that will be paid. The format of this report is PDF and 
CSV. 

 

Planned  

5 

Equal to Automatic Days. The number of days prior to Booksclose 
(record date) the system creates the summary corporate action 

Holder List Created  Holder List is created for the corporate action on record date 

Settlement Instruction 
Created 

  

Settlement Instructions are created after record date 

Preparing for Settlement  Settlement Instructions are waiting to be confirmed (instructed) on the 
settlement day 

Currently Executing  Settlement Instructions have been confirmed (instructed) but are 
waiting for RTGS processing 

Successfully Executed  Settlement Instructions have successfully settled 

Failed  Settlement Instructions have failed to settle or were not confirmed 
(instructed) 



        

 Austraclear System Participant User Guide 

          185  

 

The following reports will be available at the start of each business day as 
a result of overnight processing for Issuers of Fixed Income Securities: 

Issuer Representative’s Holding Report 
Issuer Representative’s Turnover Report 
Issuer Representative’s Record Date Report 
Issuer Representative’s 1

st
 Run FIS Payments Report 

Issuer Representatives’ 2
nd

 Run FIS Payments Report 
 

The Issuer Representative’s Holding Report lists all sub participants 
who hold a particular Issuer’s securities and how much of that security 
they hold. The format of this report is PDF only. 

The Issuer Representative’s Turnover Report lists all completed trades 
involving a particular Issuer’s securities. The format of this report is PDF 
only. 

The Issuer Representative’s Record Date Report lists all participants 
who hold a particular Issuer’s securities at record date and how much 
income is due. The format of this report is PDF only. 

The Issuer 1
st

 Run FIS Payments Report details for Issuer 
representatives who they will be paying coupon and maturity payments to 
for the current business day. The format of this report is PDF and CSV. 

The Issuer Representative’s 2
nd

 Run FIS Payments Report details for 
Issuer Representatives who they will be paying coupon, maturity and 
redemption payments to for the current business day.  This report will be 
available after 2:00pm daily. The format of this report is PDF and CSV. 

 

Navigation Steps 

► View ► Reports ►Explore 

 

 

Process Steps 

1. Follow navigation steps above to display the ‘Reports’ screen. 

2. Specify search criteria as required and click Search to display 
reports available for the current business day.    

3. Select a report and right click to Download, then right click to 
Preview and/or Print 
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128F Exempt (for Fixed Income Securities only) 

 

Definition 

The 128F exempt attribute provides Issuers with the functionality to certify that interest paid on fixed income securities that are held in Austraclear is 128F 
exempt from interest withholding tax under section 128F of the Income Tax Assessment Act. The attribute is mandatory and can be set to Yes, No or Unknown. 
The default will be set to ‘Unknown’ for all fixed income securities and can be amended by sending a request to ASX Corporate Actions and Depositary at 
CAD@asx.com.au  

 

Austraclear Reports affected by 128F 
 
The following Austraclear reports have been enhanced to include an additional column titled ‘128F Exempt’ which includes the series 128F exempt information: 
Yes, No or Unknown. Series without any128F exempt information will contain a ‘hyphen’ in the reports. 
 
The new column will be added as the last column in the following reports: 

Holding Report (PDF and CSV) 

Collateral Holding Report (PDF and CSV) 

Issuer Representatives’ Collateral Holding Report 

Issuer Representatives’ Holding Report 

Issuer Representatives’1st Run FIS Payments Report (PDF and CSV) 

Issuer Representatives’ 2nd Run FIS Payments Report (PDF and CSV) 

Issuer Representatives Record Date Report 

Income Receivable Report (PDF and CSV) 

Securities Detail Report (PDF and CSV) 
 
The new column is placed before the collateral indicator in the following reports to ensure the first 13 columns are the same in both versions of this report. 

Issuer Representatives’1st Run FIS Payments Collateral Report (CSV) 

Issuer Representatives’ 2nd Run FIS Payments Collateral Report (CSV) 

Income Receivable Collateral Report (CSV) 
 
Changes in Series Properties 
The new ‘128F Exempt’ attribute has been added after Series sub class in the Identifiers & Classifications group. 
The ‘128F Exempt’ attribute can be set to Yes, No or Unknown. If the ‘128F Exempt’ attribute is not set on the Series, the attribute value will be blank. 
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Changes in View Series, View Holdings and View Corporate Action Settlement Instructions 
A new column has been added to the View Series, View Holdings and View Corporate Action Settlement Instructions dialogue window. The new column will be 
named ‘128F Exempt’ and include the 128F information set on the Series. 
The 128F value will be blank if the ‘128F Exempt’ attribute is not set on the Series. 
The column ‘128F Exempt’ will be added as the last displayed attribute in the grid. 
Note that the ‘128F Exempt’ value will not be visible in Properties for a Settlement Instruction. 
 

 
 
Changes in View Corporate Action 
A new column has been added to the View Corporate Action dialogue. The new column been named ‘128F 
Exempt’ and include the 128F information set on the Corporate Action (Series). 
The 128F Exempt value will be blank if the ‘128F Exempt’ attribute is not set on the Series. 
The column ‘128F Exempt’ has been added as the last displayed attribute in the grid. 
 
Changes in Corporate Action Properties 
A new attribute is added to the Corporate Action Properties dialogue. 
The new attribute has been named ‘128F Exempt’ and include the 128F Exempt information set on the Series specified in the Corporate Action. 
The 128F Exempt value will be blank if the ‘128F Exempt’ attribute is not set on the Series. 
The Series 128F Exempt information is displayed as read only. 
The new attribute has been added between the fields Issuer Representative and Complete. 
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Changes in View Corporate Action Settlement Instructions 
A new column has been added to the View Corporate Action Settlement Instruction dialogue. The new column will be named ‘128F Exempt’ and include the 
128F information set on the Corporate Action object (Series). 
The 128F Exempt value will be blank if the ‘128F Exempt’ attribute is not set on the Series. 
The column ‘128F Exempt’ will be added as the last displayed attribute in the grid. 
Note that the ‘128F Exempt’ value will not be visible in Properties for a Settlement Instruction. 
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SWIFT Message Changes 
The following SWIFT messages have been updated to include the Series 128F Exempt information. The SWIFT message format is published in the ASX 
SWIFT Message Protocol document located at the following link: 
 
https://www.asxonline.com/intradoccgi/groups/participant_services/documents/participantapplicationkitsfe/asx_038014.pdf 
 
SWIFT MT535 Message - Statement of Holding 
SWIFT MT599 Message - Securities Detail Message 
SWIFT MT564 Message – Corporate Action Notification
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20. Corporate Actions (For Holders) 
 

Definition 

The ability to view Corporate Actions relating to DSS and FIS Securities. 

 

Function 

View DSS Maturity/FIS Coupon, Redemption and Maturity Corporate 
Actions 

Information 

Corporate Actions for Discount Securities consist of Maturity payments 
only. Corporate Actions for Fixed Income Securities consist of Coupon, 
Redemption and Maturity payments. 

Maturity and Coupon corporate actions are generated automatically by the 
system in the overnight recurring tasks, while Redemption corporate 
actions are generated manually by SFE Austraclear after entry of the partial 
redemption values and interest and principal PPH. 

Discount Security Instruments and Fixed Income Security Series that have 
matured will be displayed in the View Series screen until such time as they 
are deleted from the system by the CSD Administrator. 

Corporate Actions can be viewed via the following screen: 

 

 Settlement >> View Settlements >> Corporate Action  
Settlement Instructions 

All Corporate Action Settlement Instructions are displayed in this screen 
once they have been created (after Booksclose (record date).   This will 
consist of one gross Corporate Action Settlement Instruction for each 
series, representing the total payment amount for that series and a 
number of underlying Corporate Action Settlement Instructions, 
representing the individual coupon, redemption and maturity payment 
amounts to each Holder.   
 

Navigation Steps 

► Settlements ► View Settlements ► Corporate Action Settlement 
Instructions 

 

Process Steps 

1. Follow navigation steps above to display the ‘Corporate Action 
Settlement Instructions’ screen. 

2. Specify search criteria as required and click Search to display 
current Corporate Action Settlement Instructions.    

3. To view the details of an individual Corporate Action, right click 
and select Properties. 

 

Information 

 
The system will create one gross Corporate Action Settlement 
Instruction per series for Issuer Representatives to confirm and 
underlying Corporate Action Settlement Instructions for the individual 
Maturity, Coupon and Redemption payments to each Holder. 
 
To view only the Corporate Action Settlement Instructions for 
underlying payments to you as the holder, select “Maturity”, “Coupon” 
or “Redemption” in the Operation Type search criteria field. 
 
For each Coupon Corporate Action, the system will display one 
settlement instruction which consists of a credit (+) payment amount to 
the Holder for the proceeds of the coupon payment.  
For each Maturity Corporate Action, the system will display two 
settlement instructions. The first instruction relates to the removal of the 
securities from the Holders portfolio while the second instruction 
displays a credit (+) payment amount to the Holder for the proceeds of 
the maturity.  
 
Maturity, Coupon and Redemption Corporate Action Settlement 
Instructions are created with a state of Matched. On confirmation, the 
state of the individual underlying instructions will change to Settled. 
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All Coupon, Maturity and Redemption proceeds are payable on an 
Irrevocable (I) settlement basis only. 

 
 
 
 
 

 

  

 

 

 

 

 

 

 

Definition 

The ability to view, download and print reports for Corporate Actions 
relating to DSS and FIS Securities. 

 

Function 

View, download and print reports for DSS Maturity/FIS Coupon, 
Redemption and Maturity Corporate Actions 

 

Information 

 
The following report will be available at the start of each business day as a 
result of overnight processing: for Holders of Discount and Fixed Income 
Securities: 

Income Receivable Report 

The Income Receivable Report displays income to be received on the 
current business day for coupon and maturity payments and any tax that 
will be withheld on coupon payments. The format of this report is PDF & 
CSV 

Navigation Steps 

► View ► Reports ►Explore 

 

Process Steps 

1. Follow navigation steps above to display the ‘Reports’ screen. 

2. Specify search criteria as required and click Search to display 
reports available for the current business day.    

3. Select a report and right click to Download, then right click to 
Preview and/or Print 
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Glossary – Corporate Actions 

Corporate Actions 

Field Names Description 

Corporate Actions Corporate action name. 

Complete Yes - 
No - 

Indicates that the corporate action setup is completed. 
Indicates that additional information is required before completion. 

List Complete Specifies if the corresponding holder list is completed. 

State State of the corporate action. 

Underlying Series The underlying series code which gives the holder rights to entitled benefits.  

Description Description of the underlying series. 

Event Short name of the corporate action event. 

Issuer  Sub Participant code of the issuer. 

Issuer Representative Sub Participant code of the issuer representative or CSD itself. 

Record Datetime Date when the system should check which investors should be entitled to the benefits. 

Mandatory Indicates whether the corporate action is mandatory or optional. By default set to True (mandatory). 

 

Corporate Action Holder List 

Field Names Description 

Corporate Action The unique code used to identify the Corporate Action. 

Record Datetime The date and time when the list was recorded. 

List Completed  Is set to TRUE if no further entries are expected to the list. 

Sub Participant The sub participant to which the sub account belongs, i.e. the sub account controller. 

Sub Account The sub account to which the holding belongs. 

Volume The total volume of security held. 

Alternative If there are different alternatives, the choice is specified here. 

Benefit Defines which instructions are included and the execution date they should be settled. 

 

Corporate Actions Settlement Instructions 

Field Names Description 

Corporate Action Corporate action name. 

Event Ref Code The corresponding corporate event.  

Series The series involved in the corresponding trade. 
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Field Names Description 

Issuer The sub participant that issued the series.  

ISIN The ISIN code of the series.  

Settlement Instruction 
Number 

Sequence number that uniquely identifies the instruction. Set by the system. 

Settlement Date The settlement instruction's settlement date. 

Volume The size of the delivery. 

Sub Account The sub account code. 

Payment Amount Specification of the payment amount. 

Payment Currency Specification of the currency. 

Message Type Specifies properties that decide how the settlement is to be handled. One of the following:- 
  

DVP - The security is delivered in exchange for the payment, in a final and irreversible manner. 
Note: This message type is also used for DaP, Delivery and Payment, by changing the sign for 
the amount to be paid. 

DVD - The security is delivered in exchange for another security, in a final and irreversible manner. 

FOP - A security is delivered without any kind of delivery in the opposite direction. 

PVP - An amount of money is transferred in exchange for another amount of money. 

PVN - An amount of money is transferred without any kind of delivery in the opposite direction. 

CANC - Request to cancel another instruction. 

REC - A recall instruction. 

NOM - The sub participant nominates the security that will be used for trading later. 

RNOM - Message type used when the sub participant wants to release a bill nomination. 

PLVPL - This is used to substitute a parcel of unpledged securities for a parcel of pledged securities. The 
substitution is initiated by the pledgee and completed once the counterparty confirms. 

PLVP - Funds are transferred from the pledgee's bank sub account to the pledgor's sub account after 
passing the cash limit test, and a hold is placed on the pledged securities. 

PLOP - No cash is transferred between the sub participant's cash records by the system but a hold is 
placed on the pledged securities. 

RLVP - Funds are transferred between the pledgee's and pledgor's cash records after passing the cash 
limit test, and the pledged securities are released. 

RLOP - No cash is transferred by the system, between the sub participants' cash records but a release is 
made in the pledged securities. 

CORP - The message is a result of a benefit instruction of a corporate action. 
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Field Names Description 

TRANS - One-sided transfer of a holding between a sub participant's sub accounts. 
 

Operation Type Specifies the type of operation that resulted in the settlement instruction being created. One of the following:-  
 

NORMAL - A normal settlement instruction. 

MATP - Maturity payment. 

CPON - Coupon. 

PAYM - Payment. 

CORP - Corporate Action. 

SFET - SFE Transaction, special cash payment for margin requirement. 

RBA REPO - First leg in create liquidity repo. 

REVERSE RBA 
REPO - 

Second, or reversed, leg in create liquidity repo. 

 

Settlement Method Specifies the settlement method to be used to settle the corresponding trade. One of the following:-  
 

RTGS Real Time Gross Settlement. Trades are settled individually and immediately.  

EoD Gross settlement at the end of day, when the system is in end-of-day mode.  

External Gross settlement of securities legs only, the cash is handled outside of the system.  

BISM1 Gross settlement, trade for trade at a given point in time.  

BISM2 Batchwise net settlement for cash legs but gross settlement for securities legs.  

BISM3 Batchwise net settlement.  

RTAIB Real time adjust issue balance, that is, the settlement is done immediately. 

BAIB Batch adjust issue balance, that is, the settlement is done at the specified time. 

DWNET Deposit/Withdraw net, used for netting settlement instructions in the deposit/withdrawal of 
securities functionality. 

Payment Netting Net settlement of cash. 
 

Sub Participant The sub participant involved in the leg of the deal to which the settlement instruction refers.  

Cash Record A code that together with the cash record owner uniquely define a cash record in the system. 

Cash Record Owner The owner of the cash record. 

State The state of the settlement instruction. One of:  

Unmatched The instruction has been created but not yet matched with the instruction of the other leg in the 
deal.  

Matched The instruction has been matched with the instruction of the other leg in the deal.  
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Field Names Description 

Recall Requested A recall has been requested for the instruction.  

Pending Payment 
System Recall 

The recall request has been passed on to the payment system.  

Cancelled The instruction has been cancelled successfully.  

Cancel Pending A sub participant has requested to cancel the settlement instruction.  

Cancel Requested The counterparty has requested to cancel the settlement instruction.  

Cancel Completed A cancel request has been completed.  

Recall Complete The recall request has been completed.  

Recalled A sub participant has recalled the instruction.  

Recalled by 
Counterpart 

The counterpart has recalled the settlement instruction.  

Rejected The instruction has been rejected by a user.  

Completed Final state for a settlement instruction involved in corporate action, where the settlement 
instruction is only used to lock in the issuers amount and will never settle.  

Settled The settlement has been carried out successfully.  

Failed The instruction failed to be settled.  
 

Instructed Specifies if the settlement instruction will be automatically executed (True) or if it has to be finally instructed by the sub 
participant as a separate action (False).  

Counterpart The sub participant that acts as a counterpart in the transaction.  

Issuer Representative The sub participant code of the issuer representative taken from the underlying series. 

Monitor Corporate Action Execution 

Field Names Description 

Corporate Action The name of the corporate action.  

No. of Settlement 
Instructions 

The number of settlement instructions for the corporate action. 

State The state of the corporate action. One of:-  
 Planned  
 Holder List Created  
 Settlement Instruction Created  
 Preparing for Settlement  
 Currently executing  
 Successfully executed  
 Failed 
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View a Trade 

 

Definition 

The ability to view trade details. 

 

Function 

View Trade details, Settlement Instructions, Obligations and/or DVP details. 

 

Information 

The generic viewing process for all products is detailed below.   Where there are additional viewing functions, the details have been specified by product.  

Trades waiting to be settled will appear in the Settlement Instructions screen in a state of Matched and in the Settlement Obligations screen in a state of 
Not Settled. 

Once the settlement process has commenced transactions change to a state of Payment Pending indicating they are waiting for RTGS processing. 

Upon completion of settlement, transactions assume a state of Settled and the Cash Records of both parties are updated. 

All View screens eg. View Reported Trades, View Settlement Instructions are archived for a period of 90 days.   When entering search criteria users may 
backdate the Settlement Date/s to view the details of historical transactions. 

 

Navigation Steps 

► Trades ► View Reported Trades  

 

Process Steps 

View Details of a Single Trade 

1. Follow navigation steps above to display the ‘View Reported Trades’ screen. 

2. Specify search criteria and click search to view all trades to which you are a party. 

3. Highlight a transaction and right click to view Counterparty Trade Report details (if the counterparty has entered their side), DVP Information, Trade 
Report History and Properties.  

View settlement details of Trades 

1. Select Settlement ► View Settlements ► Settlement Instructions. 
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2. Specify search criteria and click Search to view the settlement instruction for all trades settling today, and /or 

3. Select Settlement ► View Settlements ► Settlement Obligations. 

4. Specify search criteria and click Search to view the settlement obligation created by the system for all trades settling today and/or 

5. Select Settlement ► View Settlements ► DVP Instructions. 

6. Specify search criteria and click Search to view the DVP instructions created by the system for all trades settling today. 

 

Process Steps (cont.) 

To view the Cash Record balance after settlement has completed 

1. Select Sub Participants ► Cash Records ► View 

2. Specify search criteria and click Search to view your Cash Records. 

3. Highlight a Cash Record and right click to View Cash Record Transactions. 

 

CASH/Market Repos/OCH Margins/SFE Margins 

Process Steps 

To view settlement details of a single Trade 

1. Select Settlement ► View Settlements ► Settlement Instructions from the Main Menu. 

2. Specify search criteria and click Search to view the settlement instructions of all Cash Transfers settling today. 

3. Highlight a transaction and right click to view Properties, State History and Historical Modifications. 
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DSS/FIS 

Process Steps 

To view Holdings: 

1. Select Holdings ► View Holdings from the Main Menu. 

2. The View Holdings screen will be displayed. 

3. Enter search criteria as required and click Search.   All holdings will be displayed according to search criteria.  

 

FRAS/FX/SWAPS 

Process Steps 

To view the net settlement details of FRA’s/FX/SWAPS 

1. Select Settlement ► View Settlement Accumulation from the Main Menu. 

2. Specify search criteria and click Search to view the details of settled FRA transactions and the net differences resulting from those settlements. 
 

RBA Repos 

Process Steps  

To view details of a single RBA Repo 

1. Select Trades ► View RBA Repos from the Main Menu. 

2. The View RBA Repos screen will be displayed.   This will default to the Open RBA Repos view.   Other available search options are Unauthorised 
and Historical. 

3. Specify search criteria and click search to view all RBA Repos to which you are a party. 

4. Highlight a transaction and right click to select View Details and Show Cash Totals.  

5. An open RBA Repo trade is one that appears as an Open contract in the View RBA Repos screen. An RBA Repo cannot be open until the first leg has 
settled (Original Settlement Date). 

6. If the second leg is not closed intra-day the Settlement Date will become the Expected Settlement Date.  

7. If the Expected Settlement Date passes and the RBA Repo has not  
been closed out, the Original Settlement Date will be overwritten with the new Expected Settlement Date. 

 

To view settlement details of an RBA Repo 

1. Select Settlement ► View Settlements ► Settlement Instructions from the Main Menu. 

2. Specify search criteria and click Search to view the settlement instructions of all RBA Repos settling today. 

3. Highlight a transaction and right click to view Properties, State History and Historical Modifications. 
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21.  90 Day BAB Contract Delivery 

Explanation of Delivery 

 

Information 

In fulfillment of the 90 Day Bank Accepted Bill Contract the Seller must deliver - $1,000,000 face value of Bank Accepted Bills of Exchange (BAB) or Electronic 
Bank Accepted Bills of Exchange (EBA) 

 - $1,000,000 face value of Bank Negotiable Certificates of Deposit (NCD) or Electronic Bank Negotiable Certificates of Deposit (ECD)  

Each Bank Accepted Bill or NCD tendered must be accepted or issued by the same Approved Bank, be payable at the same city branch of an approved bank 
(in Sydney, Perth, Melbourne, Brisbane or Adelaide) and have the same maturity date. In addition, each Bank Accepted Bill tendered must have been drawn by 
the same drawer 

Any Bank Accepted Bill or NCD tendered must have a maturity date no more than 95 days or less than 85 days from the settlement date, and must be “early” 
paper. Early paper refers to a bank bill that matures on business days between the 1

st
 and 15

th
 of the month.  

The ASX designates those banks which are known as Approved Banks for tendering purposes 

The current list of Approved Banks is: 

 - Australia and New Zealand Banking Group Ltd 

 - BNP Paribas 

 - Commonwealth Bank of Australia 

 - National Australia Bank Limited 

 - Westpac Banking Corporation 
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View Bill Nomination Parameters and Periods 

 

Definition 

The ability to view the Bill Nomination and Delivery Rules  

 

Function 

View List of Approved Securities and Bill Nomination Delivery Dates and Times  

 

Information 

The Bill Nomination and Delivery rules are maintained by Austraclear  

 

Navigation Steps 

► Trades ► Bill Nominations ►Display Rules ►Parameters  

► Trades ► Bill Nominations ►Display Rules ►Periods 

Process Steps 
 

1. Follow navigation steps above to display the ‘Parameters’ screen. 

2. The Bill Nomination Rules and list of Approved Issuers will be displayed. 

3. Follow navigation steps above to display the ‘Periods’ screen. 

4. The current Bill Nomination and Delivery Dates and Times will be displayed. 
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Nomination of BAB’s/NCD’s to be Delivered 

 

Definition 

The ability for the seller to nominate eligible securities for delivery in fulfilment of the 90 Day BAB Contract.   

 

Function 

Nominate Bank Accepted Bills or Negotiable Certificates of Deposit for Delivery 

 

Information 

The following rules apply for all nominations: 

- The series sub class must be CD/ECD or BA/EBA 

- The security must be held by the participant in their Holdings within the  

   Austraclear system 
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- The security must not be pledged 

- The unit face value (denomination) must be $1,000,000,  

- The Issuer/Acceptor and the Place Payable on the security must be 

   on the list of Approved Banks 

- The number of days from settlement to maturity must be in the range 

   85 to 95 days inclusive and must be “early”, a bank bill that matures on business days between the 1
st
 and 15

th
 of the month.  

All nominations must be entered by 5:00pm on the Thursday prior to settlement, thus any BAB’s or CD’s to be delivered must be in the delivering participant’s 
SFE Austraclear Holdings prior to that time and nominated by that time 

Once a security has been nominated, the system will place a Reservation on the holding to indicate the nomination has settled 

 

 

Definition 

To check if securities eligible for Nomination are held in the system: 

Information 

See above for details of the criteria for determining eligible securities for nomination.  
 

Navigation Steps 

► Holdings ► View Holdings 

 

Process Steps 

1. Follow Navigation steps above to display the ‘Holdings’ screen.  

2. Specify in the search criteria Series Class = DSS. 

3. Select a From Maturity Date and a To Maturity Date, then click search to view all DSS securities eligible to be nominated. 
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Navigation Steps 

► Trades ► Create Trade ► Bill Nomination 

 

Process Steps 
 

1. Follow Navigation steps above to display the ‘Bill Nomination’ screen.  

2. Enter your three digit SFEC code (or the code of any Clearing participant on whose behalf you are performing the nomination). 

3. Under Security Instructions Select the Series, enter the Volume to be nominated and select a Sub Account, then click OK.  

(Multiple lines of stock can be entered in the one nomination) 

 

Authorisation 

All Austraclear Participants require a second user to authorise the Bill Nomination. 
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Navigation Steps 

► Settlements ► View Settlements ► Settlement Instructions 

 

1. Follow Navigation steps above to display the ‘Settlement Instructions screen.  

2. Specify the search criteria Transaction Type = Bill Nomination and click search.  

3. Highlight the transaction to be authorised and from the right click menu select Authorise, or  

4. Highlight the transaction to be modified and from the right click menu select Properties, or 

5. Highlight the transaction to be cancelled and from the right click menu select Cancel 
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Definition 

To check if a Bill Nomination has settled.  

 

Function 

View Settlement Instructions.  

 

Information 

When a Bill Nomination transaction is created, the system will automatically create a Settlement Instruction with a state of Matched in preparation for settlement 

The Bill Nomination requires authorisation, once authorised the transaction will proceed to a state of Settled, see below print screen. 
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Seller Transfer Of Securities 

Definition 

The ability for the seller to transfer nominated securities to the buyer in fulfilment of the 90 Day BAB Contract.   
 

Information 

Only securities which have been previously nominated will be displayed for selection in the Series field of the Create Bill Delivery screen 

The number to trade will be determined from the SFEC seller’s advice. The Face Value entered by the seller will be validated against the Nominated Amount 
which is displayed in the Create Bill Delivery screen  

 

Navigation Steps 

► Trades ► Create Trade ► Bill Delivery 
 

Process Steps 

1. Follow Navigation steps above to display the ‘Bill Delivery’ screen.  
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2. Enter your Counterparty and select a Series. 

3. Enter a Face Value, your three digit SFEC code (or the code of any Clearing participant on whose behalf you are performing the delivery), enter a 
Rate and Calculate the Consideration, then click OK. 

 

Authorize Bill Delivery Trade 
 

Information 
Authorisation state options are:- 

 Authorised - the trade is authorised 
 Needed - the trade requires authorisation 
 Not needed - authorisation is not required 

 
A trade with Authorisation state = Needed must be authorised before it can be matched. The authorisation must be performed by a user other than the user 
who performed the transaction on the trade. 
 

Navigation Steps 

► Trades ► View Reported Trades  

Process Steps 

1. Follow navigation steps above to display the ‘View Reported Trades’ screen. 

2. Specify search criteria and click on ‘Search’ to view all trades to which you are party. 

3. Highlight the transaction to be authorised and from the right click menu select Authorise Trade Report, check the details and click OK. 

4. Highlight the transactions to be authorised and from the right click 
menu select Bulk Authorise Trade Report, check the details and click OK. 
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Buyer Confirmation of Securities 

 

Definition 

The ability for the buyer to confirm/reject transfer of nominated securities from the seller in fulfilment of the 90 Day BAB Contract.   

 

Function 

Confirm Bill Delivery Trade.  
 

Navigation Steps 
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► Trades ► View Reported Trades  
 

Process Steps 

1. Follow navigation steps above to display the ‘View Reported Trades’ screen. 

2. Specify search criteria and click search to view all Bill Delivery trades settling today 

3. Highlight the transaction to be confirmed and from the right click menu select Confirm Trade Report, enter your three digit SFEC code, then click 
Send or 

4. Highlight the transaction to be rejected and from the right click menu select Reject Trade Report, then click Send  

 

Authorisation 

 
Authorisation state options are:- 

 Authorised - the trade is authorised 
 Needed - the trade requires authorisation 
 Not needed - authorisation is not required 

 
A trade with Authorisation state = Needed must be authorised before it can be matched. The authorisation must be performed by a user other than the user 
who performed the transaction on the trade. 
 
 

Navigation Steps 

► Trades ► View Reported Trades  
 

Process Steps 

1. Follow navigation steps above to display the ‘View Reported Trades’ screen. 
 

2. Specify search criteria and click on ‘Search’ to view all trades to which you are party. 

3. Highlight the transaction to be authorised and from the right click menu select Authorise Trade Report, check the details and click OK. 

4. Highlight the transactions to be authorised and from the right click 
menu select Bulk Authorise Trade Report, check the details and click OK. 
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22.   Reports 
 

Definition 

 The ability to set Global and Individual Preferences for printing Reports from the View function in the main menu; and 

 To enable the user to view, print and export Reports from the Sub-Participants, Holdings, Trades and Settlement functions in the main menu. 

Function 

View, download, save, print and export Reports. 

Global and Individual Preferences 

Information 

The Reports are generated during the day at the following times: 

Before Business 5.30am 

2
nd

 Payment Run 2.00pm 

Day End  4.28pm 

Interim Cash List 5.17pm 

Final Cash List  7.02pm 

After Business  7.30pm  

 

From a participant perspective, After Business reports will available next morning, along with the Before Business reports.  

A list of all available reports, descriptions and formats can be found at the end of this section.  

 

Navigation Steps for Global Report Preferences 

► View ► Reports ► Properties  
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Process Steps 

1. Select Directory where Reports are to reside, if other than C: Drive. 

2. Select the number of days Reports are to be kept. 

3. Select time the Reports are to be downloaded. 

 

Automated Report Actions: 

 Download Reports at Start Up must have Default Reports to Auto- Download for Global Preferences or Auto Load selected for Individual Reports.  If 

Automatic Download Time has not been selected, Reports will be downloaded 5 minutes after the user has logged on. 

 Default Reports to Auto-Download works only if Download Reports at Start Up is selected, or Automatic Download Time is set. 

 Default Reports to Auto-Print must be selected to enable Reports to be automatically printed when reports are downloaded (whether auto or manual). 

To set the Automated Report Actions, click in box, then Apply and OK. 
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Navigation Steps for Individual Report Preferences 

 

► View ► Reports ► Explore ► Select the Report Date, click on Search. 

 

Process Steps 

Automatic Report Preference 

To set the Report Print Preference automatically for an Individual Report, highlight the line, right mouse click, select Properties and the Report Preferences 

dialog box will appear. 
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 When the boxes are greyed out with a tick, this will default to Global Preferences. 

 When unchecked, auto download is turned off. 

 When checked, without grey, this is set to automatic download regardless or what the global setting is. 

For this automatic download to work, the user must have either set the Automatic Download Time or selected Download Reports at Start Up in Global Report 

Preferences.  Once your selection is made, click on Apply, then OK. 

Manual Report Preferences 

In ► View ► Reports ► Explore ► Search, highlight Report required, right mouse click, choose Preview to preview the Report on the screen.  If Preview is 

greyed out, there is no Report available.  Choose Download to load onto specified directory.  Choose Print to print Report to default printer. 

 

PROXIES 

Report preferences (both Global and Individual) set by a user also applies to all the proxies assigned to the user where the proxy user has the Reports role. 
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Navigation Steps to View, Print and Export Reports from the Sub-Participants, Holdings, Trades and Settlement Functions  

Process Steps 

 

View Reports for Reported/Open Trades 

1.   Select ► Trades ► View Reported Trades to display the View Reported Trades screen. 

1. Specify search criteria and click search to view all trades to which the user is a party or proxy. 

2. Right click and select Export to CSV File to obtain a Reported Trades report in CSV format. 

3. Save the file into a nominated drive and file name. 

 

View Settlement Instructions Report 

1. Select Settlement ► View Settlements ► Settlement Instructions.   The Settlements Instructions screen will be displayed. 

2. Specify search criteria and click Search to view the settlement instructions of all trades settling today. 

3. Right click and select Export to File to obtain a Settlement Instructions Report in CSV format. 

4. Save the file into a nominated drive and file name.  
 

 

View Cash Records Report 

1. Select Sub Participants ► Cash Records ► View.    

2. Specify search criteria and click Search to view your cash records. 

3. Highlight a Cash Record and right click to View Cash Record Transactions. 

4. Right click and select Export to File to a obtain a Cash Record Transactions Report in CSV format 

5. Save the file into a nominated drive and file name. 

 

 

View Settlement Accumulation Report 

1. Select Settlements ► View Settlement Accumulation.   The Settlement Accumulation screen will be displayed. 

2. Specify the search criteria and click Search to view all FX/FRA/IRS trades to which the user is a party or proxy. 

3. Right click and select Export to CSV File to obtain a Settlement Accumulation report in CSV format. 

4. Save the file into a nominated drive and file name.  
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View RBA Repos Report 

1. Select Trades ► View RBA Repos.   The View RBA Repos screen will be displayed.   This will default to the Open RBA Repos view. Other available 
search options are Unauthorised and Historical. 

2. Specify the search criteria and click Search to view all RBA Repos to which the user is a party or proxy. 

3. Right click and select Export to CSV File to obtain an RBA Repo Trade report in CSV format. 

4. Save the file into a nominated drive and file name. 

 

View Holdings Report 

1. Select Holdings ► View Holdings ► The Holdings screen will be displayed. 

2. Specify search criteria and click Search to view the participant’s Holdings for the current day. 

3. Right click and select Export to File to obtain a Holdings Report in CSV format. 

4. Save the file into a nominated drive and file name.  

 

Report Name Report Description Format 

Available for ALL Participants 

Cash Open Trade Report Displays all Cash trades that are yet to settle, including unmatched trades  PDF 

Settlement Instructions Report Displays the settlement instructions for transactions that were settled on the previous business day PDF 
and 
CSV 

Cash Report Displays the cash movements of all transactions that were settled for all sub participant’s cash records at the close of business 
on the previous day 

PDF 
and 
CSV 

DSS Open Trade Report Displays all DSS trades that are yet to settle, including unmatched trades PDF 

Holding Report Displays all securities in the participant’s portfolio at the current date PDF 
and 
CSV 

Maturing Securities Report Details all securities that are due for maturity within the next 7 calendar days PDF 
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Outstanding Deposits and 
Withdrawals Report 

Displays all outstanding deposit and withdrawal transactions irrespective of status PDF 

Income Receivable Report Displays income to be received on the current business day for coupon and maturity payments and any tax that will be withheld 
on coupon payments 

PDF 
and 
CSV 

FIS Open Trade Report Displays all FIS trades that are yet to settle, including unmatched trades PDF 

Record Date Report Lists all series in which a participant has a holding where today is the record date and how much coupon and/or maturity income 
is due to them 

PDF 

FRA Open Trade Report Displays all FRA trades that are yet to settle, including unmatched trades PDF 

FX Open Trade Report Displays all FX trades that are yet to settle, including unmatched trades PDF 

Market Repo Open Trade Report Displays all Market Repo trades that are yet to settle, including unmatched trades PDF 

Market Repo Coupon Report Displays the coupon details of 2
nd

 leg market repo trades where today is the record date for the instrument and the 1
st
 leg has 

settled 
PDF 

RBA Repo Open Trade Report Displays all RBA Repo trades that are yet to settle. The definition of an open RBA Repo trade is one that appears as an Open 
contract in the View RBA Repos screen 

PDF 

IRS Payments & Receipts Due 
Report 

Lists all SWAPS payments and receipts due in the next 5 business days. This report includes regular periodical 
payments/receipts associated with SWAP flows, up front payments and termination payments 

PDF 

IRS Open Trade Report Displays all SWAP trades that are yet to settle, including unmatched trades and terminations PDF 

IRS Payment Report Details all future payment flows associated with a participant’s open SWAPS, including termination payments PDF 
and 
CSV 

Role Allocation Report Lists all participant logons and the roles and authorization to which they have access PDF 
and 
CSV 

Pledged Securities Report Displays all Pledge positions that a participant has open at that time. The report is divided into 2 sections, one where the 
participant is the pledgor and one where the participant is the pledgee 

PDF 
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Security Details Report Displays the details of all securities in the system that are in either an Inactive or Active status PDF 
and 
CSV 

Available for Issuer Representatives only 

Place Payable Maturity Report Displays details on the Maturity date of all maturing immobilised DSS securities payable on the day PDF 

Issuer Representative’s Holding 
Report 

Lists all sub participants who hold a particular Issuer’s securities and how much of that security they hold PDF 

Issuer Representative’s Turnover 
Report 

Lists all completed trades involving a particular Issuer’s securities PDF 

Issuer Representative’s DSS 
Maturities Payments Report 

Details all DSS securities which are due to mature on the current business day and who the beneficial owner of those securities 
are, including the maturity amount that will be paid 

PDF 
and 
CSV 

Issuer Representative’s Record 
Date Report 

Lists all participants who hold a particular Issuer’s securities at record date and how much income is due PDF 

Issuer Representative’s 1
st
 Run 

FIS Payments Report 
Details for Issuer Representatives who they will be paying coupon and maturity payments to for the current business day PDF 

and 
CSV 

Issuer Representative’s 2nd Run 
FIS Payments Report 

Details for Issuer Representatives who they will be paying coupon, maturity and redemption payments to for the current business 
day. This report will be available after 2:00pm daily 

PDF 
and 
CSV 

Available for Cash Providers only 

Cash List Report Displays the cash position of each active participant to whom the Cash Provider provides cash clearing services. This report is 
produced as both an Interim and Final report 

PDF 
and 
CSV 

Cash Record Limit Audit Report Provides an audit trail for Cash Providers of changes made to their client’s bank account limits during the course of each trading 
day, including intraday temporary adjustments 

PDF 
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